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Preface

Oracle Fusion Middleware Developer’s Guide for Oracle TopLink explains how to use
Oracle TopLink to design, implement, deploy, and optimize an advanced persistence
or object-to-XML transformation layer for a wide range of Java 2 Enterprise Edition
(Java EE) and Java applications. It describes TopLink mapping metadata, sessions, data
access, queries, transactions (both with and without an external transaction controller),
and cache.

It describes how to use TopLink application development tools and how to integrate
TopLink with a variety of Java EE containers. It also introduces the concepts with
which you should be familiar to get the most out of TopLink.

Oracle Fusion Middleware Developer’s Guide for Oracle TopLink is intended for application
developers creating applications that use TopLink to manage persistence.

This document assumes that you are familiar with the concepts of object-oriented
programming, the Enterprise JavaBeans (E]B) specification, and your own particular
Java development environment.

The document also assumes that you are familiar with your particular operating
system (such as Windows, UNIX, or other). The general operation of any operating
system is described in the user documentation for that system, and is not repeated in
this manual.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible to all users, including users that are disabled. To that end, our
documentation includes features that make information available to users of assistive
technology. This documentation is available in HTML format, and contains markup to
facilitate access by the disabled community. Accessibility standards will continue to
evolve over time, and Oracle is actively engaged with other market-leading
technology vendors to address technical obstacles so that our documentation can be
accessible to all of our customers. For more information, visit the Oracle Accessibility
Program Web site at http: //www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, some screen readers may not always read a line of text
that consists solely of a bracket or brace.
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Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or
organizations that Oracle does not own or control. Oracle neither evaluates nor makes
any representations regarding the accessibility of these Web sites.

Deaf/Hard of Hearing Access to Oracle Support Services

To reach Oracle Support Services, use a telecommunications relay service (TRS) to call
Oracle Support at 1.800.223.1711. An Oracle Support Services engineer will handle
technical issues and provide customer support according to the Oracle service request
process. Information about TRS is available at

http://www. fcc.gov/cgb/consumerfacts/trs.html, and a list of phone
numbers is available at http: //www. fcc.gov/cgb/dro/trsphonebk.html.

Related Documentation

For more information, refer to the documentation section of
http://www.oracle.com/technology/products/ias/toplink/index.html

Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.




Part |

TopLink Application Development
Overview

This part describes the architecture of TopLink and how TopLink fits into your
development process. It contains the following chapters:

Chapter 1, "Introduction to TopLink"

This chapter contains general information on TopLink. It discusses the TopLink
application space, development process, components, and the TopLink
metamodel.

Chapter 2, "Introduction to TopLink Application Development"

This chapter contains an overview of the key stages in the TopLink development
process including choosing an application architecture and platform, object and
relational mapping, building the persistence layer, and deploying and maintaining
a TopLink application.






1

Introduction to TopLink

Oracle TopLink is an advanced, object-persistence and object-transformation
framework that provides development tools and run-time capabilities that reduce
development and maintenance efforts, and increase enterprise application
functionality.

This chapter includes the following sections:

s What Is TopLink?

s What Is the Object-Persistence Impedance Mismatch
s TopLink Key Features

s TopLink Application Architectures

1.1 What Is TopLink?

Oracle TopLink builds high-performance applications that store persistent
object-oriented data in a relational database. It successfully transforms object-oriented
data into either relational data or Extensible Markup Language (XML) elements.

Figure 1-1 TopLink Runtime Architecture
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What Is the Object-Persistence Impedance Mismatch

Using TopLink, you can integrate persistence and object-transformation into your
application, while staying focused on your primary domain problem by taking
advantage of an efficient, flexible, and field-proven solution (see Section 1.2, "What Is
the Object-Persistence Impedance Mismatch").

TopLink is suitable for use with a wide range of Java 2 Enterprise Edition (Java EE)
and Java application architectures (see Section 1.4, "TopLink Application
Architectures"). Use TopLink to design, implement, deploy, and optimize an advanced,
object-persistence and object-transformation layer that supports a variety of data
sources and formats, including the following:

= Relational-for transactional persistence of Java objects to a relational database
accessed using Java Database Connectivity (JDBC) drivers.

s Object-Relational Data Type—for transactional persistence of Java objects to special
purpose structured data source representations optimized for storage in
object-relational data type databases such as Oracle Database.

= Enterprise information system (EIS)—for transactional persistence of Java objects to
a nonrelational data source accessed using a Java EE Connector architecture (JCA)
adapter, and any supported EIS record type, including indexed, mapped, or XML.

s XML-for nontransactional, nonpersistent (in-memory) conversion between Java
objects and XML Schema Document (XSD)-based XML documents using Java
Architecture for XML Binding (JAXB).

TopLink supports EJB 3.0 in Java EE and Java SE environments including integration
with a variety of application servers, such as Oracle WebLogic Server, OC4J, SunAS,

JBoss, and IBM WebSphere application server. TopLink also includes support for EJB
2.n container-managed persistence (CMP) in OC4]J.

The extensive suite of development tools that TopLink provides, including Oracle
JDeveloper TopLink Editor, Eclipse Dali, and Oracle TopLink Workbench, lets you
quickly capture and define object-to-data source and object-to-data representation
mappings in a flexible, efficient metadata format (see Section 2.9, "Working with
TopLink Metadata").

The TopLink runtime lets your application exploit this mapping metadata with a
simple session facade that provides in-depth support for data access, queries,
transactions (both with and without an external transaction controller), and caching.

For more information about TopLink, see Section 1.3, "TopLink Key Features".

1.2 What Is the Object-Persistence Impedance Mismatch

Java-to-data source integration is a widely underestimated problem when creating
enterprise Java applications. This complex problem involves more than simply reading
from and writing to a data source. The data source elements include tables, rows,
columns, and primary and foreign keys. The Java and Java EE include entity classes
(regular Java classes or Enterprise JavaBeans (E]B) entity beans), business rules,
complex relationships, and inheritance. In a nonrelational data source, you must match
your Java entities with EIS records or XML elements and schemas. These differences
(as shown in Figure 1-2) are known as the object-persistence impedance mismatch.

1-2 Developer's Guide for Oracle TopLink



What Is the Object-Persistence Impedance Mismatch

Figure 1-2 Solving Object-Persistence Impedance Mismatch
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Successful solution requires bridging these different technologies, and solving the
object-persistence impedance mismatch-a challenging and resource-intensive
problem. To solve this problem, you must resolve the following issues between Java
EE and data source elements:

= Fundamentally different technologies.

= Different skill sets.

= Different staff and ownership for each of the technologies.
= Different modeling and design principles.

As an application developer, you need a product that lets integrate Java applications
with any data source, without compromising ideal application design or data integrity.
In addition, as a Java developer, you need the ability to store (that is, persist) and
retrieve business domain objects using a relational database or a nonrelational data
source as a repository.

TopLink Solution

TopLink addresses the disparity between Java objects and data sources. TopLink is a
persistence framework that manages relational, object-relational data type, EIS, and
XML mappings in a seamless manner. This lets you rapidly build applications that
combine the best aspects of object technology and the specific data source.

TopLink lets you do the following:

»  Persist Java objects to virtually any relational database supported by a
JDBC-compliant driver.

»  Persist Java objects to virtually any nonrelational data source supported by a Java
EE Connector architecture (JCA) adapter using indexed, mapped, or XML
enterprise information system (EIS) records.

s Perform in-memory conversions between Java objects and XML Schema (XSD)
based XML documents using JAXB.

= Map any object model to any relational or nonrelational schema, using the Oracle
TopLink Workbench graphical mapping tool or Oracle JDeveloper TopLink editor.

= Use TopLink successfully, even if you are unfamiliar with SQL or JDBC, because
TopLink offers a clear, object-oriented view of data sources.
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TopLink Key Features

1.3 TopLink Key Features

TopLink provides an extensive and thorough set of features. You can use these features
to rapidly build high-performance enterprise applications that are both scalable and
maintainable.

Some of the primary features of TopLink are the following:

= Nonintrusive, flexible, metadata-based architecture (see Section 2.9, "Working with
TopLink Metadata")

= Architectural flexibility: Plain Old Java Objects (POJO), Container-Managed
Persistence (CMP), as well as Java Persistence API (JPA), Java API for XML
Binding (JAXB), Service Data Objects (SDO), and Web services provided by
EclipseLink.

= Advanced mapping support and flexibility: relational, object-relational data type,
Enterprise Information Systems (EIS), and XML.

= Optimized for highly scalable performance and concurrency with extensive
performance tuning options.

=  Comprehensive object caching support including cluster integration for some
application servers (such as, for example, Oracle Application Server).

= Extensive query capability including: TopLink Expressions framework, Java
Persistence Query Language (JP QL), Enterprise JavaBeans Query Language (EJB
QL), and native SQL.

= Just-in-time reading

= Object-level transaction support and integration with popular application servers
and databases.

= Optimistic and pessimistic locking options and locking policies.

= Comprehensive visual design tools: Oracle JDeveloper TopLink Editor, Eclipse
Dali, and Oracle TopLink Workbench.

For additional information, see the TopLink page on OTN:

http://www.oracle.com/technology/products/ias/toplink/index.html

1.4 TopLink Application Architectures

You can use TopLink in a variety of application architectures, including three- and
two-tier architectures, with or without Java EE, to access a variety of data types on
both relational and nonrelational data sources.

Figure 1-3 TopLink and Your Application Architecture
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For more information on strategies for incorporating TopLink into your application
architecture, see Section 2.2, "Designing Your Application with TopLink".

This section introduces some of the following common enterprise architectures used
by TopLink applications:

Three-Tier

The three-tier (or Java EE Web) application is one of the most common TopLink
architectures. This architecture is characterized by a server-hosted environment in
which the business logic, persistent entities, and the Oracle TopLink Foundation
Library all exist in a single Java Virtual Machine (JVM). See Section 2.11,
"Considering Three-Tier Architecture" for more information.

The most common example of this architecture is a simple three-tier application in
which the client browser accesses the application through servlets, JavaServer
Pages (JSP) and HTML. The presentation layer communicates with TopLink
through other Java classes in the same JVM, to provide the necessary persistence
logic. This architecture supports multiple servers in a clustered environment, but
there is no separation across JVMs from the presentation layer and the code that
invokes the persistence logic against the persistent entities using TopLink.

EJB Session Bean Facade

A popular variation on the three-tier application involves wrapping the business
logic, including the TopLink access, in E]B session beans. This architecture
provides a scalable deployment and includes integration with transaction services
from the host application server. See Section 2.13, "Considering EJB Session Bean
Facade Architecture" for more information.

Communication from the presentation layer occurs through calls to the EJB session
beans. This architecture separates the application into different tiers for the
deployment. The session bean architecture can persist either Java objects or EJB
entity beans.

EJB 3.0 Entities with JPA

The E]JB 3.0 specification includes an additional persistence specification called the
Java Persistence API (JPA). You can use this API for creating, reading, updating,
and deleting plain old Java objects (POJO) within both a compliant EJB 3.0 Java EE
container and a standard Java SE 5 (or later) environment.

EclipseLink JPA is a standards-compliant JPA persistence provider built on the
EclipseLink foundation library. EclipseLink JPA offers a variety of vendor
extensions (annotations and persistence unit properties) that give you full access
to the underlying EclipseLink APL

For more information, see the following;:

- '"Java Persistence API Overview" section of EclipseLink Developer’s Guide at
http://wiki.eclipse.org/Introduction_to_Java_Persistence_
API_%28ELUG%29

- "Introduction to EclipseLink JPA" section of EclipseLink Developer’s Guide at
http://wiki.eclipse.org/Introduction_to_EclipseLink_JPA_
%28ELUG%29

— http://wiki.eclipse.org/EclipselLink/UserGuide/Developing
JPA_Projects_%28ELUG%29

— Section 2.16, "Considering JPA Entity Architecture"
EJB Entity Beans with CMP

Introduction to TopLink 1-5



TopLink Application Architectures

TopLink provides CMP support for applications that require the use of E]B entity
beans. This support is available on the leading application servers. TopLink CMP
support provides you with an EJB 1.0, 1.1, 2.0 and 2.1 CMP solution transparent to
the application code, but still offers all the TopLink run-time benefits. See

Section 2.14, "Considering EJB Entity Beans with CMP Architecture" for more
information.

Applications can access TopLink-enabled entity beans with container-managed
persistence directly from the client, or from within a session bean layer. TopLink
also offers the ability to use regular Java objects in relationships with enterprise
entity beans.

Note: Even though TopLink fully supports EJB 1.0, 1.1, 2.0, 2.1 and
JPA, this edition of Oracle TopLink Developer’s Guide only focuses on
EJB 2.0, 2.1, and JPA. For detailed information on TopLink support for
EJB 1.0 and 1.1, refer to the earlier editions of Oracle TopLink
Developer’s Guide.

= EJB Entity Beans with BMP

Another option for using EJB entity beans is to use TopLink BMP in the
application. This architecture enables you to access the persistent data through the
EJB application programming interface (API), but is platform independent. See
Section 2.15, "Considering EJB Entity Beans with BMP Architecture" for complete
information.

The BMP approach is portable-that is, after you create an application, you can
move it from one application server platform to another.

s Web Services

A Web services architecture is similar to the three-tier or session-bean architecture.
However, in a Web services architecture you encapsulate business logic (the
service) in a Web service instead of (or in addition to) using session beans. In a
Web services architecture, clients communicate with your application using XML.

As in any architecture, you can use TopLink to persist objects to relational or EIS
data sources. However, in a Web services architecture you can also use TopLink to
map your object model to an XML schema for use with the Web service or as the
Web service XML serializer.

See Section 2.17, "Considering Web Services Architecture" for more information
s Two-Tier

A two-tier (or client/server) application is one in which the TopLink application
accesses the database directly. Although less common than the other architectures
discussed here, TopLink supports this architecture for smaller or embedded data
processing applications. See Section 2.12, "Considering Two-Tier Architecture" for
more information.
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Introduction to TopLink
Application Development

This chapter describes how to build a TopLink application, including suggested
development processes, architectures, and technologies.

This chapter includes the following sections:

Introduction to TopLink Application Development
Designing Your Application with TopLink

Selecting an Architecture with TopLink

Building and Using the Persistence Layer

Deploying the Application

Optimizing and Customizing the Application
Persisting Objects

Working with TopLink Metadata

Using Weaving

Considering Three-Tier Architecture

Considering Two-Tier Architecture

Considering EJB Session Bean Facade Architecture
Considering E]JB Entity Beans with CMP Architecture
Considering E]JB Entity Beans with BMP Architecture
Considering JPA Entity Architecture

Considering Web Services Architecture

Considering EclipseLink Service Data Objects (SDO) Architecture

2.1 Introduction to TopLink Application Development

To ensure the best design for your TopLink application, Oracle recommends that you
follow an iterative step-by-step development process. The flexibility of TopLink lets
you use any development tool.

This section describes following recommended development process:

Typical Development Stages
Oracle Development Support
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2.1.1 Typical Development Stages

This section describes the general development stages of a TopLink application.
Figure 21 illustrates the TopLink development process.

Figure 2—-1 TopLink Development Process

1 Define the application requirements.

Create an object model.

2 Create Java classes.

Create new or integrate existing data source.

3 Import classes and data source into
Cracle TopLink Mapping Workbench.

Create descriptors and mappings.

4 Create database sessions.

Query and update data source information.

5 Generate deployment files.
Package and deploy the application.
|ﬂ 6 Customize and optimize.

Design the Application (1)

Define your application requirements, select an architecture, and determine the target
platform. See Section 2.2, "Designing Your Application with TopLink" for more
information. Remember, TopLink works with any architecture and any platform.

When designing the application, you should also create an object model for the
application. See Section 2.8, "Persisting Objects" for more information. It is important
to create the object model before using TopLink to map objects, because defining
persistent mappings for an incorrect or rapidly changing model can be very difficult.

Develop the Application (2, 3, 4)

Create the Java classes and decide how the classes should be implemented by the data
source. When working with a legacy system, decide how the classes relate to the
existing data. If there is no legacy data source to integrate, decide how to store each
class in the data source and create the required schema. Alternatively, you may use
TopLink to create your initial tables.

Using Oracle JDeveloper TopLink Editor or TopLink Workbench, create descriptors
and mappings for the persistent classes. Use TopLink sessions to manipulate the
persistent classes, including querying and changing data. See Part II, "TopLink
Development Tools Overview" for more information.

Avoid building all your model's descriptors in a single iteration. Start with a small
subset of your classes. Build and test their descriptors, then gradually add new
descriptors and relationships. This lets you catch common problems before they
proliferate through your entire design.
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Write Java code to use database sessions. Sessions are used to query for database
objects and write objects to the database. See Chapter 87, "Introduction to TopLink
Sessions" for more information.

Deploy the Application (5)
Generate, package, then deploy the necessary files to your application server. The

required information will vary, depending on your environment and architecture. See
Part I1I, "TopLink Application Deployment" for more information.

Maintain the Application (6)

TopLink includes many options that can enhance application performance. You can
customize most aspects of TopLink to suit your requirements. Use advanced TopLink
features or write custom querying routines to access the database in specific ways, and
to optimize performance. See Part IV, "Optimization and Customization of a TopLink
Application” for more information.

2.1.2 Oracle Development Support

Oracle provides additional support for you as a TopLink developer on the Oracle
Technology Network (OTN), including the following:

= Metalink support

= Discussion forums
=  How-to documents
= Examples

You must register online before using OTN; registration is free of charge and can be
done at

http://www.oracle.com/technology/membership

If you already have a user name and password for OTN, then you can go directly to
the documentation section of the OTN Web site at

http://www.oracle.com/technology/docs

Using your OTN user name and password, you can also access the TopLink
developer’s forum to post questions and get answers about using TopLink at

http://forums.oracle.com/forums/forum. jsp?forum=48

2.2 Designing Your Application with TopLink

When you design your application, you must choose how and where to use TopLink.
You can use TopLink to perform a variety of persistence and data transformation
functions (see Section 2.2.1, "How to Use TopLink in Your Application Design") on a
variety of Java-supporting platforms (see Section 2.2.2, "Target Platforms"). When you
design your application architecture, keep these capabilities in mind (see Section 2.3,
"Selecting an Architecture with TopLink").

2.2.1 How to Use TopLink in Your Application Design

This section describes the basic ways in which you can use TopLink, including the
following usage types:

= Relational Database Usage
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»s  Object-Relational Data Type Database Usage
s Oracle XML Database (XDB) Usage

»  Enterprise Information System (EIS) Usage

s XML Usage

2.2.1.1 Relational Database Usage
You can use TopLink to persist Java objects to relational databases that support SQL
data types accessed using JDBC.

For more information, see Section 18.1.1, "How to Build Relational Projects for a
Relational Database".

2.2.1.2 Object-Relational Data Type Database Usage

You can use TopLink to persist Java objects to object-relational data type databases that
support data types specialized for object storage (such as Oracle Database) accessed
using JDBC.

For more information, see Section 18.1.2, "How to Build Relational Projects for an
Object-Relational Data Type Database".

2.2.1.3 Oracle XML Database (XDB) Usage
You can use TopLink to persist XML documents to an Oracle XML database using
TopLink direct-to-XMLType mappings.

For more information, see Chapter 18, "Introduction to Relational Projects" and
Section 27.4, "Direct-to-XMLType Mapping".

2.2.1.4 Enterprise Information System (EIS) Usage

You can use TopLink to persist Java objects to an EIS data source using a JCA adapter.
In this scenario, the application invokes EIS data source-defined operations by sending
EIS interactions to the JCA adapter. Operations can take (and return) EIS records.

Using TopLink EIS descriptors and mappings, you can easily map Java objects to the
EIS record types supported by your JCA adapter and EIS data source.

This usage is common in applications that connect to legacy data sources and is also
applicable to Web services.

For more information, see Chapter 71, "Introduction to EIS Projects".

2.2.1.5 XML Usage

You can use TopLink for in-memory, nonpersistent Java object-to-XML transformation
with XML Schema (XSD) based XML documents and JAXB.

You can use the TopLink JAXB compiler with your XSD to generate both JAXB-specific
artifacts (such as content and element interfaces, implementation classes, and object
factory class) and TopLink-specific artifacts (such as sessions and project XML files
and TopLink Workbench project). For more information, see Section 47.1.1, "TopLink
Support for Java Architecture for XML Binding (JAXB)".

This usage has many applications, including messaging and Web services.

For more information, see Chapter 47, "Introduction to XML Projects".
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2.2.2 Target Platforms

TopLink supports any enterprise architecture that uses Java, including the following:
s Java EE

= Spring

= Java Web servers such as Tomcat

= Java clients such as Java SE and Web browsers

s Server Java platforms

Application packaging requirements of the specific target platform (for deployment in
the host Java or Java EE environment) influences how you use and configure TopLink.
For example, you package a Java EE application in an Enterprise Archive (EAR) file.
Within the EAR file, there are several ways to package persistent entities within Web
Archive (WAR) and Java Archive (JAR). How you configure TopLink depends, in part,
on how you package the application and how you use the host application server class
loader.

In addition, TopLink provides custom CMP integration for a variety of application
servers.

For detailed information about supported application server versions, custom
integration, and configuration requirements, see Chapter 8, "Integrating TopLink with
an Application Server".

2.3 Selecting an Architecture with TopLink

2.3.1 Tiers

This section describes some of the key aspects of application architecture that apply to
TopLink and discusses the various options available for each, including the following:

s Tiers

= Service Layer
m Data Access
s Caching

s Locking

This section describes choices you need to make when deciding on how to separate
client and server functionality in your application architecture.

These choices can be summarized as follows:
n  Three Tier
— Java EE or Non-Java EE
— Client
*  Web client
*  XML/Web service client
*  Java (fat) client

s Two Tier
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2.3.1.1 Three Tier

Oracle recommends a three-tier application architecture. With a three-tier architecture,
Oracle recommends using EclipseLink JPA or server sessions and client sessions (see
Section 87.3, "Server and Client Sessions") and the TopLink unit of work (see

Chapter 113, "Introduction to TopLink Transactions").

For more information, see Section 2.11, "Considering Three-Tier Architecture".

23.1.1.1  Java EE or Non-Java EE You can use TopLink in a Java EE or non-Java EE
application architecture. Oracle recommends that you use a Java EE application
architecture.

With a Java EE application, you should use external connection pools (see

Section 96.1.6.2, "External Connection Pools"). You may consider using JPA or CMP,
EJB session beans, and Java Transaction API (JTA) integration (see Section 113.1.2.1,
"JTA Controlled Transactions").

With a non-Java EE application, you should use internal connection pools (see
Section 96.1.6.1, "Internal Connection Pools"). You may still consider using JPA.

23.1.1.2 Client In a three-tier application architecture, you can implement any of the
following types of client:

= Web client-Oracle recommends that you implement a Web client.

= XML/Web service client-With this client type, you can use TopLink XML (see
Section 2.2.1.5, "XML Usage").

= Java (fat) client-With this client type, you can choose the means of communicating
with the server:

-  EJB session beans—Oracle recommends this approach. You may consider using
the UnitOfWork method mergeClone to handle merging deserialized objects
(see Section 115.5, "Merging Changes in Working Copy Clones"). The
disadvantage of this approach is that your application must handle
serialization. Avoid serializing deep object graphs. You should use indirection,
also known in JPA as lazy loading (see Section 121.3, "Configuring Indirection
(Lazy Loading)"). Consider using the data-transfer-object pattern.

- XML/Web service-Use TopLink XML (see Section 2.2.1.5, "XML Usage").

- EJB entity bean-Use TopLink CMP integration or BMP support. The
disadvantage of this approach is that remote entity beans may not perform or
scale well.

- RMI-You may consider using a TopLink remote session (see Section 87.9,
"Remote Sessions"). The disadvantage of this approach is that a remote session
is stateful and may not scale well.

See also Section 2.3.2, "Service Layer".

2.3.1.2 Two Tier

With a two-tier application architecture, Oracle recommends using TopLink database
sessions (see Section 87.8, "Database Sessions") and the TopLink unit of work (see
Chapter 113, "Introduction to TopLink Transactions"). The disadvantages of this
architecture are that it is not Web-enabled and does not scale well to large
deployments.

For more information, see Section 2.12, "Considering Two-Tier Architecture".
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2.3.2 Service Layer

This section describes choices you need to make when deciding on how to encapsulate
your application’s business logic (or service).

These choices can be summarized as follows:
s EJB Session Beans
— Stateful
— Stateless
»  EJB Entity Beans
— Container-Managed Persistence (CMP)
— Bean-Managed Persistence (BMP)
s JPA Entities
s Plain Old Java Objects (POJO)
See also:
s Section 2.3.3, "Data Access"
s Section 2.3.4, "Caching"

2.3.2.1 EJB Session Beans

Oracle recommends using EJB session beans.

With EJB session beans, you should use JTA integration (see Section 113.1.2.1, "JTA
Controlled Transactions") and external connection pools (see Section 96.1.6.2, "External
Connection Pools"). You should acquire a unit of work (see Section 115.13.1, "How to
Acquire a Unit of Work with an External Transaction Service").

For more information, see Section 2.13, "Considering E]B Session Bean Facade
Architecture".

2.3.2.1.1 Stateful If you are using stateful session beans, then note that a reference to a
client session cannot be passivated. In this case, you must reacquire a client session
(see Section 87.2.4, "Acquiring a Session at Run Time with the Session Manager") on
activate or per request.

2.3.2.1.2 Stateless If you are using stateless session beans, you must acquire new client
session (see Section 87.2.4, "Acquiring a Session at Run Time with the Session
Manager") for each request.

2.3.2.2 EJB Entity Beans

EJB entity bean architectures are slightly different from other TopLink architectures,
because the EJB entity bean interfaces hide TopLink functionality completely from the
client application developer.

You can use entity beans in almost any Java EE application. For TopLink, how the
application uses the entity beans is not important; how entity beans are mapped and
implemented is important to TopLink.

2.3.2.2.1 Container-Managed Persistence (CMP) Oracle recommends using entity beans

with container-managed persistence. In this case, you should use the TopLink CMP
integration for your application server. You must ensure that you are using a Java EE

Introduction to TopLink Application Development 2-7



Selecting an Architecture with TopLink

server that TopLink supports (see Chapter 8, "Integrating TopLink with an Application
Server").

For more information, see Section 2.14, "Considering E]JB Entity Beans with CMP
Architecture".

2.3.2.2.2 Bean-Managed Persistence (BMP) If you are using entity beans with
bean-managed persistence, you should use the TopLink BMP integration. The
disadvantages of this architecture are that the BMP architecture is restrictive and may
not provide good performance.

For more information, see Section 2.15, "Considering E]JB Entity Beans with BMP
Architecture".

2.3.2.3 JPA Entities

Java Persistence API (JPA) is a specification for persistence in Java EE and Java SE
applications. In JPA, a persistent class is referred to as an entity. An entity is a plain old
Java object (POJO) class (see Section 2.3.2.4, "Plain Old Java Objects (POJO)") that is
mapped to the database and configured for usage through JPA using annotations,
persistence XML, or both.

With JPA, when your application is running inside a container, all of the benefits of the
container support and ease of use apply. Note that you can configure the same
application to run outside the container.

You can use session beans (see Section 2.3.2.1, "E]JB Session Beans") as the means for
your application to interact with JPA.

EclipseLink JPA is a standards-compliant JPA persistence provider built on the
EclipseLink foundation library. EclipseLink JPA offers a variety of vendor extensions
(annotations and persistence unit properties) that give you full access to the
underlying EclipseLink API to take advantage of additional functionality and
performance benefits.

For more information, see the following;:
m  Section 2.16, "Considering JPA Entity Architecture"
m  Section 1.4, "TopLink Application Architectures"

2.3.2.4 Plain Old Java Objects (POJO)

If you choose to build your service layer with non-E]B Java objects with a Java EE
application server, you should use external connection pools (see Section 96.1.6.2,
"External Connection Pools"). If you use a non-Java EE Web server, you should use
internal connection pools (see Section 96.1.6.1, "Internal Connection Pools"). In either
case, you may consider using JTA integration (see Section 113.1.2.1, "JTA Controlled
Transactions").

2.3.3 Data Access

This section describes choices you need to make when deciding on what type of data
your application architecture must support.

These choices can be summarized as follows:
s Data Type
= Multiple Data Sources

= Isolating Data Access
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s Historical Data Access

See also Section 2.3.5, "Locking".

2.3.3.1 Data Type

You can use TopLink to manage any of the following types of data:
» relational (see Section 2.2.1.1, "Relational Database Usage");

= object-relational data type (see Section 2.2.1.2, "Object-Relational Data Type
Database Usage");

s Oracle XDB (see Section 2.2.1.3, "Oracle XML Database (XDB) Usage");

s EIS, nonrelational, legacy data (see Section 2.2.1.4, "Enterprise Information System
(EIS) Usage");

s XML and Web service data (see Section 2.2.1.5, "XML Usage").

2.3.3.2 Multiple Data Sources

If your application architecture must access more than one data source, Oracle
recommends that you use a session broker (see Section 87.7, "Session Broker and Client
Sessions'") and JTA integration (see Section 113.1.2.1, "JTA Controlled Transactions") for
two-phase commit.

Alternatively, you may use multiple sessions.

2.3.3.3 Isolating Data Access

If your application architecture requires that some data be restricted to a private cache
and isolated from the TopLink shared session cache, Oracle recommends that you use
an isolated session (see Section 87.5, "Isolated Client Sessions"). You can also use an
isolated session with the Oracle Virtual Private Database (VPD) feature (see

Section 87.5.1, "Isolated Client Sessions and Oracle Virtual Private Database (VPD)").

2.3.3.4 Historical Data Access

If your data source maintains past or historical versions of objects, Oracle recommends
that you use a TopLink historical session (see Section 87.6, "Historical Sessions") to
access this historical data so that you can express read queries conditional on how
your objects are changing over time.

2.3.4 Caching

This section describes choices you need to make when deciding on how to use the
TopLink cache (see Chapter 102, "Introduction to Cache") in your application
architecture.

These choices can be summarized as follows:
n  Cache Type
s Refreshing
s Cache Coordination
—  Protocol
- Synchronization

See also Section 2.3.5, "Locking".
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2.3.4.1 Cache Type

Choose a cache type (see Section 102.2.1, "Cache Type and Object Identity")
appropriate for the type of data your application processes. For example, consider a
weak identity map for volatile data (see Section 102.2.1.6, "Guidelines for Configuring
the Cache and Identity Maps").

2.3.4.2 Refreshing

Consider how your application architecture may be affected by stale data (see
Section 102.2.3, "Handling Stale Data"): for example, consider using query or
descriptor refresh options (see Section 2.3.4.2, "Refreshing") or cache invalidation (see
Section 102.2.5, "Cache Invalidation"). Consider using an isolated session’s cache (see
Section 87.5, "Isolated Client Sessions") for volatile data.

Avoid using no identity map (seeSection 102.2.1.5, "No Identity Map") for objects that
are involved in relationships or that require object identity.

2.3.4.3 Cache Coordination

TopLink provides a distributed cache coordination feature that allows multiple,
possibly distributed, instances of a session to broadcast object changes among each
other so that each session’s cache is kept up to date (see Section 102.3, "Cache
Coordination"). Before using cache coordination, ensure that it is appropriate for your
application (see Section 102.3.1, "When to Use Cache Coordination").

2.3.4.3.1 Protocol You can configure a coordinated cache to broadcast changes using
any of the following communication protocols:

= Java Message Service (JMS)-Oracle recommends using a JMS coordinated cache
(see Section 102.3.3.1, "JMS Coordinated Cache").

= Remote Method Invocation (RMI)-Oracle recommends that you use RMI cache
coordination only if you require synchronous change propagation (see
Section 103.2, "Configuring the Synchronous Change Propagation Mode"). For
more information, see Section 102.3.3.2, "RMI Coordinated Cache".

s Common Object Request Broker Architecture (CORBA)-Currently, TopLink
provides support for the Sun ORB (see Section 102.3.3.3, "CORBA Coordinated
Cache").

2.3.4.3.2 Synchronization You can configure synchronization strategy that a
coordinated cache uses to determine what it broadcasts when an object changes. You
can configure this at the project (see Section 117.12, "Configuring Cache Coordination
Change Propagation at the Project Level") or descriptor (Section 119.15, "Configuring
Cache Coordination Change Propagation at the Descriptor Level") level as follows:

» Invalidate changed objects—Propagate an object invalidation that marks the object
as invalid in all other sessions. This tells other sessions that they must update their
cache from the data source the next time this object is read. Oracle recommends
using this synchronization strategy.

= Synchronize changes-Propagate a change notification that contains each changed
attribute.

= Synchronize changes and new objects—-Propagate a change notification that
contains each changed attribute. For new objects, propagate an object creation
(along with all the new instance’s attributes).
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2.3.5 Locking

This section describes choices you need to make when deciding on how to use
TopLink locking options in your application architecture. Oracle strongly recommends
always using a locking policy in a concurrent system (see Section 119.26, "Configuring
Locking Policy").

These choices can be summarized as follows:
s Optimistic Locking
»  Pessimistic Locking

If you are building a three-tier application, be aware of how that architecture affects
the way you use locking (see Section 16.4.6, "Locking in a Three-Tier Application").

For more information, see Section 16.4, "Descriptors and Locking".

2.3.5.1 Optimistic Locking

Oracle recommends using TopLink optimistic locking. With optimistic locking, all
users have read access to the data. When a user attempts to write a change, the
application checks to ensure the data has not changed since the user read the data.

You can use version (see Section 16.4.1, "Optimistic Version Locking Policies") or field
(see Section 16.4.4, "Optimistic Field Locking Policies") locking policies. Oracle
recommends using version locking policies.

2.3.5.2 Pessimistic Locking

With pessimistic locking, the first user who accesses the data with the purpose of
updating it locks the data until completing the update. The disadvantage of this
approach is that it may lead to reduced concurrency and deadlocks.

Consider using pessimistic locking support at the query level (see Section 119.7.1.9,
"Configuring Named Query Options").

If are using CMP, you may consider using bean-level pessimistic locking support (see
Section 119.7.1.9, "Configuring Named Query Options").

2.4 Building and Using the Persistence Layer

Oracle TopLink requires that classes must meet certain minimum requirements before
they can become persistent. TopLink also provides alternatives to most requirements.
TopLink uses a nonintrusive approach by employing a metadata architecture that
allows for minimal object model intrusions.

This section includes the following information:
s Implementation Options

n  Persistent Class Requirements

mn  Persistence Layer Components

s How to Use the Persistence Layer

2.4.1 Implementation Options

When implementing your persistence layer using TopLink, consider the following
options:

s Using EclipseLink JPA Metatdata, Annotations, and XML
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s Using TopLink Metatdata XML

s Using TopLink Metadata Java API

s Using Method and Direct Field Access
s Using Weaving

2.4.1.1 Using EclipseLink JPA Metatdata, Annotations, and XML

When using JPA, you can specify persistence layer components using any combination
of standard JPA annotations and persistence.xml, EclipseLink JPA annotation
extensions, and EclipseLink JPA persistence.xml extensions.

For more information, see Section 2.16, "Considering JPA Entity Architecture".

2.4.1.2 Using TopLink Metatdata XML
Persistence layer components may be generated as metadata from Oracle JDeveloper
or TopLink Workbench.

Oracle recommends using Oracle JDeveloper or TopLink Workbench to create the
necessary metadata (stored as XML). You can easily export and update the
project.xml and sessions.xml files. This reduces development effort by
eliminating the need to regenerate and recompile Java code each time you change the
project. With Oracle JDeveloper or TopLink Workbench, you write Java code only for
your own application classes and any necessary amendment methods. For information
about the XML structure of the project .xml and sessions.xml files, refer to the
appropriate XML schemas (XSD) in the TOPLINK_HOME/xsds directory.

TopLink Workbench provides Ant tasks that you can use to integrate TopLink
Workbench with your automated builds.

For more information, see the following:
»  Section 2.9, "Working with TopLink Metadata"
s Section 5.8, "Integrating TopLink Workbench with Apache Ant"

2.4.1.3 Using TopLink Metadata Java API

Persistence layer components may be coded or generated as Java from Oracle
JDeveloper or TopLink Workbench.

To use Java code, you must manually write code for each element of the TopLink
project including: project, login, platform, descriptors, and mappings. This may be
more efficient if your application is model-based and relies heavily on code
generation. Depending on the type of project you are creating, Oracle JDeveloper and
TopLink Workbench can export Java code for projects, tables, and your model source.

TopLink Workbench provides Ant tasks that you can use to integrate TopLink
Workbench with your automated builds.

For more information, see the following:
»  Section 116.3, "Exporting Project Information"

s Section 5.8, "Integrating TopLink Workbench with Apache Ant"
2.4.1.4 Using Method and Direct Field Access

You can access the fields (data members) of a class by using a getter/setter method
(also known as property access) or by accessing the field itself directly.
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When to use method or direct field access depends on your application design.
Consider the following guidelines:

s Use method access outside of a class.

This is the natural public API of the class. The getter/setter methods handle any
necessary side-effects and the client need not know anything about those details.

»  Use direct field access within a class to improve performance.

In this case, you are responsible for taking into consideration any side-effects not
invoked by bypassing the getter/setter methods.

When considering using method or direct field access, consider the following
limitations.

If you enable change tracking on a getter/setter method (for example, you decorate
method setPhone with @ChangeTracking), then TopLink tracks changes
accordingly when a client modifies the field (phone) using the getter/setter methods.

Similarly, if you enable change tracking on a field (for example, you decorate field
phone with @ChangeTracking), then TopLink tracks changes accordingly when a
client modifies the field (phone) directly.

However, if you enable change tracking on a getter /setter method (for example, you
decorate method setPhone with @ChangeTracking) and a client accesses the field
(phone) directly, TopLink does not detect the change. If you choose to code in this
style—field access within a class for performance and method access outside of a class
-be aware of this limitation.

For more information, see the following;:
m  Section 117.4, "Configuring Method or Direct Field Access at the Project Level"

m  Section 121.6, "Configuring Method or Direct Field Accessing at the Mapping
Level"

= Section 113.2.3, "Unit of Work and Change Policy"

s "How to Use the @ChangeTracking Annotation" section of EclipseLink Developer’s
Guide athttp://wiki.eclipse.org/Using_EclipseLink_ JPA_
Extensions_%28ELUG%29#How_to_Use_the_.40ChangeTracking
Annotation

m  Section 119.30, "Configuring Change Policy"

2.4.1.5 Using Weaving

Weaving is a technique of manipulating the byte-code of compiled Java classes.

Weaving is used to enhance both JPA entities and Plain Old Java Object (POJO) classes
for such things as lazy loading, change tracking, fetch groups, and internal
optimizations.

For more information, see Section 2.10, "Using Weaving".

2.4.2 Persistent Class Requirements

The following requirements apply to plain Java objects:

= You can use direct access on private or protected attributes. For more information
on direct and method access, see Section 121.6, "Configuring Method or Direct
Field Accessing at the Mapping Level".
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= When using nontransparent indirection, the attributes must be of the type
ValueHolderInterface rather than the original attribute type. The value
holder does not instantiate a referenced object until it is needed.

»  TopLink provides transparent indirection for Collection, List, Set, and Map
attribute types for any collection mappings. Using transparent indirection does not
require the use of the ValueHolderInterface or any other object model
requirements.

If you are using weaving, the ValueHolderInterface is not required. For more
information, see Section 2.4.1.5, "Using Weaving".

Note: For EJB 2.0 entity beans with container-managed persistence,
the bean requirements are defined by the EJB 2.0 specification; for E]B
2.1 entity beans with container-managed persistence, the bean
requirements are defined by the EJB 2.1 specification.

See Section 17.2.4, "Indirection (Lazy Loading)" for more information on indirection
and transparent indirection.

2.4.3 Persistence Layer Components

Typically, the TopLink persistence layer contains the following components:
s  Mapping Metadata

= Session

s Cache

s Queries and Expressions

s Transactions

2.4.3.1 Mapping Metadata

The TopLink application metadata model is based on the TopLink project. The project
includes descriptors, mappings, and various policies that customize the run-time
capabilities. You associate this mapping and configuration information with a
particular data source and application by referencing the project from a session.

For more information, see the following:

= Section 2.9.2, "Creating Project Metadata"
s Chapter 15, "Introduction to Projects"

s Chapter 16, "Introduction to Descriptors"

s Chapter 17, "Introduction to Mappings"

2.4.3.2 Session

A session is the primary interface between the client application and TopLink, and
represents the connection to the underlying data source.

TopLink offers several different session types (see Chapter 87, "Introduction to
TopLink Sessions"), each optimized for different design requirements and
architectures. The most commonly used session is the server session, a session that
clients access on the server through a client session. The server session provides a
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shared cache and shared connection resources. You define a session with session
metadata.

For CMP projects, the TopLink run-time creates and uses a session internally, but your
application does not acquire or use this session directly. Depending on the application
server you use, you can specify some of the parameters for this internal session.

For EclipseLink JPA projects, the EntityManager represents (wraps) the session.
For more information, see the following:
m  Section 2.9.3, "Creating Session Metadata"

»s  Section 2.4.4, "How to Use the Persistence Layer"

2.4.3.3 Cache

By default, a TopLink session provides an object-level cache that guarantees object
identity and enhances performance by reducing the number of times the application
needs to access the data source. TopLink provides a variety of cache options, including
locking, refresh, invalidation, isolation, and coordination. Using cache coordination,
you can configure TopLink to synchronize changes with other instances of the
deployed application. You configure most cache options at the session level. You can
also configure cache options on a per-query basis or on a descriptor to apply to all
queries on the reference class.

For more information, see Chapter 102, "Introduction to Cache".

2.4.3.4 Queries and Expressions

TopLink provides several object and data query types, and offers flexible options for
query selection criteria, including the following:

s TopLink expressions

s JPQL (Java Persistence Query Language)
= SQL

= Stored procedures

s Query by example

With these options, you can build any type of query. Oracle recommends using
predefined queries to define application queries. Predefined queries are held in the
project metadata and referenced by name. This simplifies application development
and encapsulates the queries to reduce maintenance costs.

When using entity beans, you can code finders completely using EJB QL (in addition
to any of the other TopLink query options), enabling the application to comply with
the Java EE specification.

Regardless of the architecture or persistent entity type, you are free to use any of the
query options. Oracle JDeveloper and TopLink Workbench provide the simplest way
to define queries. Alternatively, you can build queries in code, using the TopLink APL

For more information, see Chapter 108, "Introduction to TopLink Queries" and
Chapter 110, "Introduction to TopLink Expressions".

2.4.3.5 Transactions

TopLink provides the ability to write transactional code isolated from the underlying
database and schema by using a unit of work, a specific transactional session.
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The unit of work isolates changes in a transaction from other threads until it
successfully commits the changes to the database. Unlike other transaction
mechanisms, the unit of work automatically manages changes to the objects in the
transaction, the order of the changes, and changes that might invalidate other TopLink
caches. The unit of work manages these issues by calculating a minimal change set,
ordering the database calls to comply with referential integrity rules and deadlock
avoidance, and merging changed objects into the shared cache. In a clustered
environment, the unit of work also synchronizes changes with the other servers in the
coordinated cache.

If an application uses entity beans, you do not access the unit of work API directly, but
you still benefit from its features: the integration between the TopLink runtime and the
Java EE container automatically uses the unit of work to the application’s best
advantage.

For more information, see Chapter 108, "Introduction to TopLink Queries".

2.4.4 How to Use the Persistence Layer

At run time, your application uses the TopLink metadata (see Section 2.9, "Working
with TopLink Metadata").

For a POJO (non-CMP) project, your application loads a session.xml file at run time
using the session manager (see Chapter 90, "Acquiring and Using Sessions at Run
Time"). The session.xml file contains a reference to the mapping metadata
project.xml file. Using the session, your application accesses the TopLink runtime
and the project.xml mapping metadata.

For a CMP project, the metadata required is dependent upon the Java EE application
server you deploy your application to (see Chapter 9, "Creating TopLink Files for
Deployment"). All application servers require an ejb-jar.xml and a TopLink project
XML file. The session configuration is dependent on the specific Java EE application
server.

2.5 Deploying the Application

Application packaging (for deployment in the host Java or Java EE environment)
influences TopLink use and configuration. For example, you package a Java EE
application in an EAR file. Within the EAR file, there are several ways to package
persistent entities within WAR and JAR. How you configure TopLink depends, in part,
on how you package the application and how you use the class loader of the host
application server.

This section discusses packaging and deployment from a TopLink perspective.
However, if you deploy your application to a Java EE container, you must configure
elements of your application to enable TopLink container support.

This section includes the following information:
s About Deployments
s How to Use TopLink in a Java EE Application

For more information, see Part III, "TopLink Application Deployment".
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2.5.1 About Deployments

The TopLink approach to deployment involves packaging application files into a
single file, such as aJAR file, or an EAR file. This approach lets you create clean and
self-contained deployments that do not require significant file management.

After creating these files, deploy the project.

2.5.2 How to Use TopLink in a Java EE Application

Although TopLink is an integral part of a Java EE application, in most cases the client
does not interact with TopLink directly. Instead, TopLink features are invoked
indirectly by way of EJB container callbacks.

As a result, the typical deployment process involves the following steps:
1. Build the project elements, including beans, classes, and data sources.

2. Define the application mappings in Oracle JDeveloper TopLink Editor or TopLink
Workbench.

3. Build the application deployment files. Use Oracle JDeveloper or TopLink
Workbench to create the files.

4. Package and deploy the application.
5. Add code to the client application to enable it to access the TopLink application.

2.6 Optimizing and Customizing the Application

TopLink provides a diverse set of features to optimize performance including the
following:

»  Enhancing queries
s Tuning the cache
= Scaling to multiple server configuration

You enable or disable most features in the descriptors or session, making any resulting
performance gains global.

Using TopLink EIS (see Section 2.2.1.4, "Enterprise Information System (EIS) Usage"),
you can integrate a TopLink application with legacy data sources using a JCA adapter.
This is the most efficient way to customize a TopLink application to accommodate
unusual or nonstandard systems.

Using TopLink XML (see Section 2.2.1.5, "XML Usage"), you can integrate a TopLink
application with legacy data sources using a Web service.

See Part IV, "Optimization and Customization of a TopLink Application" for details on
optimizing and customizing TopLink.

2.7 Troubleshooting the Application

See Appendix A, "Troubleshooting a TopLink Application" for information on
troubleshooting all aspects of a TopLink application including development and
deployment.
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2.8 Persisting Objects

This section includes a brief description of relational mapping and provides important
information and restrictions to guide object and relational modeling. This information
is useful when building TopLink applications.

This section includes information on the following:
= Application Object Model

s Data Storage Schema

= Primary Keys and Object Identity

= Mappings

= Foreign Keys and Object Relationships
= Inheritance

= Concurrency

s Caching

= Nonintrusive Persistence

s Indirection

= Mutability

These sections contain additional detail on these features, and explain how to
implement and use them with TopLink.

2.8.1 Application Object Model

Object modeling refers to the design of the Java classes that represent your application
objects. With TopLink, you can use your favorite integrated development environment
(IDE) or Unified Modeling Language (UML) modeling tool to define and create your
application object model.

Any class that registers a descriptor with a TopLink database session is called a
persistent class. TopLink does not require that persistent classes provide public
accessor methods for any private or protected attributes stored in the database. Refer
to Section 2.4.2, "Persistent Class Requirements" for more information.

2.8.2 Data Storage Schema

Your data storage schema refers to the design that you implement to organize the
persistent data in your application. This schema refers to the data itself-not the actual
data source (such as a relational database or nonrelational legacy system).

During the design phase of the TopLink application development process (see

Section 2.1.1, "Typical Development Stages"), you should decide how to implement the
classes in the data source. When integrating existing data source information, you
must determine how the classes relate to the existing data. If no legacy information
exists to integrate, decide how you will store each class, then create the necessary
schema.

You can also use Oracle JDeveloper (see Chapter 4, "Using Oracle JDeveloper TopLink
Editor"), TopLink Workbench (see Chapter 5, "Using TopLink Workbench") or database
schema manager (see Chapter 6, "Using the Schema Manager") to create the necessary
information.
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2.8.3 Primary Keys and Object Identity

When making objects persistent, each object requires an identity to uniquely identify it
for storage and retrieval. Object identity is typically implemented using a unique
primary key. This key is used internally by TopLink to identify each object, and to
create and manage references. Violating object identity can corrupt the object model.

In a Java application, object identity is preserved if each object in memory is
represented by one, and only one, object instance. Multiple retrievals of the same
object return references to the same object instance-not multiple copies of the same
object.

TopLink supports multiple identity maps to maintain object identity (including
composite primary keys). Refer to Section 102.2.1, "Cache Type and Object Identity" for
additional information.

2.8.4 Mappings

TopLink uses the metadata produced by Oracle JDeveloper or TopLink Workbench
(see Section 2.9, "Working with TopLink Metadata") to describe how objects and beans
map to the data source. This approach isolates persistence information from the object
model-you are free to design their ideal object model, and DBAs are free to design
their ideal schema.

You use Oracle JDeveloper or TopLink Workbench to create and manage the mapping
information. At run time, TopLink uses the metadata to seamlessly and dynamically
interact with the data source, as required by the application.

TopLink provides an extensive mapping hierarchy that supports the wide variety of
data types and references that an object model might contain. For more information,
see Chapter 17, "Introduction to Mappings".

2.8.5 Foreign Keys and Object Relationships

A foreign key is a combination of columns that reference a unique key, usually the
primary key, in another table. Foreign keys can be any number of fields (similar to
primary key), all of which are treated as a unit. A foreign key and the primary parent
key it references must have the same number and type of fields.

Foreign keys represents relationships from a column or columns in one table to a
column or columns in another table. For example, if every Employee has an attribute
address that contains an instance of Address (which has its own descriptor and
table), the one-to-one mapping for the address attribute would specify foreign key
information to find an address for a particular Employee.

Refer to Section 28.7, "Configuring Table and Field References (Foreign and
Target Foreign Keys)" for more information.

2.8.6 Inheritance

Object-oriented systems allow classes to be defined in terms of other classes. For
example: motorcycles, sedans, and vans are all kinds of vehicles. Each of the vehicle
types is a subclass of the Vehicle class. Similarly, the Vehicle class is the superclass of
each specific vehicle type. Each subclass inherits attributes and methods from its
superclass (in addition to having its own attributes and methods).

Inheritance provides several application benefits, including the following:
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= Using subclasses to provide specialized behaviors from the basis of common
elements provided by the superclass. By using inheritance, you can reuse the code
in the superclass many times.

= Implementing abstract superclasses that define generic behaviors. This abstract
superclass may define and partially implement behavior, while allowing you to
complete the details with specialized subclasses.

Refer to Section 119.20, "Configuring Inheritance for a Child (Branch or Leaf) Class
Descriptor" and Section 119.23, "Configuring Inherited Attribute Mapping in a
Subclass" for detailed information on using inheritance with TopLink.

2.8.7 Concurrency

To have concurrent clients logged in at the same time, the server must spawn a
dedicated thread of execution for each client. Java EE application servers do this
automatically. Dedicated threads enable each client to work without having to wait for
the completion of other clients. TopLink ensures that these threads do not interfere
with each other when they make changes to the identity map or perform database
transactions.

Using the TopLink UnitOfWork class, your client can make transactional changes in
an isolated and thread safe manner. The unit of work manages clones for the objects
you modify to isolate each client’s work from other concurrent clients and threads. The
unit of work is essentially an object-level transaction mechanism that maintains all of
the ACID (Atomicity, Consistency, Isolation, Durability) transaction principles as a
database transaction. For more information on the unit of work, see Chapter 113,
"Introduction to TopLink Transactions".

TopLink supports configurable optimistic and pessimistic locking strategies to let you
customize the type of locking that the TopLink concurrency manager uses. For more
information, see Section 16.4, "Descriptors and Locking".

2.8.8 Caching

TopLink caching improves application performance by automatically storing data
returned as objects from the database for future use. This caching provides several
advantages:

= Reusing Java objects that have been previously read from the database minimizes
database access

= Minimizing SQL calls to the database when objects already exist in the cache
= Minimizing network access to the database

= Setting caching policies a class-by-class and bean-by-bean basis

= Basing caching options and behavior on Java garbage collection

TopLink supports several caching polices to provide extensive flexibility. You can
fine-tune the cache for maximum performance, based on individual application
performance. Refer to Part XXIII, "Cache" for complete information.

2.8.9 Nonintrusive Persistence

The TopLink nonintrusive approach of achieving persistence through a metadata
architecture (see Section 2.9, "Working with TopLink Metadata") means that there are
almost no object model intrusions.

To persist Java objects, TopLink does not require any of the following:
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= Persistent superclass or implementation of persistent interfaces
»  Store, delete, or load methods required in the object model

= Special persistence methods

= Generating source code into or wrapping the object model

When using entity beans with container-managed persistence, TopLink does not
require any additional intrusion to the object model, other than the CMP specification
requirements.

See Section 2.4, "Building and Using the Persistence Layer" for additional information
on this nonintrusive approach.

2.8.10 Indirection

An indirection object takes the place of an application object so the application object is
not read from the database until it is needed. Using indirection, or lazy loading in JPA,
allows TopLink to create stand-ins for related objects. This results in significant
performance improvements, especially when the application requires the contents of
only the retrieved object rather than all related objects.

Without indirection, each time the application retrieves a persistent object, it also
retrieves all the objects referenced by that object. This may result in lower performance
for some applications.

Note: Oracle strongly recommends that you use indirection in all
situations.

TopLink provides several indirection models, such as proxy indirection, transparent
indirection, and value holder indirection. TopLink also provides indirection support
for EJB (see Section 17.2.4.6, "Indirection and EJB 2.n CMP").

See Section 17.2.4, "Indirection (Lazy Loading)" for more information.

2.8.11 Mutability

Mutability is a property of a complex field that specifies whether or not the field value
may be changed or not changed as opposed to replaced.

An immutable mapping is one in which the mapped object value cannot change unless
the object ID of the object changes: that is, unless the object value is replaced by
another object value altogether.

A mutable mapping is one in which the mapped object value can change without
changing the object ID of the object.

By default, TopLink assumes the following:
s all TransformationMapping instances are mutable;

= all JPA @Basic mapping types, except Serializable types, are immutable
(including Date and Calendar types);

= allJPA @Basic mapping Serializable types are mutable.

Whether a value is immutable or mutable largely depends on how your application
uses your persistent classes. For example, by default, TopLink assumes that a
persistent field of type Date is immutable: this means that as long as the value of the
field has the same object ID, TopLink assumes that the value has not changed. If your
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application uses the set methods of the Date class, you can change the state of the
Date object value without changing its object ID. This prevents TopLink from
detecting the change. To avoid this, you can configure a mapping as mutable: this tells
TopLink to examine the state of the persistent value, not just its object ID.

You can configure the mutability of the following:
s TransformationMapping instances;

» any JPA @Basic mapping type (including Date and Calendar types)
individually;

s allDate and Calendar types.

Mutability can affect change tracking performance. For example, if a transformation
mapping maps a mutable value, TopLink must clone and compare the value in a unit
of work (see Section 119.29, "Configuring Copy Policy"). If the mapping maps a simple
immutable value, you can improve unit of work performance by configuring mapping
as immutable.

Mutability also affects weaving. TopLink can only weave an attribute change tracking
policy for immutable mappings.

For more information, see the following;:
s Section 113.2.3, "Unit of Work and Change Policy"
s Section 2.10, "Using Weaving"

= "How to Use the @Mutable Annotation" of EclipseLink Developer’s Guide at
http://wiki.eclipse.org/Using_EclipselLink JPA_Extensions_
$28ELUG%29#How_to_Use_the_.40Mutable_Annotation

»  Section 121.17, "Configuring Mutable Mappings"

2.9 Working with TopLink Metadata

The TopLink metadata is the bridge between the development of an application and its
deployed run-time environment. Capture the metadata using the following;:

= JPA annotations, persistence.xml, orm.xml, and EclipseLink JPA annotation
and persistence.xml property extensions: the EclipseLink JPA persistence
provider interprets all these sources of metadata to create an in-memory session
and project at run time.

s Oracle JDeveloper TopLink Editor or TopLink Workbench (see Section 2.9.2,
"Creating Project Metadata" and Section 2.9.3, "Creating Session Metadata") to
create TopLink sessions.xml and project.xml files which you pass to the
TopLink run-time environment.

= Java and the TopLink API (this approach is the most labor-intensive).

The metadata lets you pass configuration information into the run-time environment.
The run-time environment uses the information in conjunction with the persistent
classes (Java objects, JPA entities, or EJB entity beans) and the code written with the
TopLink API, to complete the application.

Using EclipseLink JPA, you also have the option of specifying your metadata using
sessions.xml and project .xml while accessing your persistent classes using JPA
and an EntityManager. For more information, see "What You May Need to Know
About EclipseLink JPA Overriding Mechanisms" section of EclipseLink Developer’s
Guide at http://wiki.eclipse.org/Using EclipselLink JPA_Extensions_
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This section describes the following:

= Advantages of the TopLink Metadata Architecture
»  Creating Project Metadata

n  Creating Session Metadata

s Deploying Metadata

2.9.1 Advantages of the TopLink Metadata Architecture

The TopLink metadata architecture provides many important benefits, including the
following:

= Stores mapping information in XML descriptors—not in the domain model objects

» By using the metadata, TopLink does not intrude in the object model or the
database schema

= Allows you to design the object model as needed, without forcing any specific
design

= Allows DBAs to design the database as needed, without forcing any specific
design

= Does not rely on code-generation (which can cause serious design,
implementation, and maintenance issues)

= Is unobtrusive: adapts to the object model and database schema, rather than
requiring you to design their object model or database schema to suit TopLink

Using EclipseLink JPA, you have the flexibility of expressing persistence metadata
using standard JPA annotations, deployment XML, or both and you can optionally
take advantage of EclipseLink JPA annotation and persistence.xml property
extensions.

2.9.2 Creating Project Metadata

A TopLink project contains the mapping metadata that the TopLink runtime uses to
map objects to a data source. The project is the primary object used by the TopLink
runtime.

This section describes the principal contents of project metadata, including the
following:

»  Descriptors and Mappings
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»  Data Source Login Information

Using EclipseLink JPA, the TopLink runtime constructs an in-memory project based on
any combination of JPA annotations, persistence.xml, orm.xml, and EclipseLink
JPA annotation and persistence.xml property extensions. The use of a
project.xml file is optional (see "What You May Need to Know About EclipseLink
JPA Overriding Mechanisms" section of EclipseLink Developer’s Guide at
http://wiki.eclipse.org/Using_EclipselLink JPA_Extensions_
$28ELUG%29#What_You_May_ Need_to_Know_ About_EclipseLink_ JPA_
Overriding_Mechanisms).

For more information about creating project .xml metadata, see Section 9.1.1,
"project.xml File".

2.9.2.1 Descriptors and Mappings

TopLink maps persistent entities to the database in the application, using the
descriptors and mappings you build with Oracle JDeveloper TopLink Editor or
TopLink Workbench. These tools support several approaches to project development,
including the following:

s Importing classes and tables for mapping

= Importing classes and generating tables and mappings
= Importing tables and generating classes and mappings
s Creating both class and table definitions

TopLink Workbench supports all these options. The most common solution is to
develop the persistent entities using a development tool, such as an integrated
development environment (IDE) like Oracle Oracle JDeveloper, or a modeling tool,
and to develop the relational model through appropriate relational design tools. You
then use Oracle JDeveloper TopLink Editor or TopLink Workbench to construct
mappings that relate these two models.

Although Oracle JDeveloper TopLink Editor and TopLink Workbench do offer the
ability to generate persistent entities or the relational model components for an
application, these utilities are intended only to assist in rapid initial development
strategies—not complete round-trip application development.

For more information, see Chapter 16, "Introduction to Descriptors" and Chapter 17,
"Introduction to Mappings".

29.2.1.1 Amending Descriptors An amendment method lets you implement a TopLink
feature that is not currently supported by Oracle JDeveloper TopLink Editor or
TopLink Workbench. Simply write a Java method to amend the descriptor after it is
loaded, and specify the method in Oracle JDeveloper TopLink Editor or TopLink
Workbench for inclusion in the project metadata. See Section 119.35, "Configuring
Amendment Methods" for detailed information on implementing an amendment
method for a TopLink descriptor.

2.9.2.2 Data Source Login Information

For POJO projects, you configure a session login in the session metadata that specifies
the information required to access the data source (see Section 2.9.3, "Creating Session
Metadata").

For CMP projects, the project contains a deployment login that specifies the
information required to access the data source.

For more information, see Section 15.2.4, "Projects and Login".
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2.9.3 Creating Session Metadata

A TopLink session contains a reference to a particular project . xml file, plus the
information required to access the data source. The session is the primary object used
by your application to access the features of the TopLink runtime.

The agent responsible for creating and accessing session metadata differs depending
on whether or not you are creating a CMP project. In a POJO project, your application
acquires and accesses a session directly (see Section 9.1.2.2, "POJO Applications and
Session Metadata"). In a CMP project, your application indirectly accesses a session
acquired internally by the TopLink runtime (see Section 9.1.2.4, "CMP Applications
and Session Metadata").

Using EclipseLink JPA, the TopLink runtime constructs an in-memory session based
on any combination of JPA annotations, persistence.xml, orm.xml, and
EclipseLink JPA annotation and persistence.xml property extensions. The use of a
sessions.xml file is optional (see "What You May Need to Know About EclipseLink
JPA Overriding Mechanisms" section of EclipseLink Developer’s Guide at
http://wiki.eclipse.org/Using_EclipselLink JPA_Extensions_
$28ELUG%29#What_You_May_ Need_to_Know_ About_EclipseLink_ JPA_
Overriding_Mechanisms).

2.9.4 Deploying Metadata

The project.xml and sessions.xml file are packaged for deployment differently
according to the type of application you are deploying.

For more information, see the following;:
s Chapter 9, "Creating TopLink Files for Deployment"
s Chapter 10, "Packaging a TopLink Application"

Using EclipseLink JPA, you also have the option of specifying your metadata using
sessions.xml and project.xml while accessing your persistent classes using JPA
and an EntityManager. For more information, see "What You May Need to Know
About EclipseLink JPA Overriding Mechanisms" section of EclipseLink Developer’s
Guide athttp://wiki.eclipse.org/Using_EclipseLink JPA_Extensions_
$28ELUG%29#What_You_May_ Need_to_Know_ About_EclipseLink_ JPA_
Overriding Mechanisms.

2.10 Using Weaving

Weaving is a technique of manipulating the byte-code of compiled Java classes.
Weaving is used to enhance both JPA entities and Plain Old Java Object (POJO) classes
for such things as lazy loading, change tracking, fetch groups, and internal
optimizations.

This section describes the following:

s Configuring Dynamic Weaving Using EclipseLink Agent

s Configuring Static Weaving

»  Disabling Weaving Using TopLink Persistence Unit Properties

s Packaging a POJO Application for Weaving

s What You May Need to Know About Weaving and POJO Classes

s What You May Need to Know About Weaving and Java EE Application Servers
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2.10.1 Configuring Dynamic Weaving Using EclipseLink Agent

When using EclipseLink JPA outside of an EJB 3.0 container, consider dynamic
weaving. For more information, see "How to Configure Dynamic Weaving for JPA
Entities Using EclipseLink Agent" section of EclipseLink Developer’s Guide at
http://wiki.eclipse.org/Using_EclipselLink JPA_Extensions_
$28ELUG%29#How_to_Configure_Dynamic_Weaving_ for_ JPA_FEntities_
Using_the_EclipseLink_Agent

2.10.1.1 To Configure Dynamic Weaving Using EclipseLink Agent

For information, see the following:

= "How to Configure Dynamic Weaving for JPA Entities Using EclipseLink Agent"
section of EclipseLink Developer’s Guide at http://wiki.eclipse.org/Using_

EclipselLink_JPA_Extensions_%28ELUG%29#How_to_Configure_
Dynamic_Weaving_ for JPA_Entities_Using the_EclipseLink_ Agent

»  Section 2.10.4, "Packaging a POJO Application for Weaving"

2.10.2 Configuring Static Weaving

Consider this option to weave all applicable class files at build time so that you can
deliver prewoven class files. For more information, see "How to Configure Static
Weaving for JPA Entities" section of EclipseLink Developer’s Guide at
http://wiki.eclipse.org/Using_EclipselLink JPA_Extensions_
$28ELUG%29#How_to_Configure_Static_Weaving for_ JPA_Entities.

Note that for weaving, you use a persistence.xml file in both JPA and POJO
applications.

For information on packaging and deployment of POJO applications, see
Section 2.10.4, "Packaging a POJO Application for Weaving'".

2.10.3 Disabling Weaving Using TopLink Persistence Unit Properties

To disable weaving, you use persistence unit properties in both JPA and POJO
applications. For more information, see "How to Disable Weaving Using EclipseLink
Persistence Unit Properties" section of EclipseLink Developer’s Guide at
http://wiki.eclipse.org/Using_EclipselLink JPA_Extensions_
$28ELUG%29#How_to_Disable_Weaving Using EclipseLink_Persistence_
Unit_Properties.

For information on packaging and deployment of POJO application, see Section 2.10.4,
"Packaging a POJO Application for Weaving".

2.10.4 Packaging a POJO Application for Weaving

To package a POJO application for weaving, you create a JAR that contains a
sessions.xml file and a persistence.xml file.

2.10.4.1 To Package a POJO Application for Weaving

1. Create a sessions.xmnl file for your application.
For more information, Chapter 87, "Introduction to TopLink Sessions".

2. Create a persistence.xml file for your application and reference your
sessions.xml file, as Example 2-1 shows.
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Example 2—1 persistence.xml File for a EclipseLink JPA Application
<persistence>
<persistence-unit name="appname">
<exclude-unlisted-classes>false</exclude-unlisted-classes>
<properties>
<property
name="eclipselilnk.session-name"
value="appname-session"
>
<property
name="eclipselink.sessions-xml"
value="sessions.xml"
>
</properties>
</persistence-unit>
</persistence>
3. Create a JAR file that contains your POJO classes, sessions.xml file, and
persistence.xml file, as Example 2-2 shows.

Put both the persistence.xml and sessions.xml file in a META- INF
directory.

Example 2-2 JAR File for a POJO Application

appname . jar
META-INF
persistence.xml
sessions.xml
* . java

4. Weave the JAR.
For more information, see the following:
»  Section 2.10.1, "Configuring Dynamic Weaving Using EclipseLink Agent"
»  Section 2.10.2, "Configuring Static Weaving"

2.10.5 What You May Need to Know About Weaving and POJO Classes

TopLink uses weaving to enable the following for POJO classes:

» lazy loading (indirection): see Section 121.3, "Configuring Indirection (Lazy
Loading)"

»  change tracking: see Section 119.30, "Configuring Change Policy"
» fetch groups: see Section 119.33, "Configuring Fetch Groups"
= internal optimizations.

TopLink weaves all the POJO classes in the JAR you create when you package a POJO
application for weaving. For more information, see Section 2.10.4, "Packaging a POJO
Application for Weaving'".

TopLink weaves all the classes defined in the persistence.xml file. That is the
following:

= all the classes you list in the persistence.xml file;

= all classes relative to the JAR containing the persistence.xml file if element
<exclude-unlisted-classes>is false.
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2.10.6 What You May Need to Know About Weaving and Java EE Application Servers

The default TopLink weaving behavior applies in any Java EE JPA-compliant
application server using the EclipseLink JPA persistence provider.

To change this behavior, modify your persistence.xml (for your JPA entities or
POJO classes) to use EclipseLink JPA properties, EclipseLink JPA annotations, or both.

For lazy loading (indirection) differences between Java EE and Java SE applications,
see "EclipseLink JPA Support for Lazy Loading by Mapping Type" table of EclipseLink
Developer’s Guide at http: //wiki.eclipse.org/Using EclipseLink JPA_
Extensions_%28ELUG%29#Table_19-33

2.11 Considering Three-Tier Architecture

The three-tier Web application architecture generally includes the connection of a
server-side Java application to the database through a JDBC connection (see

Figure 2-3). In this pattern, TopLink resides within a Java server (a Java EE server or a
custom server), with several possible server integration points. The application can
support Web clients such as servlets, Java clients, and generic clients using XML or
Common Object Request Broker Architecture (CORBA).

The three-tier application is a common architecture in which TopLink resides within a
Java server (either a Java EE server or a custom server). In this architecture, the server
session provides clients with shared access to JDBC connections and a shared object
cache. Because it resides on a single JVM, this architecture is simple and easily
scalable. The TopLink persistent entities in this architecture are generally Java objects.

This architecture often supports Web-based applications in which the client
application is a Web client, a Java client, or a server component.

Figure 2-3 Three Tier Architecture
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Although not all three-tier applications are Web-based, this architecture is ideally
suited to distributed Web applications. In addition, although it is also common to use
EJB in a Web application, this TopLink architecture does not.

2.11.1 Example Implementations

Examples of three-tier architecture implementation include the following:

= A Model-View-Controller Model 2 architectural design pattern that runs in a Java
EE container with servlets and JSP that uses TopLink to access data without EJB.

= A Swing or Abstract Window Toolkit (AWT) client that connects to a server-side
Java application through RMI, without an application server or container.
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2.11.2 Advantages and Disadvantages

The three-tier Web application architecture offers the following advantages:

High performance, lightweight persistent objects
High degree of flexibility in deployment platform and configuration

The disadvantage of this architecture is it is less standard than EJB.

2.11.3 Variation Using Remote Sessions

TopLink includes a session type called remote session. The session offers the full
session API and contains a cache of its own, but exists on the client system rather than
on the TopLink server. Communications can be configured to use RMI or RMI-Internet
Inter-Object Request Broker Protocol (IIOP).

Remote session operations require a corresponding client session on the server.

Although this is an excellent option for you if you wish to simplify the access from the
client tier to the server tier, it is less scalable than using a client session and does not
easily allow changes to server-side behavior.

For more information, see Section 87.9, "Remote Sessions".

2.11.4 Technical Challenges

The three-tier application with a stateless client presents several technical challenges,
including the following:

Transaction management in a stateless environment

A common design practice is to delimit client requests within a single unit of work
(transactional session). In a stateless environment, this may affect how you design
the presentation layer. For example, if a client requires multiple pages to collect
information for a transaction, then the presentation layer must retain the
information from page to page until the application accumulates the full set of
changes or requests. At that point, the presentation layer invokes the unit of work
to modify the database.

Optimistic locking in a stateless environment

In a stateless environment, take care to avoid processing out-of-date (stale) data. A
common strategy for avoiding stale data is to implement optimistic locking, and
store the optimistic lock values in the object.

This solution requires careful implementation if the stateless application serializes
the objects, or sends the contents of the object to the client in an alternative format.
In this case, transport the optimistic lock values to the client in the HTTP contents

of an edit page. You must then use the returned values in any write transaction to

ensure that the data did not change while the client was performing its work.

For more information about locking, see Section 119.26, "Configuring Locking
Policy".

External JDBC pools

By default, TopLink manages its own connection pools. You can also configure
TopLink to use connection pooling offered by the host application server. This
feature is useful for shared connection pools and is required for JTA/JTS
integration (see Section 97.4, "Configuring External Connection Pooling").

JTA/JTS Integration
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JTA and JTS are standard Java components that enable sessions to participate in
distributed transactions. You must configure TopLink to use JTA/JTS to use
session beans in the architecture (see Section 115.13, "Integrating the Unit of Work
with an External Transaction Service").

s Cache coordination

If you choose to use multiple servers to scale your application, you may require
TopLink cache coordination (see Chapter 102, "Introduction to Cache").

2.12 Considering Two-Tier Architecture

A two-tier application generally includes a Java client that connects directly to the
database through TopLink. The two-tier architecture is most common in complex user
interfaces with limited deployment. The database session provides TopLink support
for two-tier applications.

For more information, see Chapter 87, "Introduction to TopLink Sessions".

Figure 2-4 Two-Tier Architecture
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Although the two-tier architecture is the simplest TopLink application pattern, it is
also the most restrictive, because each client application requires its own session. As a
result, two-tier applications do not scale as easily as other architectures.

Two-tier applications are often implemented as user interfaces that directly access the
database (see Figure 2—-4). They can also be non-interface processing engines. In either
case, the two-tier model is not as common as the three-tier model.

The following are key elements of an efficient two-tier (client-server) architecture with
TopLink:

s Minimal dedicated connections from the client to the database

= Anisolated object cache

2.12.1 Example Implementations

An example of a two-tier architecture implementation is a Java user interface
(Swing/AWT) and batch data processing.

2.12.2 Advantages and Disadvantages

The advantage of the two-tier design is its simplicity. The TopLink database session
that builds the two-tier architecture provides all the TopLink features in a single
session type, thereby making the two-tier architecture simple to build and use.

The most important limitation of the two-tier architecture is that it is not scalable,
because each client requires its own database session.
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2.12.3 Technical Challenges

The current trend toward multitiered Web applications makes the two-tier architecture
less common in production systems, but no less viable. Because there is no shared
cache in a two-tier system, you risk encountering stale data if you run multiple
instances of the application. This risk increases as the number of individual database
sessions increases.

To minimize this problem, TopLink offers support for several data locking strategies.
These include pessimistic locking and several variations of optimistic locking. For
more information, see Section 119.26, "Configuring Locking Policy".

2.13 Considering EJB Session Bean Facade Architecture

This architecture is an extension of the three-tier pattern, with the addition of EJB
session beans wrapping the access to the application tier. Session beans provide public
API access to application operations, enabling you to separate the presentation tier
from the application tier. The architecture also lets you use session beans within a Java
EE container.

This type of architecture generally includes JTA integration, and serialization of data to
the client.

Figure 2-5 Three-Tier Architecture Using Session Beans and Java Objects
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A common extension to the three-tier architecture is to combine session beans and
persistent Java objects managed by TopLink. The resulting application includes session
beans and Java objects on a TopLink three-tier architecture (see Figure 2-5).

The three-tier architecture creates a server session and shares it between the session
beans in the application. When a session bean needs to access a TopLink session, the
bean obtains a client session from the shared server session. This architecture has the
following key features:

»  Session beans delimit transactions.
Configure TopLink to work with a JTA system and its associated connection pool.
= Accessing the persistent objects on the client side causes them to be serialized.

Ensure that when the objects re-emerge on the server-side, they properly merge
into the cache to maintain identity.

2.13.1 Example Implementation

An example of the EJB session bean facade architecture implementation is a
Model-View-Controller Model 2 architectural design pattern that runs in a Java EE
container with servlets and JSP and uses the session bean enabled by TopLink to access
data without EJB.
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2.13.2 Advantages and Disadvantages

The E]B session bean facade architecture is a popular and effective compromise
between the performance of persistent Java objects, and the benefits of E]B for
standardized client development and server scalability. It offers the following
advantages:

s Less overhead than an EJB CMP application

TopLink shares access to the project, descriptor, and login information across the
beans in the application.

= Future compatibility with other servers

This design isolates login and E]B server-specific information from the beans,
which lets you migrate the application from one application server to another
without major recoding or rebuilding.

s Shared read cache

This design offers increased efficiency by providing a shared cache for reading
objects.

The key disadvantage of this model is the need to transport the persistent model to the
client. If the model involves complex object graphs in conjunction with indirection
(lazy loading), this can present many challenges with inheritance, indirection, and
relationships.

For more information about managing inheritance, indirection and relationships, see
Part VIII, "Mappings".

2.13.3 What Are Session Beans

Session beans model a process, operation, or service and as such, are not persistent
entities. However, session beans can use persistence mechanisms to perform the
services they model.

Under the session bean model, a client application invokes methods on a session bean
that, in turn, performs operations on Java objects enabled by TopLink. Session beans
execute all operations related to TopLink on behalf of the client.

The EJB specifications describe session beans as either stateless or stateful.

Stateful beans maintain a conversational state with a client; that is, they retain
information between method calls issued by a particular client. This enables the client
to use multiple method calls to manipulate persistent objects.

Stateless beans do not retain data between method calls. When the client interacts
with stateless session beans, it must complete any object manipulations within a single
method call.

2.13.4 Technical Challenges

Your application can use both stateful and stateless session beans with a TopLink client
session or database session. When you use session beans with a TopLink session, the
type of bean used affects how it interacts with the session.

m  Stateless session beans and the TopLink session

Stateless beans store no information between method calls from the client. As a
result, reestablish the connection of the bean to the session for each client method
call. Each method call through TopLink obtains a client session, makes the
appropriate calls, and releases the reference to the client session.
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»  Stateful session beans and the TopLink session

Your EJB server configuration includes settings that affect the way it manages
beans-settings designed to increase performance, limit memory footprint, or set a
maximum number of beans. When you use stateful beans, the server may
deactivate a stateful session bean enabled by TopLink out of the JVM memory
space between calls to satisfy one of these settings. The server then reactivates the
bean when required, and brings it back into memory.

This behavior is important, because a TopLink session instance does not survive
passivation. To maintain the session between method calls, release the session
during the passivation process and re-obtain it when you reactivate the bean.

= External JDBC pools

By default, TopLink manages its own connection pools. For the session bean
architecture, you must configure TopLink to use connection pooling offered by the
host application server. This feature is useful for shared connection pools and is
required for JTA/JTS integration (see Section 97.4, "Configuring External
Connection Pooling").

s JTA/JTS integration

JTA and JTS are standard Java components that enable sessions to participate in
distributed transactions. You must configure TopLink to use JTA/JTS to use
session beans in the architecture (see Section 115.13, "Integrating the Unit of Work
with an External Transaction Service").

s Cache coordination

If you choose to use multiple servers to scale your application, you may require
TopLink cache coordination (see Section 102.3, "Cache Coordination").

2.13.5 What Is a Unit of Work Merge

You can use a unit of work to enable your client application to modify objects on the
database. The unit of work merge functions employ mappings to copy the values from
the serialized object into the unit of work, and to calculate changes.

For more information, see Section 115.5, "Merging Changes in Working Copy Clones".

2.14 Considering EJB Entity Beans with CMP Architecture

CMP is the part of the Java EE component model that provides an object persistence
service that an EJB container uses to persist entity beans. CMP provides distributed,
transactional, secure access to persistent data, with a guaranteed portable interface.

This architecture is an extension of the three-tier architecture, in which the
implementation of persistence methods is handled by the container at runtime. As a
bean provider, you only need to specify in a deployment descriptor those persistent
fields and relationships for which the container must handle data access and,
optionally, an abstract representation of the database schema.

TopLink CMP is an extension of the TopLink persistence framework that provides
custom integration to EJB containers of various application servers (see Section 8.1,
"Introduction to the Application Server Support"). For more information about
choosing an application server, see Section 2.2.2, "Target Platforms". TopLink integrates
with the EJB container in this architecture to augment the container’s persistence
manager.
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TopLink CMP integration is nonintrusive (see Figure 2-6). Through a combination of
run-time integration and code generation, the container uses TopLink internally and
the bean user interacts with entity beans with container-managed persistence
according to their standard API. This lets you combine the standard interfaces and
power of CMP and a container with TopLink flexibility, performance, and
productivity.

Figure 2-6 Three-Tier CMP Architecture
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For more information, see the following;:

s Chapter 8, "Integrating TopLink with an Application Server"
s Chapter 9, "Creating TopLink Files for Deployment"

s Chapter 10, "Packaging a TopLink Application"

s Chapter 11, "Deploying a TopLink Application"

»  Section 117.5, "Configuring Persistence Type"

2.14.1 Example Implementation

An example of the entity beans with container-managed persistence implementation is
a Model-View-Controller Model 2 architectural design pattern that runs in a Java EE
container, with servlets and JSP that access either session beans or entity beans with
container-managed persistence enhanced by TopLink.

2.14.2 Advantages and Disadvantages

A three-tier architecture using entity beans with container-managed persistence offers
the following advantages:

= It allows for entity beans with container-managed persistence supplied with
sophisticated TopLink features such as caching and mapping support, storing
bean data across more than one table, composite primary keys, and data
conversion.

s It presents a standard method to access data, which lets you create standardized,
reusable business objects.

s Itis well-suited to create coarse-grained objects, which TopLink relates to
dependent, lightweight, regular Java objects (TopLink can also manage
container-managed relationships to lightweight dependent Java objects).

»  TopLink provides for lazy initialization of referenced objects and beans (see
Section 17.2.4, "Indirection (Lazy Loading)").

s TopLink provides functionality for transactional copies of beans, allowing
concurrent access by several clients, rather than relying on individual serialization.
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s TopLink provides advanced query capabilities, as well as dynamic querying,
including the ability to define queries at the bean-level rather than the data source
level and to use a rich set of querying and finder options.

s TopLink maintains bean and object identity.

The disadvantage of this architecture is that pure entity bean with container-managed
persistence architectures can impose a high overhead cost. This is especially true when
a data model has a large number of fine-grained classes with complex relationships.

2.14.3 Technical Challenges

The key technical challenge in this architecture lies in integrating components into a
cohesive system. For example, this architecture requires a specific TopLink integration
with the application server or Java EE container.

Other issues include the following:

s External JDBC Pools

s JTA/JTS Integration

s Cache Coordination

»  Maintaining Bidirectional Relationships

s Managing Dependent Objects

= Managing Collections of EJBObject Objects

2.14.3.1 External JDBC Pools

By default, TopLink manages its own connection pools. You can also configure
TopLink to use connection pooling offered by the host application server. This feature
is useful for shared connection pools and is required for JTA /JTS integration (see
Section 97 .4, "Configuring External Connection Pooling").

2.14.3.2 JTANJTS Integration

JTA and JTS are standard Java components that enable sessions to participate in
distributed transactions. You must configure TopLink to use JTA/JTS to use session
beans in the architecture (see Section 115.13, "Integrating the Unit of Work with an
External Transaction Service").

2.14.3.3 Cache Coordination

If you choose to use multiple servers to scale your application, you may require
TopLink cache coordination (see Section 102.3, "Cache Coordination").

2.14.3.4 Maintaining Bidirectional Relationships

When one-to-one or many-to-many relationship is bidirectional, you must maintain
the back pointers as the relationships change.

TopLink automatically maintains the relationship between two entity beans.
To set the back pointer manually, do one of the following:

= Code the entity bean to maintain the back pointer when the relationship is
established or modified (recommended).

»  Code the client to explicitly set the back pointer.
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If you code the entity bean to set back pointers, the client is freed of this responsibility.
This has the advantage of encapsulating this maintenance implementation in the bean.

In a one-to-many relationship, a source bean might have several dependent target
objects. For example, an EmployeeBean might own several dependent PhoneNumber
instances. When you add a new dependent object (a PhoneNumber, in this example)
to an employee, you must set the PhoneNumber instance’s back pointer to its owner
(the employee). Maintaining a one-to-many relationship in the entity bean involves
getting the local object reference from the context of the EmployeeBean, and then
updating the back pointer, as Example 2-3 shows.

Example 2-3 Setting the Back-Pointer in the Entity Bean

// obtain owner and phoneNumber

owner = empHome.findByPrimaryKey (ownerId) ;

phoneNumber = new PhoneNumber ("cell", "613", "5551212");
// add phoneNumber to the phoneNumbers of the owner
owner .addPhoneNumber (phoneNumber) ;

// Maintain the relationship in the Employee's addPhoneNumber method
public void addPhoneNumber (PhoneNumber newPhoneNumber) {
// get, then set the back pointer to the owner
Employee owner = (Employee)this.getEntityContext ().getEJBLocalObject();
newPhoneNumber . setOwner (owner) ;
// add new phone
getPhoneNumbers () .add (newPhoneNumber) ;

}
For more information, see the following:

= Section 121.18, "Configuring Bidirectional Relationship"
»  Section 27.2.1, "Directionality"

2.14.3.5 Managing Dependent Objects

Unlike EJB, TopLink dependent persistent objects can be sent back and forth between a
client and a server. When objects are serialized, the risk exists the objects can cause the
cache to lose the identity of the objects or attempt to cache duplicate identical objects.
To avoid potential problems, use the bean setter methods when adding dependent
objects to relationship collections, as Example 2—4 shows. This enables TopLink to
handle merging of objects in the cache.

Example 2-4 Managing Dependent Objects

addPhoneNumber (PhoneNumber phone) {
Collection phones = this.getPhoneNumbers () ;
Vector newCollection = new Vector();
newCollection.addAll (phones) ;
newCollection.add (phone) ;
this.setPhones (newCollection) ;

2.14.3.6 Managing Collections of EJBObject Objects

Collections generally use the equals method to compare objects. This is not a
problem in the case of an object that contains a collection of EJBObject objects,
because the EJB container collection handles equality appropriately.

2-36 Developer's Guide for Oracle TopLink



Considering EJB Entity Beans with BMP Architecture

2.15 Considering EJB Entity Beans with BMP Architecture

BMP is the part of the Java EE component model that lets you, the bean provider,
implement the entity bean’s persistence directly in the entity bean class or in one or
more helper classes that you provide.

This architecture is an extension of the three-tier architecture, in which the persistent
data is bean managed within an entity bean using code that you implement. The client
code accesses the data through the entity bean interface.

TopLink BMP is an extension of the TopLink persistence framework that provides base
class BMPEntityBase as a starting point for your BMP development. This class
provides an implementation for all methods (except ejbPassivate) required by the
EJB specifications prior to 3.0. Subclass BMPEntityBase to create a TopLink-enabled
entity bean with bean-managed persistence.

To use the BMPEntityBase class, perform the following;:

1. Create a TopLink session (see Chapter 87, "Introduction to TopLink Sessions") for
your application.

2. Add aBMPWrapperPolicy to each descriptor that represents an entity bean with
bean-managed persistence.

The BMPWrapperPolicy provides TopLink with the information to create remote
objects for entity beans and to extract the data out of a remote object.

3. Create the home and remote interfaces.

4. Create deployment descriptors (see Chapter 8, "Integrating TopLink with an
Application Server" and Chapter 9, "Creating TopLink Files for Deployment").

5. Package your application (see Chapter 10, "Packaging a TopLink Application").
6. Deploy the beans (see Chapter 11, "Deploying a TopLink Application").

To make full use of TopLink session and unit of work features, TopLink provides a
hook into its functionality through the BMPDataStore class. Use this class to translate
EJB-required functionality into simple calls.

The BMPDataStore class provides implementations of LOAD and STORE, multiple
finders, and REMOVE functionality. The BMPDataStore class requires a TopLink
session. A single instance of BMPDataStore must exist for each bean type deployed
within a session. When creating a BMPDataStore, pass in the session name of the
session that the BMPDataStore must use to persist the beans and the class of the bean
type being persisted. Store the BMPDataStore in a global location so that each
instance of a bean type uses the correct store method.

TopLink BMP support (see Figure 2-7) lets you combine the standard interfaces of
entity beans with bean-managed persistence with TopLink flexibility, performance,
and productivity.

Introduction to TopLink Application Development 2-37



Considering EJB Entity Beans with BMP Architecture

Figure 2-7 Three-Tier BMP Architecture
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TopLink supports BMP. To use BMP support, the home interface must inherit from the
oracle.toplink.ejb.EJB20Home. To make calls to the BMPEntityBase, the
findal1l method must call the EJB 2.0 version of the methods. These methods are
prefixed with ejb20. For example, in the EJB 2.0 version, the £indA11 method
appears as ejb20FindAll.

To use local beans, use the oracle. toplink.ejb.EJB20LocalHome setting instead
of the default oracle.toplink.ejb.EJB20Home. Instead of the
oracle.toplink.ejb.BMPWrapperPolicy setting, use the
oracle.toplink.ejb.bmp.BMPLocalWrapperPolicy setting.

To accommodate both local and remote configurations, ensure the following;:

= For a bean that has a single interface, use the corresponding wrapper policy (local
or remote) for the descriptor.

= Beans can only participate in relationships as either local or remote interfaces, not
both.

For more information, see the following:

»  Chapter 8, "Integrating TopLink with an Application Server"
»  Chapter 9, "Creating TopLink Files for Deployment"

»  Chapter 10, "Packaging a TopLink Application"

»  Chapter 11, "Deploying a TopLink Application"

m  Section 117.5, "Configuring Persistence Type"

= Section 89.9, "Configuring the Server Platform"

2.15.1 Example Implementations

An example of the entity beans with bean-managed persistence implementation is a
Model-View-Controller Model 2 architectural design pattern that runs in a Java EE
container, with servlets and JSP that access session beans and entity beans with
bean-managed persistence enhanced by TopLink.

2.15.2 Advantages and Disadvantages
Using BMP with a TopLink three-tier architecture offers the following advantages:

s It simplifies the BMP method calls. These can be inherited from an abstract bean
class, rather than being generated.

s TopLink makes BMP easier to implement.

= It enables you to implement database-independent code in the bean methods.
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s The architecture supports features such as complex relationships, caching,
object-level and dynamic queries, and the unit of work.

The main disadvantages of BMP include the following:
= You must create the persistence mechanisms in the bean code.
= Itisnot as transparent or efficient as CMP.

= TopLink-only Java object applications offer the same degree of independence from
the application server.

2.15.3 Technical Challenges

The key technical challenge in this architecture lies in integrating components into a
cohesive system. For example, this architecture requires a specific TopLink integration
with the application server or Java EE container.

Other issues include the following:
s External JDBC Pools
s JTA/JTS Integration

s Cache Coordination

2.15.3.1 External JDBC Pools

By default, TopLink manages its own connection pools. You can also configure
TopLink to use connection pooling offered by the host application server. This feature
is useful for shared connection pools and is required for JTA /JTS integration (see
Section 97 .4, "Configuring External Connection Pooling").

2.15.3.2 JTANTS Integration

JTA and JTS are standard Java components that enable sessions to participate in
distributed transactions. You must configure TopLink to use JTA/JTS to use session
beans in the architecture (see Section 115.13, "Integrating the Unit of Work with an
External Transaction Service").

2.15.3.3 Cache Coordination

If you choose to use multiple servers to scale your application, you may require
TopLink cache coordination (see Section 102.3, "Cache Coordination").

2.16 Considering JPA Entity Architecture

A part of the E]B 3.0 specification, the Java Persistence API (JPA) is a lightweight,
POJO-based framework for Java persistence. JPA focuses on object relational mapping
and contains a full object relational mapping specification supporting the use of Java
language metadata annotations and /or XML descriptors to define the mapping
between Java objects and a relational database. Object relational mapping with the JPA
is completely metadata-driven. JPA supports a SQL-like query language for both static
and dynamic queries. It also supports the use of pluggable persistence providers.

JPA includes the following concepts:

= Entity—any application-defined object with the following characteristics can be an
entity:

— it can be made persistent;
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- it has a persistent identity (a key that uniquely identifies an entity instance
and distinguishes it from other instances of the same entity type. An entity has
a persistent identity when there is a representation of it in a data store);

- itis partially transactional in a sense that a persistence view of an entity is
transactional (an entity is created, updated and deleted within a transaction,
and a transaction is required for the changes to be committed in the database).
However, in-memory entities can be changed without the changes being
persisted.

- itis not a primitive, a primitive wrapper, or built-in object. An entity is a
fine-graned object that has a set of aggregated state that is typically stored in a
single place (such as a row in a table), and have relationships to other entities.

= Entity metadata—describes every entity. Metadata could be expressed as
annotations (specifically defined types that may be attached to or place in front of
Java programming elements) or XML (descriptors).

= Entity manager—enables API calls to perform operations on an entity. Until an
entity manager is used to create, read, or write an entity, the entity is just a regular
nonpersistent Java object. When an entity manager obtains a reference to an entity,
that entity becomes managed by the entity manager. The set of managed entity
instances within an entity manager at any given time is called its persistence
context-only one Java instance with the same persistent identity may exist in a
persistence context at any time.

You can configure an entity manager to be able to persist or manage certain types
of objects, read or write to a particular database, and be implemented by a specific
persistence provider. The persistence provider supplies the backing
implementation engine for JPA, including the EntityManager interface
implementation, the Query implementation, and the SQL generation.

Entity managers are provided by an EntityManagerFactory. The configuration
for an entity manager is bound to the EntityManagerFactory, but it is defined
separately as a persistence unit. You name persistence units to allow
differentiation between Ent ityManagerFactory objects. This way your
application obtains control over which configuration to use for operations on a
specific entity. The configuration that describes the persistence unit is defined in a
persistence.xml file.

The following description expresses relationships between JPA concepts:

— Persistence creates one or more EntityManagerFactory objects;

each EntityManagerFactory is configured by one persistence unit;
- EntityManagerFactory creates one or more EntityManager objects;
— one or more EntityManager manages one PersistenceContext.
TopLink implementation of JPA is provided by EclipseLink.
For more information, see the following;:

»  JPA sections of EclipseLink Developer’s Guide at
http://wiki.eclipse.org/EclipselLink/UserGuide/Developing JPA_
Projects_%28ELUG%29

»  EclipseLink API at
http://www.eclipse.org/eclipselink/api/1.0/index.html
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2.16.1 Example Implementations

An example of the entity beans with bean-managed persistence implementation is a
Model-View-Controller Model 2 architectural design pattern that runs in a Java EE
container, with servlets and JSP that access session beans and E]JB 3.0-compliant
entities using the EclipseLink JPA persistence provider.

2.16.2 Advantages and Disadvantages
The use of EclipseLink JPA entities offers the following advantages:

»  POJO persistence—in JPA, persistent objects are POJOs.
= Object relational mapping is completely metadata-driven.

s The persistence API exists as a separate layer from the persistent objects and does
not intrude upon them.

s Using the query framework you can query across entities and their relationships
without having to use concrete foreign keys or database columns. Also, you can
define queries statically in metadata or create them dynamically by passing query
criteria on construction. Queries can return entities as results.

= Entities are mobile: objects are able to move from one JVM to another and back,
and at the same time be usable by the application.

= You can configure persistence features through the use of Java SE 5 annotations, or
XML, or a combination of both. You may also rely on defaults.

s If your application is running inside a container, the container provides support
and ease of use; you can configure the same application to run outside a container.

2.17 Considering Web Services Architecture

A Web services architecture is similar to the three-tier (see Section 2.11, "Considering
Three-Tier Architecture") or session bean (see Section 2.13, "Considering EJB Session
Bean Facade Architecture") architecture, however, in a Web services architecture, you
encapsulate business logic (the service) in a Web service instead of (or in addition to)
using session beans. In a Web services architecture, clients communicate with your
application using SOAP messages (XML over HTTP).

Figure 2-8 Web Services Architecture
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As in any architecture, you can use TopLink to persist objects to relational or EIS data
sources. However, in a Web services architecture, you can also use TopLink to map
your object model to an XML schema for use with the Web service or as the Web
service XML serializer.

Introduction to TopLink Application Development 2-41



Considering EclipseLink Service Data Objects (SDO) Architecture

2.17.1 Example Implementations

An example of a Web services architecture implementation is the use of a Web service
to expose parts of an existing application to a remote client (typically another
application) by way of SOAP messages. In this application, you can use TopLink XML
to unmarshall XML messages to Java objects to facilitate requests and marshall Java
object responses back into XML for transmission to the client.

2.17.2 Advantages and Disadvantages

Using TopLink in Web services architecture has many advantages, including, but not
limited to, the following:

= you can map XML messages to an existing Java object model;

= you can achieve a high level of complexity of mapping support;
= compliance with the JAXB standards;

= providing a scalable, high-performing solution.

One debatable disadvantage is this solution’s complexity over a simple RMI session
bean service.

2.17.3 Technical Challenges

As with any technology, there are technical challenges associated with the use of
TopLink in Web services architecture. These technical challenges are mostly related to
special-case scenarios, such as when you need to implement a custom serializer
because you have both the Java objects and the schema.

For more information, see the following:

»  Oracle TopLink as a Custom Serializer in a JAX-RPC 1.1 Web service at
http://www.oracle.com/technology/products/ias/toplink/technic
al/tips/jaxRpcll/index.htm

s Part XVI, "XML Mappings"

2.18 Considering EclipseLink Service Data Objects (SDO) Architecture

An EclipseLink SDO architecture uses the SDO 2.1 framework for data application and
development. For more information, see "Considering EclipseLink Service Data
Objects (SDO) Architecture" section of EclipseLink Developer’s Guide at
http://wiki.eclipse.org/Introduction_to_EclipseLink_Application_
Development_%28ELUG%29#Considering EclipselLink_Service_Data_
Objects_.28SD0.29_Architecture.
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TopLink Development Tools Overview

This part describes the development tools and tool support TopLink provides. It
contains the following chapters:

s Chapter 3, "Introduction to TopLink Development Tools"

This chapter describes the development tools and tool support TopLink provides.
»  Chapter 4, "Using Oracle JDeveloper TopLink Editor"

This chapter describes how to use Oracle JDeveloper TopLink editor.
»  Chapter 5, "Using TopLink Workbench"

This chapter describes how to use TopLink Workbench including working with
databases, generating data from database tables, and creating and editing a
sessions.xml file.

»  Chapter 6, "Using the Schema Manager"

This chapter explains how to use the TopLink schema manager to create databases,
tables, stored procedures, and to populate database tables.

»  Chapter 7, "Using an Integrated Development Environment"

This chapter explains how to integrate TopLink with an IDE.
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Introduction to TopLink Development Tools

The TopLink runtime provides Java or Java EE applications with access to persistent
entities stored in a data source. In addition to run-time capabilities, the TopLink
Foundation Library includes the TopLink Application Programming Interface (API).
This API enables applications to access TopLink run-time features.

TopLink includes additional development tools that simplify application
development. These tools capture mapping and run-time configuration information in
metadata files that TopLink passes to the application at run time.

This chapter includes the following sections:
s Development Environment
s TopLink Run-Time Environment

TopLink metadata is the link between the two (see Section 2.9, "Working with TopLink
Metadata").

Figure 3-1 illustrates how these elements interact with the data source.

Figure 3—-1 TopLink Components in Development Lifecycle
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Development Environment

3.1 Development Environment

To create a TopLink application, use Oracle JDeveloper TopLink Editor or TopLink
Workbench to map objects to data sources using relational and nonrelational models.
Capture the resulting mappings and additional run-time configurations in the TopLink
project file (project . xml) and build a session configuration file (sessions.xml).
These files together represent your entire TopLink project, as shown in Figure 3-2.

During development, you can use the TopLink API to define query and transaction
logic. When you use entity beans, there is generally little or no direct use of the
TopLink API and there is no session or sessions.xml file.

Figure 3-2 TopLink Workbench in Development Environment
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TopLink Workbench can import compiled entity classes (Java objects or EJB entity
beans), as well as relational or nonrelational schemas through a JDBC driver
(configured by you). Because TopLink imports the object and relational models for
mapping, you can develop the two models relatively independently from the mapping
phase of a project development.

3.2 TopLink Run-Time Environment

The TopLink Foundation Library provides the TopLink run-time component. Access
the run-time component either directly through the TopLink API or indirectly through
a Java EE container when using entity beans with container-managed persistence. The
run-time environment is not a separate or external process—it is embedded within the
application. Application calls invoke TopLink to provide persistence behavior. This
function allows for transactional and thread-safe access to shared database connections
and cached objects.

In addition to Java EE environments, TopLink fully supports non-Java EE
environments as well. See Section 2.3, "Selecting an Architecture with TopLink" for
more information.
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Using Oracle JDeveloper TopLink Editor

This chapter provides general information about Oracle JDeveloper TopLink Editor, as
well as detailed information on using and customizing it.

This chapter includes the following sections:

s Introduction to Oracle JDeveloper TopLink Editor
s Configuring the Oracle JDeveloper TopLink Editor
»  Using the Oracle JDeveloper TopLink Editor

4.1 Introduction to Oracle JDeveloper TopLink Editor

Using Oracle JDeveloper's TopLink editor, you can quickly and easily configure and
map your Java classes, EJB, JPA entities to different data sources, including relational
databases, enterprise information systems (EIS), and XML schemas without using code.
The TopLink editor supports multiple standards, including JPA and E]B 3.0.

For more information, see the "Developing TopLink Mappings" section of the Oracle
JDeveloper online help.

4.2 Configuring the Oracle JDeveloper TopLink Editor

For more information, see "Configuring TopLink Preferences" in the "Developing
TopLink Mappings" section of the Oracle JDeveloper online help.

4.3 Using the Oracle JDeveloper TopLink Editor

Figure 4-1 shows the primary parts of the TopLink editor:
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Figure 4-1 Parts of the TopLink Editor

% Oracle Jeveloper Fusian - Application? jes : Project?. jpr

Ele DM \ew Search Wavigln Bun Debug Pefgclor Versigning Took Window  Hep
Beld 90 Xk 0-0- 8- Adda- p- S-@dGNE BN
.}am«:m Dycomectors |3 L] e

5 appacaton! bl |-l Y Y-

| W Progcts ey

=R 8- P astozined Tale | <nons sslscteits

Primary Feys

1
= n
n S Fauticnad Ocect Wig e Sanpuencing
=10 ofine Dtshiarts Sourcas -
i - St

Cpaoper sk 111 I e Ediing 3 133 of 157

1. TopLink Project Elements in the Application Navigator
2. TopLink Editor Tabs in the Editor Window
3. TopLink Project Elements in the Structure Window

For more information, see "About the TopLink Editor" in the "Developing TopLink
Mappings" section of the Oracle JDeveloper online help.

4.3.1 TopLink Project Elements in the Application Navigator

The Application Navigator displays each element of with your TopLink mappings
including the mapping project, deployment descriptor, and sessions information.

Figure 4-2 shows sample TopLink project elements in the Application Navigator.

Figure 4-2 Sample TopLink Editor — Application Navigator
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Figure 4-2 identifies the following user interface components:
1. TopLink folder
2. Sessions configuration file (sessions.xml)

3. TopLink map

4.3.2 TopLink Editor Tabs in the Editor Window

The TopLink Editor displays your TopLink mapping information. The information in
the editor will vary, depending on the TopLink element you selected in the
Application Navigator or Structure window.

Figure 4-3 shows the TopLink Editor tabs for a TopLink map.
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Figure 4-3
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4.3.3 TopLink Project Elements in the Structure Window

The Structure window displays detailed information about the TopLink element
selected in Application Navigator or TopLink Editor.

When working with an EJB or Java class, the Structure window displays the

related TopLink descriptor and its mapping attributes.

When working with a TopLink sessions configuration file, the Structure window

displays your sessions and session brokers.

When working with a persistence configuration, the Structure window displays

your JPA descriptors and persistence units.

When you select an item in the Structure window, its properties appear in the TopLink
Editor.

Figure 4-4 Sample TopLink Editor — Structure Window
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Figure 4-4 identifies the following user interface components:

1.

2
3.
4

Descriptor

TopLink map

Unmapped attribute

Mapped Java attribute (one-to-one mapping)
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You can perform specific functions for an item by selecting the item in the Navigator
and doing the following:

= Right-clicking the object and selecting the function from the pop-up menu.

= Selecting the object by clicking a button in the Structure toolbar.
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Using TopLink Workbench

This chapter provides information about understanding, using, and customizing
TopLink Workbench.

This chapter includes the following sections:

s Introduction to TopLink Workbench

s Configuring the TopLink Workbench Environment
s Using TopLink Workbench

= Using TopLink Workbench Preferences

s Using Databases

s Using XML Schemas

s Using Classes

s Integrating TopLink Workbench with Apache Ant

For information on using TopLink Workbench to configure sessions XML, refer to
Part XXI, "TopLink Sessions".

5.1 Introduction to TopLink Workbench

TopLink Workbench is a separate component from the TopLink runtime-it lets you
graphically configure descriptors and map your project. TopLink Workbench can
verify the descriptor options, access the data source (either a database or an XML
schema), and create the database schema. Using TopLink Workbench, you can define
TopLink descriptors and configurations without using code.

You can use TopLink Workbench during the development phase of the development
process (see Section 2.1, "Introduction to TopLink Application Development").
Typically, this phase includes the following:

1. Defining an object model (a set of Java classes) to describe and solve your
problem.

2. Creating a TopLink Workbench project, importing your Java classes and data
sources, and using descriptors to describe how the Java classes map to your data
source model.

3. Creating a TopLink session and registering your descriptors. In your application,
use the session to retrieve and store objects from and to the data source.

TopLink Workbench creates a <projectName>.mwp file to store all TopLink project
information, including object model, descriptor, and session information.
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The <projectName>.mwp file is used only by TopLink Workbench. Typically, the
only time you need to modify the <projectName>.mwp file is to merge changes
during application development by a team of developers (Section 7.2.2, "How to
Merge Files").

Using TopLink Workbench, you export this information into a project . xml file that
your TopLink enabled application reads at run time.

For more information on using TopLink Workbench as the development environment,
see Figure 3-2.

5.2 Configuring the TopLink Workbench Environment

TopLink Workbench reads its environment variables from the setenv script in the
<TOPLINK_HOME>/bin directory.

Before you launch TopLink Workbench, you must configure its environment as
follows:

1. Use a text editor to open the <TOPLINK_HOME>/bin/setenv script.
= For Windows, open the setenv. cmd file.
»  For UNIX, open the setenv. sh file.

2. Ensure that the JAVA__HOME environment variable is set:
s For Windows: set JAVA_HOME=C:/j2sdk1l.5.0_04

s For UNIX: JAVA_HOME=/usr/local/packages/java; export JAVA_
HOME

3. Update the DRIVER_CLASSPATH environment variable to add the location of the
following (if necessary):

Note: Do not include any Java classes for your persistent business
objects in the DRIVER_CLASSPATH variable. Instead, add these
persistent business objects in your TopLink Workbench project
classpath (see Section 117.3, "Configuring Project Classpath").

= JDBC drivers—if you are using relational projects (see Section 18.1, "Building
Relational Projects").

= Java EE Connector Architecture (JCA) adapters—if you are using EIS projects
(see Section 71.1, "EIS Project Concepts").

s JCA connector. jar file-if you are using EIS projects (see Section 71.1, "EIS
Project Concepts").

The connector. jar file contains javax.resource.cci and
javax.resource. spi interfaces that TopLink EIS uses. By default, TopLink
Workbench updates its classpath to include the Java 1.5.n connector. jar
file from <ORACLE_HOME>/11ib/java/api. If this version of the
connector. jar file is incompatible with your environment, edit the
workbench. cmd or workbench. sh file in < TOPLINK_
HOME>/utils/workbench to change the path to this file.

At run time, this connector. jar file (or its equivalent) must be on your
application or application server classpath.
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s Oracle Database ORACLE_HOME/rdbms/jlib/xdb. jar file-if you are using
direct-to-XMLType mappings with an Oracle9i Database or later (see
Section 27.4, "Direct-to-XMLType Mapping").

s Custom Collection class that you use to override the default Collection
class that TopLink uses with a mapping container policy (see Section 121.14,
"Configuring Container Policy").

Example 5-1 shows how to set the DRIVER_CLASSPATH variable for Windows
system, and Example 5-2—for UNIX.

Example 5-1 Setting DRIVER_CLASSPATH on Windows

set DRIVER_
CLASSPATH=C: \OraHome2\jdbc\lib\ojdbcld.jar;C:\Attunity\Connect\Java\lib\attunityResourceAdapt
er.jar;C:\OraHome2\rdbms\jlib\xdb.jar

Note: If the path to your driver(s) contains spaces, you must enclose
the path in double-quotes in the setenv. cmd file. For example:

set DRIVER_CLASSPATH="C:\Program Files\some directory\driver.jar"

Example 5-2 Setting DRIVER_CLASSPATH on UNIX

DRIVER_
CLASSPATH=/OraHome2/jdbc/1lib/ojdbcl4. jar; /attunity/connect/java/lib/attunityResourceAdapter.j
ar; /OraHome2/rdbms/jlib/xdb.jar; export JDBC_CLASSPATH

4. Save and close the setenv script.

To launch TopLink Workbench, double-click the workbench. cmd file located in
<TOPLINK_HOME>/utils/workbench directory.

5.2.1 How to Configure the Language Preference

To use TopLink Workbench in a language different than your default, add the

-Duser . language and -Duser . country options to the JVM_ARGS variable in the
workbench.cmd or . sh file. For example, the following arguments will start TopLink
Workbench in US English, regardless of default language of your operating system:

JVM_ARGS="-Duser.language=en -Duser.country=en_US"

5.3 Using TopLink Workbench

Figure 5-1 shows the primary parts of TopLink Workbench window.
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Figure 5-1 TopLink Workbench Window
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numbered callouts in Figure 5-1 identify the following user interface components:
Menu bar

The menu bar contains menus for each TopLink Workbench function. Some objects
also contain context-sensitive menus. See Section 5.3.1, "How to Use Menus" for
more information.

Toolbars

The toolbars contain shortcuts to specific functions. See Section 5.3.2, "How to Use
Toolbars" for more information.

Navigator window section

The Navigator window section shows the project navigation tree for all open
projects (see Section 5.3.3, "How to Use the Navigator"). Click the plus (+ ) or
minus (- ) sign next to an object (or double-click the object) to expand or collapse
the tree. When you select an object in the Navigator window section, its properties
appear in the Editor window.

Editor window section

The Editor window section contains specific property sheets and option tabs for
the currently selected object. See Section 5.3.4, "How to Use the Editor" for more
information.

Problems window section
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The Problems window section shows messages and errors for the currently
selected object in the Navigator window section (see Section 5.3.5, "How to Use the
Problems Window"). Section A.3, "TopLink Workbench Error Reference" contains
detailed information on each error message.

5.3.1 How to Use Menus
TopLink Workbench contains the following two types of menus:
s Menu bar menus (see Section 5.3.1.1, "Using Menu Bar Menus")

s Context menus (see Section 5.3.1.2, "Using Context Menus")

5.3.1.1 Using Menu Bar Menus

The menu bar, located at the top of the TopLink Workbench window, provides menus
for each TopLink Workbench function. Some menus (such as Selected) are
context-sensitive; the available options may vary, depending on the currently selected
object.

Figure 5-2 Sample Menu Bar Menu
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- E EmploymentPeriod - "
- g LargeProject HIOELF K
- 3 Phonemiurnber ADDRESS.ADDRESS _ID add...
- g SmallProject
ﬁ Database (Oraclel0g) Remave o
Use Sequencing:
Mame: ADDRESS_SEQ
ol [ ] b
i Problemns
Mode e Message

5.3.1.2 Using Context Menus

When you right-click objects in the Navigator window, a context menu appears with
functions specific to the selected object.
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Figure 5-3 Sample Context Menu

:\; Oracle ToplLink Workbench

File ‘workbench Selected Tools  Window Help

D-ElREM0T B &'y @
3 Mavigataor | g Editar
=2 11r

Refresh Classes

i Add or Refresh Classes...

G Create Mew Class. .

Manage Mon-Descriptor Classes ...
E Update Project From ejb-jar . =ml
%Write Project to ejb-jar.xml

[ﬁ Close

T3k Delete Praject...

B:ave

E] Save As...

|igg Expart

% Automap

i, Problems
— Help

=== =T

Chrlshift+R
=i vefaults | Options |
Chrl+E 2
ployesimw |
Chrl+F4 o
Chrl+shift+a
g 1| Browse... b

5.3.2 How to Use Toolbars

TopLink Workbench contains the following toolbars at the top of the window:

= Standard toolbar (see Section 5.3.2.1, "Using Standard Toolbar")

= Context toolbar (see Section 5.3.2.2, "Using Context Toolbar")

Toolbars provide tool tips: each toolbar button provides a brief description when you

position the mouse pointer over it.

5.3.2.1 Using Standard Toolbar

The standard toolbar furnishes quick access to the standard menu options (File, Edit,

Selected, and so on).

Table 5-1 Standard Toolbar Buttons

Button Description Available for...
New All

Open All

Save All

@ Save as All

Save all All

@ Close All

|i| Close all All

Help topics All
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Table 5-1 (Cont.) Standard Toolbar Buttons

Button Description Available for...

% Export deployment XML for the selected ~ Projects
projects

E‘ Refreshes selected classes Projects

a Add or refresh classes Projects

i‘ Create new class Projects

5.3.2.2 Using Context Toolbar

The context toolbar provides quick access to functions for the currently selected object
in the Navigator (see Section 5.3.3, "How to Use the Navigator"). The available buttons
will vary, depending on which item you have selected.

You can also right-click the item and choose the appropriate option from the context
menu.

Table 5-2 Context Toolbar Buttons

Button Description Available for...
@ Login to database Databases
\ﬁl Logout of database Databases
o Add new table Databases
[ Add or update existing tables from Databases
database
g Refresh from database Database tables
B Remove table or selected item Database tables
ﬂ Rename table or selected item Database tables
5 Import schema Schemas
2 Relational aggregate descriptor Descriptors
- Relational class descriptor Descriptors
@ Relational EJB descriptor Descriptors
2, EIS composite descriptor Descriptors
@, EIS root descriptor Descriptors
e, EIS EJB descriptor Descriptors
iy XML descriptor Descriptors
> Direct-to-field mapping Attributes in relational descriptors
ar Object type mapping’ Attributes in relational descriptors
o Type conversion mapping' Attributes in relational descriptors
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Table 5-2 (Cont.) Context Toolbar Buttons

Button Description Available for...

" Serialized object mapping' Attributes in relational descriptors
oy Direct-to-XMLType mapping Attributes in relational descriptors
3 Direct collection mapping Attributes in relational descriptors
% Direct map mapping Attributes in relational descriptors
@ Aggregate mapping Attributes in relational descriptors
o One-to-one mapping Attributes in relational descriptors
o8 Variable one-to-one mapping Attributes in relational descriptors
o One-to-many mapping Attributes in relational descriptors
o Many-to-many mapping Attributes in relational descriptors
" Direct mapping Attributes in EIS descriptors

s Direct collection mapping Attributes in EIS descriptors

) Composite object mapping Attributes in EIS descriptors

.. Composite collection mapping Attributes in EIS descriptors

P One-to-one mapping Attributes in EIS descriptors

o One-to-many mapping Attributes in EIS descriptors

" Direct-to-XML mapping Attributes in XML descriptors

- Direct collection mapping Attributes in XML descriptors

e, Composite object mapping Attributes in XML descriptors

N Composite collection mapping Attributes in XML descriptors

oz Any object mapping Attributes in XML descriptors

o7 Any collection mapping Attributes in XML descriptors

2% Transformation mapping Attributes in all descriptors

. Unmap Attributes in all descriptors

Session Sessions configurations

Session Broker

Sessions configurations

Named connection pool

Server sessions

Sequence connection pool

Server sessions

Write connection pool

Server sessions
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Table 5-2 (Cont.) Context Toolbar Buttons

Button Description Available for...
ﬂ Rename Database sessions, session brokers
% Delete session Database sessions, session brokers

! Deprecated. For more information, see Section 27.2.2.2, "Using a Converter Mapping"

5.3.3 How to Use the Navigator

TopLink displays the items included in each project (descriptors, mappings, data
source, and so on) in the Navigator on the left side of the TopLink Workbench
window, as Figure 5-4 shows.

Figure 5-4 Sample Navigator

@-______;iNavigator
—j *Employes ~
=i *examples sessions. threstier,mor

*% country
*% id

& postalCode
# province
i shrest

@7% *Emploves

+_._‘% PhoneMumber

=i w *Database (Oraclel0g)
O FE ADDRESS

®7—-- EF EMPLOVEE

The numbered callouts on Figure 54 identify the following user interface
components:

1. Project (relational project)

2, Package

3. TopLink Descriptor (relational descriptor)

4. Attribute/mapping (direct to field mapping)
5. Unsaved/changed item

6. Database

7. Database table

Click the plus ( +) or minus ( - ) sign next to the item, or double-click the item name to
expand or collapse the item.

TopLink Workbench identifies items that have been changed but not yet saved by
adding an asterisk ( *) in front of the item name.

When you select an item in the Navigator, its properties appear in the Editor (see
Section 5.3.4, "How to Use the Editor").

To perform specific functions for an item, select the item in the Navigator and do one
of the following:

= Right-click on the object and select the function from the context menu (see
Section 5.3.1.2, "Using Context Menus").
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s Choose a function from the Selected menu (see Section 5.3.1.1, "Using Menu Bar
Menus").

For information on using the Navigator with a database in relational projects, see
Section 5.5.1, "How to Use Database Tables in the Navigator Window".

For information on using the Navigator with an XML schema in EIS projects (using
XML records) and XML projects, see Section 5.6.1, "How to Use XML Schemas in the
Navigator".

Active and Inactive Descriptors

Inactive descriptors appear dimmed in the Navigator. Inactive descriptors are not
registered with the session when the project is loaded into Java. This feature lets you
define and test subsets of descriptors. To activate or deactivate a descriptor, right-click
the descriptor and select Activate/Deactivate Descriptor from the context menu.

Figure 5-5 Sample Active and Inactive Descriptors

3 Mavigaktor
B_.i Employes

\é Employee

@ I “#= Phoneumber
& § Database (Orack10g)

Figure 5-5 numbered callouts show the following user interface components:
1. Inactive descriptor

2. Active descriptor

Errors and Missing Information

A If an element in the project (such as a descriptor or mapping) contains an error or some
deficiency (sometimes called neediness), a warning icon appears beside the element
icon in the Navigator, and TopLink Workbench displays a message in the Problems
window (see Section 5.3.5, "How to Use the Problems Window").

Section A.3, "TopLink Workbench Error Reference" contains more information on each
TopLink Workbench error message.

5.3.4 How to Use the Editor

The Editor, on the right side of the TopLink Workbench window, displays the property
sheet associated with the currently selected item in the Navigator, as Figure 5-6
shows.
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Figure 5-6 Sample Editor

[ Editor
@_ “# Address

@_DESCHD'ZOF Info | Class Info | Queries | Caching | Locking

Associated Table: | ADDRESS v |

Primary Keys

ADDRESS.ADDRESS_ID Add. ..

Use Sequencing:

Mame: | SEQ |
Table: | ADDRESS v|
Field: |ADDRESS_ID (MUMEER) |
[ Read-Cnily

[] Confarm Results in Unit of Wark.

Descriptor Alias: | Address

Carmment

Figure 5-6 numbered callouts identify the following user interface components:
1. Selected element (from the Navigator)

2. Editor property tabs

5.3.5 How to Use the Problems Window

A If an element in the project (such as a descriptor or mapping) contains an error or some
deficiency (sometimes called neediness), the TopLink Workbench displays a caution
icon (represented by a yellow triangle with a black exclamation point in the middle) to
the left of the deficient element in the Navigator (see Section 5.3.3, "How to Use the
Navigator") and displays a message in the Problems window as Figure 5-7 shows.

If you select the error, then TopLink Workbench displays the complete error message
in the Problems window. Section A.3, "TopLink Workbench Error Reference" contains
detailed information on each error message.

Figure 5-7 Sample Deficient Mapping

3 Mavigataor
Bj *Employee

(= #3 *examples.sessions,threetier. madel
-4 *Address

T ity
*% country

hEs
+-- @3 Employes
‘ﬁ PhoneMumbe
[ @ Database (Oracl

L% Problems

ode Code Message

_'Tl‘ft province |D420 |N0 database field is selected,
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Double-click any error message in the Problems window to automatically highlight
the specific node in the Navigator. To display or hide the Problems window, select
Window > Show Problems from the menu.

You can also create a status report (see Section 116.2.3, "How to Generate the Project
Status Report") that includes all errors in a selected project.

5.3.6 How to Use the Online Help

TopLink Workbench contains an extensive online Help system to assist you in
developing TopLink applications.

To receive help on any field, tab, or element in TopLink Workbench, right-click the
element and select Help from the context menu or press F1.

To review the complete TopLink documentation and Quick Start, click Help.

5.4 Using TopLink Workbench Preferences

To customize TopLink Workbench, select Tools > Preferences from the menu. The
Preferences dialog box appears.

Figure 5-8 Preferences Dialog Box

:\: Preferences

General

Display Splash Screen

Look and Feel: |Wind0ws w |

-Database Size of recently opened Files lisk:
= S:essmns Configuration HTTF Proey Host: |
oo New Names
L. Platfarm HTTP Proeey Part: | 30

Metwork Connect Timeout {seconds): | 10

Metwork Read Timeout (seconds): | 10

|:| Reopen Prajects on Startup

[ Import.., ][ Export... H (o] 4 H Cancel

TopLink Workbench provides the following preferences:
s How to Use General Preferences
- How to Use Help Preferences
s How to Use Mappings Preferences
- How to Use Class Preferences
— How to Use EJB Preferences
- How to Use Database Preferences
s How to Use Sessions Configuration Preferences
- How to Use New Names Preferences

— How to Use Session Platform Preferences
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Use this dialog box to configure TopLink Workbench preferences. After changing
preferences, you must restart TopLink Workbench.

To import your preferences from an existing file, click Import and select the file.

To export your preferences, click Export and select a directory location and filename.

5.4.1 How to Use General Preferences

Use the General preferences to customize the look and feel (the graphical user
interface) of TopLink Workbench as well as to specify any proxy information required
to access the Internet (for example, to allow TopLink to access XML schemas hosted on
Internet sites). Follow these steps to customize the General preferences:

1.
2.

Select Tools > Preferences from the menu. The Preferences dialog box appears.

Select General in the Category window.

Figure 5-9 Preferences—General Dialog Box

:\: Preferences

B S_essions Configuration
F Mew Names
Lo Platfarm

Metwork

Metwork

[ Reop

General
Display Splash Screen
Look and Feel:

Size of recently opened files list:
HTTP Proxy Host:

HTTP Proxy Part:

| windows
|

|0

Connect Timeout {seconds): | 10

Read Timeout {seconds): | 10

en Projects on Startup

J

[ Import,., ][ Export... (o] 4 H Cancel

]

Use the following information to enter data in each field of the dialog box:

Field Description

Display Splash Screen  Specify if TopLink Workbench should show the graphical splash
screen when starting.

Look and Feel Select the look and feel to use for TopLink Workbench.

Size of recently opened

Select the number of projects to maintain in the File menu. See

files list Section 116.2.1, "How to Open Existing Projects" for more
information.

HTTP Proxy Host Specify if your PC requires a proxy server to access the internet.

HTTP Proxy Port Specify the port used by your proxy host.

Network Connect
Timeout

Specify the timeout (in seconds) to establish a network or internet
connection.

Network Read Timeout

Specify the timeout (in seconds) when accessing data from a
network or internet connection.

Reopen Projects on
Startup

Select to reopen the projects that were open the last time you exited
the TopLink Workbench.
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You must restart TopLink Workbench to apply the changes.

5.4.2 How to Use Help Preferences

Use the Help preferences to select the Help system preferences.
1. Select Tools > Preferences from the menu. The Preferences dialog box appears.

2. Expand General in the Category window and select Help. The Preferences—Help
dialog box appears.

Figure 5-10 Preferences—General-Help Dialog Box

:\: Preferences

Help
: elp
: Mappings Display Welcome at Startup
External HTML Browser:
e | :\Program Files\Mozilla Firefox\Firefox. exe | [ Erawse. .. l
(= S_essions Configuration Help Jar:
----- Mew Names | | [ Browse. .. ]
= Platfarm
[ Innpark. .. ] [ Expart... ] [ QK ] [ Cancel

Use the following information to enter data in each field:

Field Description
ISDisplay Welcome at Specify if TopLink should show the Welcome screen each time
tartup

you start TopLink Workbench.

External HTML Browser Click Browse and select the location of your default Web browser.
You must specify a Web browser to access the Quick Tour, Javadoc
(API), and other Web-based material.

Help Jar Specify the location of the JAR file that contains help topics.

Click Browse and select the help JAR file location. The default
filename is <TOPLINK_
HOME>/utils/jlib/help/tlmwhelp.jar

To use the help content in a language other than the default
language for your local, specify a different help JAR file.

Note: You must restart TopLink Workbench to apply changes
to this option.

5.4.3 How to Use Mappings Preferences

Use the Mappings preferences to specify general mapping preferences. Follow these
steps to set the Mapping preferences:

1. Select Tools > Preferences from the menu. The Preferences dialog box appears.

2. Select Mappings in the Category window. The Mappings dialog box appears.
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Figure 5-11 Preferences—-Mappings Dialog Box

:\; Preferences

[z General Mappings
E| Allow changing query bype
) es )Mo () Prompt
H s s Allow changing query Format
[ Sessions Configuration
- Hew Mames O Yes O Mo (%) Prompt
L Platfarm
[ Imnpart. .. ] [ Expart... ] [ QK ] [ Cancel

Use the following information to enter data in each field:

Field Description

Allow changing query  Configure whether or not TopLink Workbench always allows, never
type allows, or prompts before allowing you to change the query type
associated with a descriptor.

Allow changing query  Configure whether or not TopLink Workbench always allows, never
format allows, or prompts before allowing you to change the configuration
of a query associated with a descriptor.

5.4.4 How to Use Class Preferences

Use the Class preferences to specify how TopLink Workbench maintains classes when
renaming or editing a zero-argument constructor. Follow these steps to set the Class
preferences:

1. Select Tools > Preferences from the menu. The Preferences dialog box appears.

2. Expand Mappings in the Category window and select Class.
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Figure 5-12 Preferences — Mappings — Class Dialog Box

:\; Preferences

(= General
i e Help
-Mappings

- EJB

- Database

= Sessions Configuration
----- Mew Mames
... PlatFarm

Class

IMaintain a zero-argument conskruckor while editing dasses

If an exisking zero-argument constructor is renamed or & parameter is added

to it, the Workbench will add another zero-argument constructor to the class,

O ves
)Mo
() Prampt

[ Imnpart. .. ][ Expart... H QK ][

Caneel

]

On the Preferences—-Mappings—Class dialog box, specify how TopLink Workbench
maintains classes when renaming or editing a zero-argument constructor.

5.4.5 How to Use EJB Preferences

Use the EJB preferences to specify how TopLink Workbench updates the
ejb-jar.xml file when saving EJB projects. Follow these steps to set the EJB

preferences:

1. Select Tools > Preferences from the menu. The Preferences dialog box appears.

2. Expand Mappings in the Category window and select EJB.

Figure 5-13 Preferences—-Mappings—EJB Preferences Dialog Box

:\: Preferences

(= General

EIB

‘Write ejb-jar, xml on project save

() Always () Mewer (%) Prompt
JEI
s ahaze Allows removing EJB info
(=)~ Sessions Configuration
S New Narmes O ves )Mo (%) Prompt
“o Platform
Allaw remaving EJE 2.x info
) es )Mo (%) Prompt
[ Irnpark. .. ] [ Expart... ] [ CK ] [ Cancel

Use the following information to select how TopLink Workbench will update the

ejb-jar.xml file:
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Field Description

Write ejb-jar.xml on Configure whether or not TopLink Workbench always updates,

project save never updates, or prompts before updating the ejb-jar.xml file
each time you save the project.

Allow removing EJB Configure whether or not TopLink Workbench always allows, never

info allows, or prompts before allowing you to remove the E]JB

information associated with a descriptor. See Section 119.18,
"Configuring a Descriptor with EJB CMP and BMP Information" for
more information.

Allow removing EJB 2.x Configure whether or not TopLink Workbench always allows, never

info allows, or prompts before allowing you to remove the EJB 2.0 or 2.1
information associated with a descriptor. See Section 119.18,
"Configuring a Descriptor with EJB CMP and BMP Information" for
more information.

5.4.6 How to Use Database Preferences

Use the Database preferences to specify custom database divers and connection URLs
for TopLink Workbench. These drivers and URLs can then be used when defining
database logins. Follow these steps to set the Database preferences:

1. Select Tools > Preferences from the menu. The Preferences dialog box appears.

2. Expand Mappings in the Category window and select Database.

Figure 5-14 Preferences-Mappings—Database Preferences Dialog Box

:\: Preferences

B General Database
C Lo Hep
E Mappings Database Driver: | |

Connection LRL: | |

co Mew Names
“ Platform

[ Import... ][ Export... H (o] 4 ][ Cancel

Use the following information to enter data in each field:

Field Description
Database Driver Enter the custom database driver class name.
Connection URL Enter the custom database connection URL.

5.4.7 How to Use Sessions Configuration Preferences

Use the Sessions preferences to specify default classpaths to be added to each newly
created TopLink sessions configuration for features that require an external Java class
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(for example, session event listeners). The entries added here will automatically
appear on the Sessions Configuration property sheet (see Section 88.3, "Configuring a
Sessions Configuration"). Follow these steps to set the Sessions Configuration
preferences:

1. Select Tools > Preferences from the menu. The Preferences dialog box appears.

2. Select Sessions Configuration in the Category window.

Figure 5-15 Preferences-Sessions Configuration Dialog Box

:\: Preferences

B General Sessions Configuration
. LeHelp
= Mappings Default Classpath For New Sessions Configuration

Add Entry

[ Import.., ][ Export... H [0 4 ][ Cancel ]

To add a JAR or ZIP file, click Add Entry or Browse and add the JAR or ZIP files that
contain the default compiled Java classes for this sessions configuration.

To remove a JAR or ZIP file, select the file and click Remove.

To change the order in which TopLink searches these JAR or ZIP files, select a file and
click Up to move it up, or click Down to move it down in the list.

5.4.8 How to Use New Names Preferences

Use the New Names preferences to specify the default values and names of newly
created sessions, session brokers, and connection pools. Follow these steps to set the
New Names preferences:

1. Select Tools > Preferences from the menu. The Preferences dialog box appears.

2. Expand Sessions Configuration in the Category window and select New Names.
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Figure 5-16 Preferences—Sessions Configuration—-New Names Dialog Box

:\; Preferences

= General New Names
i e Help
[=- Mappings Diefault Mew Mames
Sessions Configuration: | ses5i0ns | xml
SESsi0n; | Session |
Broker: | SessionBroker |
Connection Poal: | ConnectionPool |
[ Imnpart. .. ] [ Expart... ] [ QK ] [ Cancel

Use the following information to enter data in each field:

Field Description

Sessions Configuration Specify the default name for newly created sessions configuration
files (default, sessions.xml). See Section 88.2, "Creating a
Sessions Configuration" for more information.

Session Specify the default name for newly created sessions (default,
Session). See Section 88.1, "Introduction to the Session Creation"
for more information.

Broker Specify the default name for newly created session brokers (default,
SessionBroker). See Section 88.5, "Creating Session Broker and
Client Sessions" for more information.

Connection Pool Specify the default name for newly created connection pools
(default, ConnectionPool). See Chapter 100, "Creating an Internal
Connection Pool" for more information.

5.4.9 How to Use Session Platform Preferences

Use the Platform preferences to specify the default data source type for newly created
sessions. The type selected here will automatically appear on the Create New Session
dialog box. Follow these steps to set the Platform preferences:

1. Select Tools > Preferences from the menu. The Preferences dialog box appears.

2. Expand Sessions Configuration in the Category window and select Platform.
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Figure 5-17 Preferences—Sessions Configuration—Platform Preferences Dialog Box

:\; Preferences

Class
EJB

- Genersl Platform
. = Help
(= Mappings [ Use Server PlatFarm

i Database
(=]~ Sessions Configuration Default Daka Source Type
flew hames (¥) Database
PlakFarm
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[ Import... ][ Export... H (0] 4 ][ Cancel

Use the following information to enter data in each field:

Field

Description

Use Server Platform

Specify the default application server platform for newly created
sessions configuration files (default, sessions.xml). See
Section 88.2, "Creating a Sessions Configuration" for more
information.

Default Data Source
Type

Select the default data source type (Database, EIS, or XML) and
platform for newly created sessions. See Section 89.9, "Configuring
the Server Platform" for more information.

5.4.10 How to Use Platforms Preferences

Use the Platforms preferences to specify if platforms are to be visible in production.
Follow these steps to set Platforms preferences:

1. Select Tools > Preferences from the menu. The Preferences dialog box appears.

2. Select Platforms in the Category window.

Figure 5-18 Preferences — Platforms Preferences

:\: Preferences

e Help
appings

Clazs

EJB

H Database

E| Sezzions Configuration
| b New Names

- General Platforms

[ wisible in Procuction

| Help |

| Import ... || Export... || O _” Cancel |
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Configure whether or not TopLink Workbench allows platforms to be visible in
production.

5.5 Using Databases

In relational projects, when you expand the database object in the Navigator, TopLink
Workbench displays the database tables associated with the project. You can associate
tables by importing them from the database, or by creating them within TopLink
Workbench.

Figure 5-19 Sample Database Tables

3 Mavigator

@——9—3 ThreeTierEmployee

(3 examples sessions.threetier.model
= Diatabase (Oracle10g)
.- [ ADDRESS

@—7@ EMPLOYEE

- [ LPROJECT

Figure 5-19 numbered callouts identify the following database icons.

1. Project

2. Database

3. Database table

Each database table property sheet contains the following tabs in the Editor:

s Columns—Add or modify the table’s fields, and specify each field’s properties.
= References—Specify references between tables.

This section includes information on the following topics:

s How to Use Database Tables in the Navigator Window

= How to Use Database Tables in the Editor Window

s How to Generate Data from Database Tables

5.5.1 How to Use Database Tables in the Navigator Window

This section describes the following options:
s Logging In and Out of a Database

»s  Creating New Tables

s Importing Tables from a Database

s Removing Tables

= Renaming Tables

»  Refreshing Tables from the Database

See Section 5.5.2, "How to Use Database Tables in the Editor Window" for more
information.

5.5.1.1 Logging In and Out of a Database

To log in or out of a relational database, do the following:
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1. Create a database login (see Section 98.1, "Introduction to Database Login
Configuration").

2. Tolog in to a relational database, right-click the database object in the Navigator,
and choose Log In to Database from the context menu or choose Selected > Log
In to Database from the menu.

3. Tolog out of a relational database, right-click the database object in the Navigator
and choose Log Out of Database from the context menu or choose Selected > Log
Out of Database from the menu.

5.5.1.2 Creating New Tables

To create a new database table within TopLink Workbench, use the following
procedure:

1. Select the database object in the Navigator window and click Add New Table. The
New Table dialog box appears.

You can also right-click the database object and choose Add New Table from the
context menu, or choose Selected > Add New Table from the menu.

Figure 5-20 New Table Dialog Box

:\: New Table

Enter new table name:
Catalog:

Schema:

Table Mame;
[ NEWTABLE |

[ Help ] [ (o] 4 H Cancel ]

Use the following information to enter data in each field:

Field Description

Catalog Use to identify specific database information for the table. Consult
your database administrator for more information.

Schema Use to identify specific database information for the table. Consult
your database administrator for more information.

Table Name Specify the name of this database table.

TopLink Workbench adds the database table to the project.

Although the database table has been added to the project, it has not been written to
the actual database. See Section 5.5.3.4, "Generating Tables on the Database" for more
information on creating the table in the database.

Continue with Section 5.5.2, "How to Use Database Tables in the Editor Window" to
use these tables in your project.

5.5.1.3 Importing Tables from a Database

TopLink Workbench can automatically read the schema for a relational database and
import the table data into the project as long as your JDBC driver supports the
following JDBC methods:
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getTables
getTableTypes
getImportedKeys
getCatalogs

getPrimaryKeys

The JDBC driver must be on the TopLink Workbench classpath (see Section 5.2,
"Configuring the TopLink Workbench Environment").

To import tables from the database, use the following procedure:

1.

Select the database object in the Navigator, and click Add or Update Existing
Tables from Database. The Import Tables from Database dialog box appears.

You can also right-click on the database object in the Navigator and choose Add or
Update Existing Tables from Database from the context menu or choose Selected
> Add or Update Existing Tables from Database from the menu.

Figure 5-21 Import Tables from Database Dialog Box

: Catalog: | <Ignores w |
Schema Pattern: rVIW v |

T\." Import Tables from Database

Table Name Pattern: | % |

Table Type: [ TaBLE v|

Get Table Mames
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M PROJECT
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[ Import: Fully Gualified Mames
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Figure 5-21 numbered callouts identify the following user interface components:
1. Filters
2. Database tables that match the filters

Use the following information to enter data in each field of the dialog box:

Field Description

Table Name Pattern Specify the name of database table(s) to import. Use percent

character ( %) as a wildcard. Tables that match the Table Name
Pattern can be imported.

Catalog Specify the catalog of database table(s) to import.
Schema Pattern Specify the schema of database table(s) to import.
Table Type Specify the type of database table(s) to import.

Using TopLink Workbench 5-23



Using Databases

Field Description

Available Tables Click Get Table Names to make TopLink display tables that match
Table Name Pattern, Catalog, Schema Pattern, and Table Type
settings.

Selected Tables Select the tables in the Available Tables area to import, and click
the right-arrow button. TopLink adds the table to the Selected
Tables field.

Click OK to import the tables from the database into the TopLink
Workbench project.

Import Fully Qualified  Specify whether or not the tables’ names are fully qualified against
Names the schema and catalog.

Examine each table’s properties to verify that the imported tables contain the correct
information. See Section 5.5.2, "How to Use Database Tables in the Editor Window" for
more information.

5.5.1.4 Removing Tables

To remove a database table from the project, use the following procedure:

B 1. Select a database table in the Navigator, and click Remove Selected Item on the
toolbar. TopLink Workbench prompts for confirmation.

You can also right-click on the database object and choose Remove from the
context menu or choose Selected > Remove from the menu.

2. Click OK. TopLink Workbench removes the table from the project.

Note: Although you have removed the table from the TopLink
Workbench project, the table remains in the database.

5.5.1.5 Renaming Tables

To rename a database table in the TopLink Workbench project, use the following
procedure:

1. Select a database table in the Navigator, and click Rename on the toolbar. The
Rename dialog box appears.

You can also right-click on the table and choose Rename from the context menu or
choose Selected > Rename from the menu.

2. Enter a new name and click OK. TopLink Workbench renames the table.

Note: Although you have renamed the table in the TopLink
Workbench project, the original table name remains in the database.

5.5.1.6 Refreshing Tables from the Database

To refresh (that is, reload) the database tables in the TopLink Workbench project, use
this procedure:

2] Select a database table in the Navigator, and click Refresh from Database on the
toolbar.
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You can also right-click on the table and choose Refresh from Database from the
context menu or choose Selected > Refresh from Database from the menu. TopLink
Workbench reloads the database table.

When refreshing tables from the database, if there are multiple database tables with
similar names, the Duplicate Tables dialog box appears.

Figure 5-22 Duplicate Table Dialog Box

¢ Duplicate Tables for DUAL

The table DUAL has multiple matches on the database, please select the table From which vou wauld like ta refresh:
FUBLIC.DUAL
SYS.DUAL

Select the specific database table to update, and then click OK.

5.5.2 How to Use Database Tables in the Editor Window

When you select a database table in the Navigator, its properties appear in the Editor.
Each database table contains the following property tabs:

s Columns-Add or modify the table fields, and specify each field properties.
= References—Specify references between tables.

This section describes how to use these tabs to configure the following;:

s Working with Column Properties

= Setting a Primary Key for Database Tables

s Creating Table References

»  Creating Field Associations

5.5.2.1 Working with Column Properties

Use the database table’s Column tab to specify properties for the database table’s
fields.

To specify a table’s column properties, use this procedure:

1. Select a database table in the Navigator. The table’s property sheet displays in the
Editor.

2. C(Click the Columns tab.
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Figure 5-23 Fields Properties

References

MName Type Size Sub-Size | AllowsMull | Unique  Primary Key | Identity Add...
DESCRIF VARCHARZ  + | 200 3 .l (]
LEADER,_ID MUMBER, v| 152 o2 O (]
PROI_ID HUMBER, v/ 153 ol O
PROJ_NAME  [VARCHARZ w | 303 O [l
PROI_TYRE YARCHARZ w0 18 O [l
WERSION HUMBER, v| 153 ol | (]

3. Enter data in each field on the Columns tab. Use the scroll bar to display the

additional field.

Use the following information to fill each column on the Columns tab:

Field

Description

Name

Specify the name of the field.

Type

Use the drop-down list to select the field’s type.

Note: The valid values will vary, depending on the database.

Size

Specify the size of the field.

Sub-Size

Specify the sub-size of the field.

Allows Null

Specify if this field can be null.

Unique

Specify whether the value must be unique within the table.

Primary Key

Specify whether or not this field is a primary key for the table (see
Section 5.5.2.2, "Setting a Primary Key for Database Tables").

Identity

Use to indicate a Sybase, SQL Server or Informix identity field.

Note:

Some properties may be unavailable, depending on your
database type.

To add a new field, click Add.

To remove a field, select the field and click Remove.

To rename a field, select the field and click Rename.

5.5.2.2 Setting a Primary Key for Database Tables

To set a primary key(s) for a database table, use this procedure:

Note:

TopLink Workbench can automatically import primary key

information if supported by the JDBC driver.

1. Select a database table in the Navigator. Its property sheet appears in the Editor.
2, Click the Columns tab.

5-26 Developer's Guide for Oracle TopLink



Using Databases

Figure 5-24 Setting Primary Key for a Database Table

Prirnary key
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3. Select the Primary Key field(s) for the table.

5.5.2.3 Creating Table References

References are table properties that contain the foreign key; they may or may not
correspond to an actual constraint that exists on the database. TopLink Workbench
uses these references when you define relationship mappings and multiple table
associations.

When importing tables from the database, TopLink Workbench can automatically
create references (if the driver supports this), or you can define references from the
workbench. See Section 5.5.1.3, "Importing Tables from a Database".

To create a new table reference, use this procedure:

1. Select a database table in the Navigator. The table’s properties display in the
Editor.

2. C(Click the References tab.

Figure 5-25 References Tab

Columns | References |

@——l Mame Target Table On Database Add. ..
EMPLOYEE_ADDRESS  aialaliiass
EMPLOYEE_EMPLOYEE | EMPLOYEE w
EMPLOYEE_SALARY SALARY w O

@—— Source Columnn Target Calumn Add
ADDR._ID ~ | ADDRESS_ID w

Figure 5-27 numbered callouts identify the following user interface components:
1. Table References area
2. Key Pairs area

3. Inthe References area, click Add. The New Reference dialog box appears.
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Figure 5-26 New Reference Dialog Box

:\; New Reference

Enter Mame of Mew Reference:

Select the Source Table:

Select the Target Table:
ADDRESS

[] on Database

Use the following information to enter data in each field of the dialog box:

Field Description
Enter Name of New Specify the name of the reference table. If you leave this field
Reference blank, TopLink Workbench automatically creates a name based on

the format: SOURCETABLE_TARGETTABLE.

Select the Source Table  Specify the name of the source database table (the currently
selected table in the Navigator).

Select the Target Table Use the list to specify the target table for this reference.

On Database Specify if you want to create the reference on the database when
you create the table. Not all database drivers support this option.

Continue with Section 5.5.2.4, "Creating Field Associations".

5.5.2.4 Creating Field Associations

For each table reference, you can specify one or more field associations that define how
fields in the source table relate to fields in the target table. See Section 5.5.2.3, "Creating
Table References".

To create new field references, use this procedure:

1. Select a database table in the Navigator. The table’s properties display in the
Editor.

2. C(lick the References tab.

Figure 5-27 References Tab

Columns | References |

@——l ame Target Table On Database Add. ..
EMPLOYEE_EMPLOYEE | EMPLOYEE W
EMPLOYEE _SALARY SALARY W O

@—— Source Column Target Column Add
ADDR._ID | ADDRESS_ID W

Figure 5-27 numbered callouts identify the following user interface components:
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1. Table references area
2. Key pairs area
3. Select a table reference from the references area.

4. To create a new key pair, click Add in the key pairs area and complete each field in
the key pairs area using the following information:

To create a new key pair, click Add in the key pairs area and complete each field in the
key pairs area using the following information.

Field Description

Table References Area

Name Specify the name of this table reference
Target Table Specify the database table that is the target of this
reference.
On Database Specify if the reference exists on the database.
Key Pairs Area
Source Column Select the database field from the source table.
Target Column Select the database field from the target table.

5.5.3 How to Generate Data from Database Tables

TopLink Workbench can automatically generate a variety of information from the
database tables. This section describes the following;:

= Generating SQL Creation Scripts
= Generating Classes and Descriptors from Database Tables
= Generating EJB Entity Beans and Descriptors from Database Tables

= Generating Tables on the Database

5.5.3.1 Generating SQL Creation Scripts

Using the TopLink Workbench, you can generate SQL scripts that you can use to create
tables in a relational database.

To automatically generate SQL scripts to create the tables in a project, use this
procedure:

1. Select the database table(s) in the Navigator.

2. Right-click the table(s) and choose Generate Creation Script for > Selected Tables
or All Tables from the context menu. The SQL Creation Script dialog box appears.

You can also choose Selected > Generate Creation Script for > Selected Tables or
All Tables from the menu.

Using TopLink Workbench 5-29



Using Databases

Figure 5-28 SQL Creation Script Dialog Box

:\; SOL Creation Script

DROP TAELE PROJECT ~
CREATE TABELE PROJECT (PROI_TYPE YARCHARZ(1) NULL, DESCRIP YARCHARZ(Z00) |
MULL, YERSIGN NUMEER(15) NULL, LEADER _ID MUMBER(15) NULL, PROI_NAME
WARCHARZ(30) MULL, PROI_ID NUMBER{ 15) MOT MULL, PRIMARY KEY (PRO1_IDY)

DROP TABLE PHOME

CREATE TABELE PHOME (P_NUMBER YARCHARZ(T) MULL, AREA_CODE YARCHARZ(3)

MULL, EMP_ID NUMBERE 15) NOT MULL, TYPE YARCHARZ(15) NOT NULL, PRIMARY KEY
(EMP_ID, TYPE)

DROP TABLE PROI_EMP

CREATE TABLE PROI_EMP (EMP_ID NUMEER(15) NOT NULL, PROJ_ID MUMBER(15)

MOT MULL, PRIMARY KEY (EMP_ID, PROI_ID))

DROP TABLE EMPLOYEE

CREATE TABLE EMPLOYEE (START_DATE DATE MULL, GENDER YARCHARZ(1) NULL,
EMD_TIME DATE HULL, END_DATE DATE HULL, START_TIME DATE HULL, YERSION |
NUMBER(15) NULL, ADDR_ID NUMBER(1S) MULL, MANAGER _ID NUMEER(1SYNULL, |
L e i e ol e T = e e s ranT eram zmaitusemecacs OO

s

P

Copy the script and paste it into a file. You may need to edit the file to include
additional SQL information that TopLink Workbench could not generate. If the
database table or column name is an SQL reserved word, you must edit the SQL script
and enclose the database table or column in quotes. See "Oracle Database Reserved
Words" in the Oracle Database SQL Reference Guide for more information.

Note: If TopLink cannot determine how a particular table feature
should be implemented in SQL, it generates a descriptive message
in the script.

5.5.3.2 Generating Classes and Descriptors from Database Tables

TopLink Workbench can automatically generate Java class definitions, descriptor
definitions, and associated mappings from the information in database tables. You can
later edit the generated information if necessary.

For each table, TopLink Workbench does the following;:

»  Creates a class definition and a descriptor definition.

= Adds attributes to the class for each column in the table.

= Automatically generates access methods, if specified.

»  Creates direct-to-field mappings for all direct (nonforeign key) fields in the table.

»  Creates relationship mappings (one-to-one and one-to-many) if there is sufficient
foreign key information. You may be required to determine the exact mapping

type.

Note: Class and attribute names are generated based on the table
and column names. You can edit the class properties to change their
names.

To generate classes and descriptors from database tables, use the following
procedure:

1. Select the database table(s) in the Navigator.

2. Right-click the table(s) and choose Generate Classes and Descriptors from >
Selected Tables or All Tables from the context menu. TopLink Workbench
prompts you to save your project.
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You can also choose Selected > Generate Classes and Descriptors from >
Selected Tables or All Tables from the menu.

3. Click Yes. The Generate Classes and Descriptors dialog box appears.

Figure 5-29 Generate Classes and Descriptors Dialog Box

:\: Generate Classes and Descriptors

Package Marie: | |

Generate Accessing Methods

[ Ok l [ Cancel ]

Use the following information to enter data in each field:

Field Description

Package Name Specify the name of package to generate. The package name must
comply with Java naming standards.

Generate Accessing Specify if TopLink Workbench generates accessing methods for each

Methods class and descriptor.

If the table contains foreign key fields that may represent relationship mappings, then
the Choose Relationships to Generate dialog box appears.

Figure 5-30 Choose Relationships to Generate Dialog Box

:\: Choose Relationships to Generate

EBased on the foreign keys of the tables, some relationship mappings can be generated. Select the appropriate
relationships below and indicate their bvpes using the mapping buttans,

Potential Relationships: Selected Relationships:
EMPLOYEE (EMP_ID) =3 EMPLOYEE (MANAGER_ID
EMPLOYEE (MANAGER_ID) =3 EMPLOYEE (EMP_IDY

L

[] Generate Bi-directional Relationships

oK l [ Cancel

Select an entry from Potential Relationships and click the 1:1 Mapping or 1:M
Mapping button, located between the Potential Relationships and Selected
Relationships windows. See Chapter 27, "Introduction to Relational Mappings" for
more information on mappings.

You can also specify whether the relationships are bidirectional. See Section 121.18,
"Configuring Bidirectional Relationship" for more information.

Click OK to automatically create the relationships.

The newly created descriptors appear in the Navigator of TopLink Workbench.
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5.5.3.3 Generating EJB Entity Beans and Descriptors from Database Tables

Using TopLink Workbench, you can automatically generate EJB entity beans and
descriptors for each database table, including the following;:

= One EJB descriptor that implements the <javax.ejb.EntityBean> and entity
bean classes

»  Bean relation attributes (CMP or BMP)
= Java source for each class

= EJB-compliant method stubs

Note: This option is available only for projects with
container-managed or bean-managed persistence. See Section 117.5,
"Configuring Persistence Type" for more information.

To automatically generate EJB entity beans and descriptors for each database table, use
this procedure:

1. Select the database table(s) in the Navigator.

2. Right-click the table(s) and choose Generate EJB Entities and Descriptors from >
Selected Table or All Tables from the context menu. TopLink Workbench prompts
you to save your project.

You can also choose Selected > Generate EJB Entities and Descriptors from >
Selected Table or All Tables from the menu.

3. Click Yes to save your project before generating EJB entities. The Generate E]B
Entity Classes and Descriptors dialog box appears.

Figure 5-31 Generate EJB Entity Classes and Descriptors Dialog Box

T Generate EJB 2.0 CMP Entity Classes and Descriptors E|

Package Mame: | |

Thesefields appear
for BEJB 2.0 CMP
and BMP projects only. ||:| Generate Remote Inkerfaces

= o)

| Generate Local Inkerfaces

Use the following information to enter data in each field on the Generate EJB Entity
Classes and Descriptors dialog box:

Field Description

Package Name Name of the package to contain the generated entity
beans and descriptors.

Generate Local Interfaces! Specify if TopLink creates local interfaces for the EJB
entity beans.

Generate Remote Interfaces' Specify if TopLink creates remote interfaces for the EJB
entity beans.

1 For CMP and BMP projects only. See Section 119.18, "Configuring a Descriptor with EJB CMP and BMP
Information" for more information.
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If the table contains foreign key fields that may represent relationship mappings, then
the Choose Relationships to Generate dialog box appears. Select a potential
relationship and click the 1:1 Mapping or 1:M Mapping button, located between the
Potential Relationships and Selected Relationships windows.

You can also specify if the relationships are bidirectional (see Section 121.18,
"Configuring Bidirectional Relationship").

Repeat for all appropriate sets of tables.
Click OK to generate the relationship mappings.

The system creates the remote primary key, home, and bean classes for each bean and
adds this information to the project.

5.5.3.4 Generating Tables on the Database

To create a table in the database, based on the information in TopLink Workbench, use
this procedure:

Note: You must log in the database before creating tables. See
Section 20.6, "Logging In to the Database" for more information.

1. Select the database table(s) in the Navigator.

2. Right-click the table(s) and choose Create on Database > Selected Table or All
Tables from the context menu.

You can also create tables by selecting Selected > Create on Database > Selected
Table or All Tables from the menu.

TopLink Workbench creates the tables on the database.

Alternatively, you can generate tables at run time by exporting the information in
TopLink Workbench to a TableCreator class (see Section 6.1, "Introduction to the
Schema Manager").

5.6 Using XML Schemas

For XML and EIS projects, TopLink Workbench maps each TopLink descriptor to your
XML schema.

This section includes information on the following topics:
s How to Use XML Schemas in the Navigator

= How to Use an XML Schema Structure

s How to Import an XML Schema

s How to Configure an XML Schema Reference

s How to Configure XML Schema Namespace

5.6.1 How to Use XML Schemas in the Navigator

After you import one or more XML schemas into your project (see Section 5.6.3, "How
to Import an XML Schema") and you expand the schema object in the Navigator,
TopLink Workbench displays the schemas associated with the project.
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Figure 5-32 Sample XML Schemas
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Figure 5-32 numbered callouts identify the following schema icons:

1. Project

2. Schemas object

3. Specific schema

For more information, see the following:

s Section 5.6.2, "How to Use an XML Schema Structure"

»  Section 5.6.4, "How to Configure an XML Schema Reference"

= Section 5.6.5, "How to Configure XML Schema Namespace"

5.6.2 How to Use an XML Schema Structure

When you select a specific XML schema in the Navigator, you can display the
structure and details of the schema using the Schema Structure tab.

To display the structure and details of a schema, use this procedure:

1. Select a schema element in the Navigator. Its properties appear in the Editor.

2. Click the Schema Structure tab. The Schema Structure tab appears.

3. Select an element in the schema. The element’s details appear.
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Figure 5-33 Schema Structure Tab
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Use the following information to verify data in each field in the Schema Document

Info tab:

Field Description

Schema Structure Displays the elements of the schema, listed in alphabetical order, in
an expandable or collapsible tree structure.

Details Displays detailed information (such as name and type) for the

currently selected element in the Schema Structure area.

These fields are for display only and cannot be changed in TopLink Workbench.

5.6.3 How to Import an XML Schema

The first step in configuring an EIS project (using XML records) or XML project is
importing the XML schema(s) that your project uses.

When you import a schema, you define a schema reference that gives TopLink the
information it needs to locate the schema itself. Anytime after you import an XML
schema, you can update the schema reference (see Section 5.6.4, "How to Configure an
XML Schema Reference") if necessary.

After importing an XML schema, you can configure XML schema namespaces (see
Section 5.6.5, "How to Configure XML Schema Namespace").

To import an XML schema into an EIS project (using XML records) or an EIS project,
use this procedure:

1. Right-click the schemas element in the Navigator and select Import Schema from
the context menu. The Import Schema dialog box appears.
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Figure 5-34 Import Schema Dialog Box

:\; Import Schema

Mame: |
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(®) File:

O URL:

() Classpath:

Cancel

Use the following information to enter data in each field in the Import Schema dialog

box:

Field

Description

Name

Specify the name of this schema. This is the display name that
TopLink Workbench uses. It can be different than the name you
specify when you configure Source.

Source

Select how TopLink Workbench should import the schema.

File

Specify that TopLink Workbench should import the schema from a
file.

Enter the fully qualified directory path and filename of the schema
file.

URL

Specify that TopLink Workbench should import the schema using a
URL.

Enter the complete URL of the schema file.

Note: When importing schemas by URL, ensure you have set your
proxy information correctly. See Section 5.4.1, "How to Use General
Preferences” for more information.

Classpath

Specify that TopLink Workbench should import the schema from the
project classpath.

Resource Name

Enter the fully qualified name of the XML schema file including the
name of the package of which it is a part. For example, if your XML
schema mySchema.xsdisin C:\project\config and you add
this directory to your project classpath (see Table 117—4, " Project
Support for Project Classpath"), specify a resource name of
project.config.mySchema.xsd.

To reimport a specific schema, right-click on the specific schema in the Navigator and
select Reimport Schema from the context menu.

To reimport all schemas in a project, right-click on Schemas in the Navigator and select
Reimport All Schemas from the context menu.

To change a schema’s source, right-click on the specific schema in the Navigator
window and select Properties from the context menu. The Schema Properties dialog

appears.
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5.6.4 How to Configure an XML Schema Reference

After you import an XML schema (see Section 5.6.3, "How to Import an XML
Schema"), you can update its source by configuring the schema reference.

5.6.4.1 How to Configure an XML Schema Reference Using TopLink Workbench

To specify the source of a schema, use this procedure:
1. Select a schema element in the Navigator. Its properties appear in the Editor.

2. Click the Schema Document Info tab. The Schema Document Info tab appears.

Figure 5-35 Schema Document Info Tab—Source Field

e,
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Target Mamespace:

MNamespace URL Prefix Declare
(absent) | |

Imported Namespaces:

Mamespace URL Prefix Declare

3. Click Edit to select a new source for the selected schema. The Schema Properties
dialog box appears.

Figure 5-36 Schema Properties Dialog Box

:\: Schema Properties

Matne: | employes |

SOurce:
(®) File:
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O URL:
| |

) Classpath:

[ Reimport H OK H Cancel ]

Use the following information to complete each field in the Schema Properties dialog
box:
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Field

Description

Name

Specify the name of this schema. This is the display name that
TopLink Workbench uses. It can be different than the name you
specify when you configure Source.

Source

Select how TopLink Workbench should import the schema.

File

Specify that TopLink Workbench should import the schema from a
file.

Enter the fully qualified directory path and filename of the schema
file.

URL

Specify that TopLink Workbench should import the schema using a
URL.

Enter the complete URL of the schema file.

Note: When importing schemas by URL, ensure you have set your
proxy information correctly. See Section 5.4.1, "How to Use General
Preferences” for more information.

Classpath

Specify that TopLink Workbench should import the schema from the
project classpath.

Resource Name

Enter the fully qualified name of the XML schema file including the
name of the package of which it is a part. For example, if your XML
schema mySchema.xsd is in C: \project\config and you add this
directory to your project classpath (see Section 117.3, "Configuring
Project Classpath", specify a resource name of
project.config.mySchema.xsd.

5.6.4.2 How to Configure an XML Schema Reference Using Java

Use Java to configure schema reference. Create a descriptor amendment method (see
Section 119.35, "Configuring Amendment Methods") that instantiates the appropriate
type of XMLSchemaReference (XMLSchemaClassPathReference,
XMLSchemaFileReference, or XMLSchemaURLReference) and configures the
descriptor with it, as follows:

= If you are using EISDescriptors, the TopLink runtime does not use the schema
reference; no further configuration is required.

= If you are using XMLDescriptors, configure the descriptor with the
XMLSchemaReference using XMLDescriptor method setSchemaReference.

5.6.5 How to Configure XML Schema Namespace

As defined inhttp: //www.w3.org/TR/REC-xml-names/, an XML namespace is a
collection of names, identified by a URI reference, which are used in XML documents
as element types and attribute names. To promote reusability and modularity, XML
document constructs should have universal names, whose scope extends beyond their
containing document. XML namespaces are the mechanism which accomplishes this.

When you import an XML schema (see Section 5.6.3, "How to Import an XML
Schema") such as the one that Example 5-3 shows, TopLink Workbench organizes the
various namespaces that the XML schema identifies, as Table 5-3 shows.

Example 5-3 XML Schema with Namespace Options

<xsd:schema

xmlns:<prefix>="<URI>" <!-- TopLink Workbench Built-in Namespace -->
targetNamespace="<URI>" <!-- TopLink Workbench Target Namespace -->
elementFormDefault="qualified"
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attributeFormDefault="unqualified"

version="10.1.3">

<xsd:import <!-- TopLink Workbench Imported Namespace -->
namespace="http://xmlns.oracle.com/ias/xsds/opm"
schemaLocation="object-persistence_1_0.xsd"

/>

</xsd:schema>

Table 5-3 TopLink Workbench XML Schema Categories

TopLink
Workbench
Category Defined By Purpose When Needed
Built-in xmlns:<prefix>="<URI>" Provides access to types If your project uses more
defined in other XML than one XML schema or if
schemas for use as is. you want to use xsi or xsd
types.
Target targetNamespace="<URI>" The namespace you use to You may need to specify a
qualify the types you define  target namespace
for your application. If set, all depending on how element
XML documents that use and attribute form options
these types must use this are set (see Section 15.4.2,
namespace qualifier. "Element and Attribute
Form Options").
Imported xsd:import Provides access to types If your project uses more

defined in the corresponding than one XML schema and
built-in XML schema so that ~ you want to extend one or
you can extend the built-in more built-in types.

types. Extended types must

be qualified by the target

namespace.

For more information, see Section 15.4, "XML Namespaces Overview".

5.6.5.1 How to Configure XML Schema Namespace Using TopLink Workbench

To specify the namespaces of a schema, use this procedure:
1. Select a schema element in the Navigator. Its properties appear in the Editor.

2. Click the Schema Document Info tab. The Schema Document Info tab appears.

Figure 5-37 Schema Document Info Tab—-Namespaces Field

Schema Structure

Source

File: "C:\Documents and Settingsippurich| Deskkopimwhrnl-jaxb-rwiconfiglemploves. xsd"

{ Mamespaces """,

Built-in Mamespaces:

Mamespace URL Prefix Declare
hitbp: f ey, w3, 0rg /2001 f2MLSchema |xs | |
http:f fvwvs. w3, orgf200 1 f¥MLSchemarinstance [xsi | ]
Target Mamespace!

Mamespace LURL Prefiz Declare
(absent) | |

Imported Mamespaces:

Mamespace URL Prefix Declare

Use the following information to complete each Namespaces field in the tab:
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Field

Description

Built-in Namespaces

All namespaces defined by xmlns:<prefix>="<URI>".

Note that when a schema is imported to the TopLink
Workbench (see Section 5.6.3, "How to Import an XML
Schema"), none of the built-in namespaces” URLs are selected.
If you are using inheritance, declare the built-in namespace
with xsi prefix. Otherwise, TopLink will throw exceptions.

Target Namespaces

All namespaces defined by targetNamespace="<URI>".

Imported Namespaces

All namespaces defined by xsd: import.

Prefix

Double-click in the Prefix field to specify the prefix that
corresponds to the given namespace.

When the TopLink runtime marshalls (writes) an object to an
XML document, it uses the namespace prefixes you specify
here.

When the TopLink runtime unmarshalls (reads) an XML
document, the document may use any prefix value as long as it
corresponds to the appropriate namespace. For more
information, see Section 15.4.3, "TopLink Runtime Namespace
Resolution".

Declare

When selected, XML documents must use the corresponding
URI qualifier when referring to types from this namespace.
XML documents may use a different prefix value as long as
that value is associated with the appropriate namespace URL
For more information, see Section 15.4.3, "TopLink Runtime
Namespace Resolution".

5.6.5.2 How to Configure XML Schema Namespace Using Java

Using Java, to configure XML schema namespaces for an EIS descriptor (with XML
records) or an XML descriptor, create a descriptor amendment method (see

Section 119.35, "Configuring Amendment Methods") that uses EISDescriptor or
XMLDescriptor method getNamespaceResolver to configure the descriptor’s
NamespaceResolver accordingly, as Example 5-4 shows.

Example 5-4 Configuring Namespaces

public void addToDescriptor (ClassDescriptor descriptor) ({
descriptor.getNamespaceResolver.put (

prefix,
namespaceURI
)

5.7 Using Classes

Using TopLink Workbench, you can create Java classes and packages. This section
includes information on the following:

s How to Create Classes

s How to Configure Classes

s How to Import and Update Classes

= How to Manage Nondescriptor Classes

= How to Rename Packages
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5.7.1 How to Create Classes

Oracle recommends that you develop your Java classes using an IDE, such as Oracle
Oracle JDeveloper, and import these existing classes into TopLink Workbench (see
Section 5.7.3, "How to Import and Update Classes")

However, it is sometimes convenient to create and conﬁgure classes in TopLink
Workbench: for example, when generating an object model from a database schema.

This section includes information on using TopLink Workbench to create Java classes.

For more information on using TopLink Workbench to edit classes, see Section 5.7.1,
"How to Create Classes".

5.7.1.1 How to Create Classes Using TopLink Workbench

To create new classes and packages from within TopLink Workbench, use this
procedure:

1. Select the project in the Navigator and click Create New Class.

You can also right-click the project in the Navigator and choose Create New Class
from the context menu or choose Selected > Create New Class from the menu.

Figure 5-38 Add Class Dialog Box

i Add Class

Package Mame: -

Mew Class Mame: | MewClass

o [ o]

Use the following information to enter data in each field on the Add Class dialog box:

Field Description

Package Name Choose an existing package or enter a new package name. If
blank, TopLink Workbench uses the default package name.

New Class Name Enter a class name. The New Class Name must be unique within
the package.

For more information on using TopLink Workbench to edit classes, see Section 5.7.2,
"How to Configure Classes".

5.7.2 How to Configure Classes

Oracle recommends that you develop your Java classes using an IDE, such as Oracle
Oracle JDeveloper, and import these existing classes into TopLink Workbench (see
Section 5.7.3, "How to Import and Update Classes")

However, it is sometimes convenient to create (see Section 5.7.1, "How to Create
Classes") and configure classes in TopLink Workbench: for example, when generating
an object model from a database schema.

This section describes using TopLink Workbench to edit classes, including the
following:

s Configuring Class Information

Using TopLink Workbench 5-41



Using Classes

s Configuring Class Modifiers

s Configuring Class Interfaces

s Adding Attributes

s Configuring Attribute Modifiers

s Configuring Attribute Type Declaration

s Configuring Attribute Accessing Methods
s Adding Methods

s Configuring Method Modifiers

s Configuring Method Return Type

s Configuring Method Parameters

5.7.2.1 Configuring Class Information

This section includes information on Using TopLink Workbench to configure class
information.

5.7.2.1.1 Using TopLink Workbench To configure class and superclass information, use
this procedure:

1. Select a class in the Navigator. Its properties appear in the Editor.

2. Click the Class Info tab in the Editor.

3. Click the Class tab.

Figure 5-39 Class Tab, Class Information Fields

Descriptor Info | Class Info | Queries || Caching || Locking

Class | atributes | Methods

Mame: | examples.sessions. threetier.model. Emplaves :
Superc ass:b’ava.lang.object || Browse...

Modifiers Interfaces Implemented

Access Maodifiers

(%) public
() (Default)

Other Modifiers
[] abstract

g

Use the following information to enter data in each field on the tab:

Field Description
Name The name of the class. This field is for display only.
Superclass Click Browse and select a class and package that contains the

class (that is, the superclass).
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5.7.2.2 Configuring Class Modifiers

This section includes information on Using TopLink Workbench to configure class
modifiers.

5.7.2.2.1 Using TopLink Workbench To configure class modifiers, use this procedure:
1. Select a class in the Navigator. Its properties appear in the Editor.

2. Click the Class Info tab in the Editor.

3. Click the Class tab.

Figure 540 Class Tab, Class Modifiers Fields

Descriptor Info | Class Info | Queries | Caching | Locking

Class | attributes | Methods

Mame: examples.sessions, threetier,model. Employves

Superclass: | java.lang.Object
: MadiffErs ==y Interfaces Implemented

Access Modifiers

() public
() (DeFault)

COther Modifiers
[] abstract

=

Use the following information to enter data in each field on the tab:

Field Description

Access Modifiers Use to specify whether the class is accessible publicly or not.

Only public classes are visible to the Oracle TopLink
Workbench.

Other Modifiers Specify if the class is Final or Abstract, or both. Final classes are
not included in the superclass selection lists for other classes to
extend.

5.7.2.3 Configuring Class Interfaces

This section includes information on Using TopLink Workbench to specify the
interfaces implemented by a class. You can choose any interface in the TopLink
Workbench classpath (see Section 117.3, "Configuring Project Classpath").

Although you may add interfaces to a project directly (see Section 5.7.3, "How to
Import and Update Classes"), you do not need to do so in order to configure a class to
implement an interface.

5.7.2.3.1 Using TopLink Workbench To implement interfaces, use this procedure:

1. Select a class in the Navigator. Its properties appear in the Editor.

2. Click the Class Info tab in the Editor.

3. Click the Class tab.
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Figure 5-41 Class Tab, Interfaces Implemented Fields

Descriptor Info | lass Info | Queries || Caching | Locking

Class | attributes | Methods

Mame: examples.sessions threetier,model. Employes
Superclass: | javalang.Object
Modifiers Interfaces Implemente

ficcess Modifiers

() public
() (Default)

Other Modifiers
[ abstract

A i

Use the following information to enter data in the Interfaces Implemented field on the

Class tab:
Field Description
Interfaces Implemented To add an interface, click Add. The Choose Class dialog box

appears. In the dialog box, select the interface and package.

To remove an interface, select the interface and click Remove

5.7.2.4 Adding Attributes

This section includes information on Using TopLink Workbench to add an attribute to
a class.

5.7.2.4.1 Using TopLink Workbench To add a new attribute (field) to the descriptor, click
Add.

To delete an existing attribute, select the attribute and click Remove.

To rename an existing attribute, select the attribute and click Rename.

The Attributes tab contains the following tabs:

= General

s Accessors

5.7.2.5 Configuring Attribute Modifiers

This section includes information on Using TopLink Workbench to configure attribute
modifiers.

5.7.2.5.1 Using TopLink Workbench To specify access modifiers, use this procedure:

1. Select a class in the Navigator. Its properties appear in the Editor.

2. Click the Class Info tab in the Editor.

3. Click the Attributes tab. The Attributes tab contains two sub-tabs.

4. Click the General tab.
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Figure 5-42 Attributes Tab, Modifiers Fields

3 Address
Descriptor Info | Class Info | Queries | Caching | Locking

Class | Attributes | Methods

9. city : Map General | accessors
2 country : String s

- odifiers
Sgid:long

E postalCods : Map Access Modifiers Other Modifiers

Sig province : String ) public (%) private [Cfinal [ transient
g street : String
¢ () protected () (Default) [ static [ volatile

Type Declaration

Type: java.util.Map
Dimensionality: il

Map Key Type: java.lang. Object
Map Yalue Type: | java.lang.String

[ add. . ][ Remave ][ Rename ]

Use the following information to enter data in the Modifiers fields on the Attributes
tab:

Field Description
Access Modifiers Specify how the attribute is accessible:
' Public

(I.. ' Protected—only visible within its own package and
subclasses.

A ¢ Private-not visible for subclasses

Eﬂ' Default-only visible within its own package

Other Modifiers Specify whether the attribute is Final, Static, Transient, or
Volatile.

Note: Selecting some modifiers may disable others.

5.7.2.6 Configuring Attribute Type Declaration

This section includes information on Using TopLink Workbench to configure attribute
type declaration.

5.7.2.6.1 Using TopLink Workbench To specify attribute type declaration, use this
procedure:

1. Select a class in the Navigator. Its properties appear in the Editor.

2, Click the Class Info tab in the Editor.

3. Click the Attributes tab. The Attributes tab contains two sub-tabs.

4. Click the General tab.
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Figure 5-43 Attributes Tab, Type Declaration Fields

3 Address
Descriptor Info | Class Info | Queries | Caching | Locking

Class | Attributes | Methods

9. city : Map General | Accessors
2 country : String o
odifiers

9. id : long
[ postalCode : Map Access Modifiers Other Modifiers

Sig province : String ) public (%) private [Cfinal [ transient
S street : String
() protected () (Default) [ static [ volatile
< Type Declaration :
Type: java.util.Map
Dimensionality: il
Map Key Type: java.lang. Chjeck
Map Value Type: | java.lang.String

[ add. . ][ Remaove ][ Rename ]

Use the following information to enter data in Type Declaration fields on the

Attributes tab:

Field Description

Type Click Browse and select a class and package for the attribute.

Dimensionality Specify the length of an array. This field applies only if Type is
an array.

Value Type Click Browse and select a class and package for the attribute.
This field applies for ValueHolderInterface types only.

Map Key Type Click Browse and select a class and package for the attribute.
This field applies for Map types only.

Map Value Type Click Browse and select a class and package for the attribute.
This field applies for Map types only.

Element Type Click Browse and select a class and package for the attribute.

This field applies for List types only.

5.7.2.7 Configuring Attribute Accessing Methods

This section includes information on Using TopLink Workbench to configure attribute
accessing methods. If you change an attribute and regenerate the accessing methods,
TopLink does not remove any previously generated methods.

5.7.2.7.1 Using TopLink Workbench To specify attribute accessing methods, use this
procedure:

1. Select a class in the Navigator. Its properties appear in the Editor.
2. Click the Class Info tab in the Editor.

3. Click the Attributes tab. The Attributes tab contains two sub-tabs.
4. Click the Accessors tab.
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Figure 5-44 Attributes Tab, Accessors Fields

Descriptar Infa | Class Info | Queries || Caching || Locking

Class | Attributes | Methods

2" city 1 Skring
E'l‘ country ¢ ValueHolderInterface
2" id ! long

B postalCode : Map

2" province @ Skring
Sig street : String

[ add... H Remove H Renams ]

Generdl| Accessars ™

ek Method: | @ getPostalCode() : Map v|
Set Method: |(E‘ setPostalCode(Map) @ void w |
Generate Methods
Add Method: | <none selected = w |
Remave Method: | <none selecteds v |

Generate Methods

Use the following information to complete the Accessors fields on the Attributes tab:

Field Description
Get Method Choose the get method for the attribute.
This field applies for non-Collection types only.
Set Method Choose the set method for the attribute.
This field applies for non-Collection types only.
Add Method Choose the add method for the attribute.
This field applies for List and Map types only.
Remove Method Choose the remove method for the attribute.
This field applies for List and Map types only.
Value Holder Get Method Choose the method used to return the
ValueHolderInterface type.
This field applies for ValueHolderInterface types only.
Value Holder Set Method Choose the method used to set the ValueHolderInterface

type.
This field applies for ValueHolderInterface types only.

Value Get Method

Choose the method used to return the actual value.

This field applies for ValueHolderInterface types only.

Value Set Method

Choose the method used to set the actual value.

This field applies for ValueHolderInterface types only.

5.7.2.8 Adding Methods

This section includes information on Using TopLink Workbench to add a method to a

class.

5.7.2.8.1

Using TopLink Workbench To add or remove methods, use this procedure:

1. Select a class in the Navigator. Its properties appear in the Editor.

2. C(lick the Class Info tab in the Editor.
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3. C(lick the Methods tab.

Figure 5-45 Class Info—Methods Tab

g Address

Descriptor Info| Class Info |Queries Caching || Locking

Class | Attributes MEth0d5|

Madifiers
@ 9etlityy) : String Access Modifiers Other Modifiers
@ getCountry() : String ) public P i
# getId) ¢ long
# 0etPostalCoded) : String (O protected () (Default)

@ getProvince() : String

@ getstreet() : String

@ setCity(String) : woid

@ setCountry(String) : void

@ setPostalCode(String) : void
# setProvince(String) : void |

@ setStreet(String) : void I:I

# tostring() : String

Return Type

Parameters

Type Dimensianality

Add... Remave Rename

To add a new method to the descriptor, click Add.
To delete an existing method, select the method and click Remove.

To rename an existing method, select the method and click Rename.

5.7.2.9 Configuring Method Modifiers

This section includes information on Using TopLink Workbench to configure method
modifiers.

5.7.2.9.1 Using TopLink Workbench To specify access modifiers, use this procedure:

1. Select a class in the Navigator. Its properties appear in the Editor.

2. Click the Class Info tab in the Editor.

3. Click the Methods tab.
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Figure 5-46 Methods Tab, Modifiers Fields

3 Address
Descriptor Info | Class Info | Queries | Caching | Locking

Class | Attributes | Methods
£ Modifiers

address()
@ getCity() : String Access Modifiers Other Modifiers
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# 0etPostalCoded) : String (O protected () (Default) [ Final [ native
@ getProvince() : String 0 hranized
synchronize:
# getStreet() : String o
@ setCity(String) : void
# sebCountry(String) : woid
@ setPostalCode(String) : void [FEUT RS
@ sebProvince(String) © void
@ setStreet(String) : void
# tostringl) © String
Parameters
Type Dimensionality
¢ String (java.lang) ol$|

[ add. . ][ Remave ][ Rename ]

Use the following information to enter data in Modifiers fields on the Methods tab:

Field

Description

Access Modifiers

Specify how the method can be accessed:
$ Public

(I.. ' Protected—only visible within its own package and
subclasses.

A ¢ Private-not visible for subclasses.

Eﬂ' Default-only visible within its own package.

Other Modifiers

Specify whether the method is Abstract, Final, Synchronized,
Static, or Native.

Note: Selecting some modifiers may disable others.

5.7.2.10 Configuring Method Return Type

This section includes information on Using TopLink Workbench to configure method

return type.

5.7.2.10.1 Using TopLink Workbench To specify method return type, use this procedure:

1. Select a class in the Navigator. Its properties appear in the Editor.

2. C(Click the Class Info tab in the Editor.

3. C(lick the Methods tab.
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Figure 5-47 Methods Tab, Return Type Fields

g Address
Descriptor Info | Class Info | Queries | Caching | Locking

Class | Attributes | Methods
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@ setCountry(String) : void

@ setPostalCode(String) : void
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j

Return Type "y

Dimensionality: 08
@ toString() : String >
Parameters
Type Dimensionality
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Use the following information to enter data in Return Type fields on the Methods tab:

Field Description

Type Click Browse and select a class and package for the method.

Dimensionality Specify the length of an array. This field applies only if Type is
an array.

5.7.2.11 Configuring Method Parameters

This section includes information on Using TopLink Workbench to configure method
parameters.

5.7.2.11.1 Using TopLink Workbench To specify additional method parameters, use this
procedure:

1. Select a class in the Navigator. Its properties appear in the Editor.

2. Click the Class Info tab in the Editor.

3. Click the Methods tab.
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Figure 5-48 Methods Tab, Method Parameters Fields

3 Address
Descriptor Info | Class Info | Queries | Caching | Locking

Class | Attributes | Methods

Address{) Modifiers
@ getCity() : String Access Modifiers Other Modifiers
# getCountry() ¢ String @ publi O privats [ st
@ getId() : long
# getPostalCodsd) ¢ String ) protected () (Default) [ final [ native

@ getProvince() : String

# getStreet() : String [ synchranized
@ setCity(String) : void
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Use the following information to enter data in Parameters fields on the Methods tab:

Field Description

Type Click Browse and select a class and package for the method.

Dimensionality Specify the length of an array. This field applies only if Type is
an array.

5.7.3 How to Import and Update Classes

This section includes information on Importing and Updating Classes Using TopLink
Workbench to import and update Java classes.

You can import Java classes and interfaces created in any IDE.
You can import any class on the system classpath or project classpath.

If a class exists on both the system classpath and the project classpath, TopLink
Workbench will update the class from the system classpath. To update or refresh from
the project classpath, remove the class from the system classpath and restart TopLink
Workbench.

For more information, see Section 117.3, "Configuring Project Classpath".

5.7.3.1 Importing and Updating Classes Using TopLink Workbench
Use this procedure to update or refresh the classes in the TopLink Workbench project.

1. Define the available classes and packages for the project on the General tab. See
Section 117.3, "Configuring Project Classpath" for information on classes and
packages.

2. Click Add or Refresh Class. The Select Classes dialog box appears.

You can also update the classes by choosing Selected > Add or Refresh Classes
from the menu.
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Figure 5-49 Select Classes Dialog Box

I\; Select Classes

Available Packages/Classes: Selected Classes:

[#-(F) examples.sessions. threetier
@ examples . sessions, threetier . examples J

@ examples sessions, threetisr,model

[ Refresh List ] [ oK ] [ Cancel ]

Select the packages or classes (or both) to import into the project and click OK.
TopLink Workbench adds the new classes to your project in the Navigator.

By default, TopLink Workbench creates the following descriptor types for each
package and class (depending on your project type):

= Relational projects—Relational class descriptors (see Section 22.2.1.1, "Creating
Relational Class Descriptors")

»  EIS projects—EIS composite descriptors (see Section 75.2.1.2, "EIS Composite
Descriptors")

s XML projects—XML descriptors (see Section 50.1.1.1, "Composite Descriptors in
XML Projects")

See Chapter 118, "Creating a Descriptor” for more information.

Note: If the class exists on both the system classpath and the
project classpath, TopLink Workbench will update the class from
the system classpath. To update or refresh from the project
classpath, remove the class from the system classpath and restart
TopLink Workbench.

To Remove a Class from a Project, do the following:
% Select the descriptor and click Remove, or choose Selected > Remove from the menu.

5.7.4 How to Manage Nondescriptor Classes

Some of the mappings in your TopLink project may reference classes that do not have
TopLink descriptors or are not included in the project.

To add, remove, or refresh Java classes that do not have TopLink descriptors, use this
procedure:

From the menu, select Workbench > Manage Non-Descriptor Classes. The Manage
Non-Descriptor Classes dialog box appears.

You can access the dialog box by right-clicking the TopLink project icon in the
Navigator and selecting Manage Non-Descriptor Classes from the context menu.
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Figure 5-50 Manage Non-Descriptor Classes Dialog Box

i Manage Non-Descriptor Classes

These are the non-descriptor classes For whom the Full class definitions have been imported into
the Workbench. Other classes may be referenced by name, but their names are all the
information that is kept,

Add/Refresh: Entire class definition is updated from class file and added to project.
Remove: Class definition is cleared. Class may still be referred to by name only,

‘I ExampleSessionEventAdapter (examples.sessions.threetier examples)

I

Select one of the following options:
s Toadd new classes, click Add. The Select Classes dialog box appears.

= Toadd new classes, click Add. The Select Classes dialog box appears (see
Figure 549, "Select Classes Dialog Box".

Only classes that have been added to the project’s class path can be added as
nondescriptor classes. See Section 117.3, "Configuring Project Classpath" for more
information.

s To delete an existing class, select the class and click Remove.

»  To refresh the classes (for example, if you edited the classes in an IDE), click
Refresh.

5.7.5 How to Rename Packages

When you add classes to a project, TopLink Workbench shows the classes contained in
the package to which they belong (see Section 5.3.3, "How to Use the Navigator").

You can use TopLink Workbench to change the package statements in all the Java
classes of a selected package (to move the all the classes contained by the selected
package to a new package). This is useful if you are refactoring an existing TopLink
Workbench project.

Note: The TopLink Workbench package rename feature is not
intended for migrating projects from older versions of TopLink: for
this, you must still use the TopLink Package Renamer. The Package
Renamer updates import statements for TopLink classes—it does not
change the package statements in user application classes.

For information on the TopLink Package Renamer, refer to Oracle
TopLink Release Notes.

For more information on using TopLink Workbench to edit classes, see Section 5.7.2,
"How to Configure Classes".

5.7.5.1 Renaming Packages Using TopLink Workbench

To change the package of an existing class in TopLink Workbench, use this procedure:

1. Right-click the package in the Navigator and select Rename.
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You can also select the package and choose Selected > Rename from the menu.

Figure 5-51 Rename Package Dialog Box

:\: Rename Package

Erter Meww Package Mame:

[ Help ] [ Ol H Cahcel ]

Enter the package name and click OK. TopLink Workbench changes the name of the
package in the Navigator window.

For more information on using TopLink Workbench to edit classes, see Section 5.7.2,
"How to Configure Classes".

5.8 Integrating TopLink Workbench with Apache Ant

If you use the Apache Ant Java-based build tool, you can use the Ant task and type
definitions that TopLink provides to invoke certain TopLink Workbench functions
from an Ant build file. Using these tasks, you can integrate TopLink Workbench into
your automated build process.

This section describes the following:

= How to Configure Ant to Use TopLink Workbench Tasks

= What You May Need to Know About TopLink Workbench Ant Task API
s How to Create TopLink Workbench Ant Tasks

For more information about Ant, see http: //ant.apache.org/manual/.

5.8.1 How to Configure Ant to Use TopLink Workbench Tasks

Before you can use TopLink Workbench tasks in your Ant build files, you must
consider their library dependencies (see Section 5.8.1.1, "Creating Library
Dependencies").

To declare TopLink Workbench tasks in your Ant build.xml file, declare them
directly (see Section 5.8.1.2, "Declaring TopLink Workbench Tasks").

5.8.1.1 Creating Library Dependencies

In addition to the Ant library dependencies (see
http://ant.apache.org/manual/install.html#librarydependencies),
Table 54 lists the TopLink-specific JAR files that must be in your Ant classpath.

Table 5-4 TopLink Workbench Ant Task Library Dependencies

JAR Name Needed For... Available At...

toplinkmw.jar TopLink Workbench Ant task and type definitions. <TOPLINK_
HOME>/utils/workbenc
h/jlib

5-54 Developer's Guide for Oracle TopLink



Integrating TopLink Workbench with Apache Ant

5.8.1.2 Declaring TopLink Workbench Tasks

After you declare the TopLink Workbench task definitions (see Table 5-6) and data
definitions (see Table 5-4) in the toplink-ant-1ib.xml file (see Example 5-5), you
can use a TopLink Workbench task in a build.xml file, as Example 5-6 shows:

Example 5-5 Declaring TopLink Workbench Ant Task and Data Types in a

toplink-ant-lib.xml File

<?xml version="1.0"?>
<antlib>
<taskdef name="mappings.export"

classname="oracle.toplink.workbench.ant.

<taskdef name="mappings.validate"

classname="oracle.toplink.workbench.ant.

<taskdef name="session.validate"

classname="oracle.toplink.workbench.ant.

<typedef name="ignoreerror"

classname="oracle.toplink.workbench.ant.

<typedef name="ignoreerrorset"

classname="oracle.toplink.workbench.ant.

<typedef name="loginspec"

classname="oracle.toplink.workbench.ant.

</antlib>

taskdefs.

taskdefs

taskdefs.

typedefs.

typedefs.

typedefs.

ExportDeploymentXMLTask" />

.MappingsValidateTask" />

SessionvValidateTask" />

IgnoreError" />

IgnoreErrorSet" />

LoginSpec" />

Example 5-6 Specifying the toplink-ant-lib.xml File in the build.xml File

<project name="MyBuild" default="validate.session" basedir="." xmlns:toplink="toplinklib">

<typedef file = "toplink-ant-lib.xml" classpathref = "mw.classpath" uri = "toplinklib" />

</project>

5.8.2 What You May Need to Know About TopLink Workbench Ant Task API
Table 5-5 lists the TopLink Workbench Ant task definitions that TopLink provides.

Table 5-5 TopLink Workbench Ant Task Definitions

Task Name TopLink Class

How to Create the oracle.toplink.workbench.ant.taskdefs.MappingsValidateTask

mappings.validate
Task

How to Create the oracle.toplink.workbench.ant.taskdefs.SessionValidateTask

session.validate
Task

How to Create the oracle.toplink.workbench.ant.taskdefs.ExportDeploymentXMLTask

mappings.export
Task

Table 5-6 lists the TopLink Workbench Ant type definitions that TopLink provides.

Table 5-6 TopLink Workbench Ant Type Definitions

Type Name TopLink Class

How to Create the oracle.toplink.workbench.ant.typedefs.IgnoreError

ignoreerror Task
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Table 5-6 (Cont.) TopLink Workbench Ant Type Definitions

Type Name TopLink Class

How to Create the oracle.toplink.workbench.ant.typedefs.IgnoreErrorSet
ignoreerrorset

Task

How to Create the oracle.toplink.workbench.ant.typedefs.LoginSpec
loginspec Task

5.8.3 How to Create TopLink Workbench Ant Tasks

Example 5-7 shows a typical Ant build.xml file that declares and uses the TopLink
Workbench Ant task and type definitions.

Example 5-7 Example Ant Build File with TopLink Workbench Ant Tasks

<project name="MyBuild" default="validate.session" basedir="." xmlns:toplink="toplinklib">
<l-- == —=== -->
<!-- Properties -—>
<l-- ===================================================== -->

<target name="init">
<property file="build.properties"/>

<property name = "toplink.mwp.dir" value = "${basedir}/mw"/>
<property name = "toplink.sessions.dir" value = "${basedir}/config"/>
<property name = " myProject.classes" value = "S{basedir}/classes "/>

<path id = "database.classpath">
<pathelement path = "${toplink.home}/mdoules/oracle.toplink_
11.1.1j1ib/OracleThindDBC.jar" />
</path>
<path id = "toplink.classpath">
<pathelement path = "${toplink.home}/modules/oracle.toplink 11.1.1/toplink.jar"/>
<pathelement path = "${toplink.home}/modules/oracle.toplink
11.1.11ib/java/api/ejb.jar"/>
<pathelement path = "${toplink.home}/modules/xmlparserv2.jar"/>
<pathelement path = "${toplink.home}/modules/oracle.toplink_
11.1.1/jlib/antlr.jar"/>
</path>
<path id = "mw.classpath">
<pathelement path = "${toplink.home}/modules/oracle.toplink_
11.1.1/jlib/tlmwcore.jar"/>
<pathelement path = "${toplink.home}/modules/oracle.toplink
11.1.1/j1lib/toplinkmw. jar"/>
</path>
<path id = "mwplatforms.classpath">
<pathelement path = "${toplink.home}/config"/>
</path>

<typedef file = "toplink-ant-lib.xml"

classpathref = "mw.classpath"

uri = "toplinklib" />
</target>
<l-- == —=== >
<!-- Define task parameter -—>
<!-- ===================================================== -->

<target name="parameter.definition" depends="init">
<toplink:ignoreerrorset id = "ignoreErrors">
<toplink:ignoreerror code = "0233" />
</toplink:ignoreerrorset>

<toplink:loginspec id = "loginSpec"

url = "jdbc:cloudscape:stagedb;create=true"
driverclass = "COM.cloudscape.core.JDBCDriver"
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user = "scott"

password="tiger" />
</target>
<l-- = ==== -->
<!-- Validate the MW Project -=>
<l-- ==============-====sssoso-sossossosos-so=sSssSsosso=sSssSsss========= -->

<target name="validate.project" depends="parameter.definition">

<toplink:mappings.validate
projectfile = "${toplink.mwp.dir}/myProject.mwp"
reportfile = "${toplink.mwp.dir}/problem-report.html"

reportformat = "html"
property = "mw-valid"
classpathref = "mwplatforms.classpath" >

<toplink:classpath refid = "mw.classpath" />
<toplink:classpath refid = "toplink.classpath" />

<toplink:ignoreerrorset refid = "ignoreErrors"/>

</toplink:mappings.validate>

</target>

<l-- ===================================================== -->
<!-- TopLink deployment descriptor XML generation -=>
<l-- == ==== —-->

<target name="export.deployment" depends="validate.project" if="mw-valid">

<toplink:mappings.export
projectfile = "S{toplink.mwp.dir}/myProject.mwp"
deploymentfile = "${toplink.sessions.dir}/sessions.xml"
property = "export-completed"
failonerror = "true"
classpathref = "toplink.classpath">

<toplink:classpath refid = "mw.classpath" />
<toplink:classpath refid = "mwplatforms.classpath" />

<toplink:ignoreerrorset refid = "ignoreErrors"/>
<toplink:loginspec refid = "loginSpec" />
</toplink:mappings.export>

</target>

<l-— ===================================================== -->
<!-- TopLink Session Validate -—>
<l-- == ==== -=>

<target name="validate.session" depends="export.deployment" if="export-completed">

<toplink:session.validate

sessionsfile = "${toplink.sessions.dir}/sessions.xml"
sessionname = "ThreeTierEmployee"

property = "session-valid"

classpathref = "toplink.classpath"

classpath = "${ myProject.classes}" >

<toplink:classpath refid = "mw.classpath" />
<toplink:classpath refid = " database.classpath" />

<toplink:loginspec refid = "loginSpec" />
</toplink:session.validate>
</target>
<project>

5.8.4 How to Create the mappings.validate Task

The mapings.validate taskis a testing task that you use to list of all the problems
in a TopLink Workbench project (. mwp) file.
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This task lets you do the following:
= log all the problems to a file in text or HTML format;

= setan Ant property to indicate that the TopLink Workbench project is valid (has no
errors).

5.8.4.1 Using Parameters

Table 5-7 mappings.validate Task Parameters

Attribute Description Required
projectfile Fully qualified TopLink Workbench projects file name (mwp). Yes

reportfile Fully qualified file name to which to write the output. No

reportformat The format of the generated output. Must be html or text. No-default to text.
classpath Project classpath. No

classpathref Reference to a path defined elsewhere. No

property The name of the property to set (true if there is no problem). No

5.8.4.2 Specifying Parameters Specified as Nested Elements
You can specify the following parameters as nested elements of this task:

= classpath
= ignoreerror (see Section 5.8.8, "How to Create the ignoreerror Task")

= ignorerrorset (see Section 5.8.9, "How to Create the ignoreerrorset Task")

5.8.4.3 Examples
Example 5-8 shows a typical mappings.validate task.

Example 5-8 A mappings.validate Task

<toplink:mappings.validate
projectfile = "${toplink.mwp.dir}/myProject.mwp"
reportfile = "${toplink.mwp.dir}/problem-report.html"
reportformat = "html"
property = "mw-valid"
classpath = "${mwplatforms.classpath}" >

<toplink:classpath refid = "mw.classpath" />
<toplink:classpath refid = "toplink.classpath" />

<toplink:ignoreerrorset refid = "ignoreErrors"/>
<toplink:ignoreerror code = "0555" />
</toplink:mappings.validate>

5.8.5 How to Create the session.validate Task

The session.validate task is a testing task that you use to test your TopLink
deployment XML by running TopLink.

This task provides the ability to do the following:
= specify the test type using a nested element;

= setan Ant property to indicate that the TopLink Workbench project is valid (has no
errors).
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5.8.5.1 Using Parameters

Table 5-8 session.validate Task Parameters

Attribute Description Required

sessionsfile Fully qualified sessions.xml file. No-default to sessions.xml
and to classpath.

sessionname Name of the session to test. Yes

classpath Project classpath. No

classpathref Reference to a path defined elsewhere. No

property The name of the property to set (true if valid). No

5.8.5.2 Specifying Parameters Specified as Nested Elements
You can specify the following parameters as nested elements of this task:

= classpath;
= loginspec (see Section 5.8.10, "How to Create the loginspec Task").

5.8.5.3 Examples

Example 5-9 shows a typical session.validate task.

Example 5-9 A session.validate Task

<toplink:session.validate

sessionsfile = "${toplink.sessions.dir}/sessions.xml"
sessionname = "ThreeTierEmployee"

property = "session-valid"

classpathref = "toplink.classpath"

classpath = "${ myProject.classes}" >

<toplink:classpath refid = "mw.classpath" />
<toplink:classpath refid = " database.classpath" />

<toplink:loginspec refid = "loginSpec" />
</toplink:session.validate>

5.8.6 How to Create the mappings.export Task

The mappings. export task is a generation task that you use to generate a TopLink
deployment XML file for a given TopLink Workbench project (. mwp). The
mappings.export task executes a mappings.validate (see Section 5.8.4, "How to
Create the mappings.validate Task") before executing. A BuildException is thrown
if validation fails.

This task provides the ability to override the TopLink Workbench project database
login information.

5.8.6.1 Using Parameters

Table 5-9 mappings.export Task Parameters

Attribute Description Required

projectfile Fully qualified TopLink Workbench projects file  Yes
name (. mwp).
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Table 5-9 (Cont.) mappings.export Task Parameters

Attribute Description Required
deploymentfile Fully qualified TopLink project deployment file  No-default to the name
name (.xml). specified in the TopLink
Workbench project (. mwp).
ejbjarxmldir The directory that contains the ejb-jar.xml No-default to the directory
file (only applicable to Java EE project). specified in the TopLink
Workbench project (. mwp).
classpath Project classpath. No
classpathref Reference to a path defined elsewhere. No
failonerror Indicates whether the build will continue even if No

there are export errors; defaults to true.

property The name of the property to set (true if export  No
completed successfully).

5.8.6.2 Specifying Parameters Specified as Nested Elements
You can specify the following parameters as nested elements of this task:

= classpath;
= loginspec (see Section 5.8.10, "How to Create the loginspec Task");
= ignorerror (see Section 5.8.8, "How to Create the ignoreerror Task");

» ignorerrorset (see Section 5.8.9, "How to Create the ignoreerrorset Task").

5.8.6.3 Examples
Example 5-10 shows a typical mappings . export task.

Example 5-10 A mappings.export Task

<toplink:mappings.export
projectfile = "${toplink.mwp.dir}/myProject.mwp"
deploymentfile = "${toplink.sessions.dir}/sessions.xml"
property = "export-completed"
failonerror = "true"
classpathref = "toplink.classpath">

<toplink:classpath refid = "mw.classpath" />
<toplink:classpath refid "mwplatforms.classpath" />

<toplink:ignoreerrorset refid = "ignoreErrors"/>
<toplink:ignoreerror code = "0545" />
<toplink:loginspec
url = "jdbc:cloudscape:stagedb;create=true"
driverclass = "COM.cloudscape.core.JDBCDriver"
user = "scott"
password="tiger" />
</toplink:mappings.export>

5.8.7 How to Create the classpath Task

Use the classpath element to define the Java classpath necessary to run a task. For
more information, see http://ant.apache.org/manual /using.html#path.
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5.8.7.1 Using Parameters

Table 5-10 classpath Element Parameters

Attribute Description Required

location Specifies a single file or directory relative to the No
project's base directory (or an absolute filename).

path Specifies one or multiple files or directories separated =~ No
by a colon or semicolon.

refid Reference to a path defined elsewhere. No

5.8.7.2 Specifying Parameters Specified as Nested Elements
You can specify the following parameters as nested elements of this task:

= pathelement

n fileset
m dirset
n filelist

5.8.7.3 Examples

Example 5-11 shows a typical classpath element.

Example 5-11 A classpath Element

<classpath>
<pathelement path="${classpath}"/>
<fileset dir="1lib">
<include name="**/*.jar"/>
</fileset>
<pathelement location="classes"/>
<dirset dir="${build.dir}">
<include name="apps/**/classes"/>
<exclude name="apps/**/*Test*"/>
</dirset>
<filelist refid="third-party_jars"/>
</classpath>

5.8.8 How to Create the ignoreerror Task

Use the ignoreerror element to instruct a TopLink Ant task to ignore a specific
TopLink Foundation Library or TopLink Workbench (see Section A.3, "TopLink
Workbench Error Reference") run-time error code.

To instruct a TopLink Ant task to ignore multiple error codes, consider using an
ignoreerrorset element (see Section 5.8.9, "How to Create the ignoreerrorset
Task").

5.8.8.1 Using Parameters

Table 5-11 ignoreerror Element Parameters

Attribute Description Required

code Error code of the problem to ignore. Yes
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5.8.8.2 Specifying Parameters Specified as Nested Elements
You cannot specify parameters as nested elements of this element.

5.8.8.3 Examples

Example 5-12 shows a typical ignoreerror element. This element instructs a
mappings . export task to ignore TopLink Workbench error code 0545.

Example 5-12 An ignoreerror Element

<toplink:mappings.export
projectfile = "${toplink.mwp.dir}/myProject.mwp"
deploymentfile = "${toplink.sessions.dir}/sessions.xml"
classpathref = "toplink.classpath">

<toplink:classpath refid = "mw.classpath" />
<toplink:classpath refid = "mwplatforms.classpath" />

<toplink:ignoreerror code = "0545" />

</toplink:mappings.export>

5.8.9 How to Create the ignoreerrorset Task

Use the ignoreerrorset element to instruct a TopLink Ant task to ignore any of
multiple TopLink Foundation Library or TopLink Workbench (see Section A.3,
"TopLink Workbench Error Reference") run-time error codes.

5.8.9.1 Using Parameters

Table 5-12 ignoreerrorset Element Parameters

Attribute Description Required

id Unique identifier for this type instance, can be used to No
reference this type in scripts.

refid Reference to a ignoreerrorset defined elsewhere. No

5.8.9.2 Specifying Parameters Specified as Nested Elements

You can specify the following parameter as nested elements of this element:

= ignorerror (see Section 5.8.8, "How to Create the ignoreerror Task")

5.8.9.3 Examples

Example 5-13 shows a typical ignoreerrorset element. This element instructs a
mappings . export task to ignore all of TopLink Workbench error codes 0402 and
0570. Note that the mappings . export task also uses an explicitly ignoreerror
element: this means that the mappings. export task will ignore all of error codes
0402, 0570, and 0545.

Example 5-13 An ignoreerrorset Element

<toplink:ignoreerrorset id = "ignoreErrors">
<toplink:ignoreerror code = "0402" />
<toplink:ignoreerror code = "0570" />

</toplink:ignoreerrorset>

<toplink:mappings.export
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projectfile = "${toplink.mwp.dir}/myProject.mwp"
deploymentfile = "${toplink.sessions.dir}/sessions.xml"
classpathref = "toplink.classpath">

<toplink:classpath refid = "mw.classpath" />
<toplink:classpath refid = "mwplatforms.classpath" />
<toplink:ignoreerrorset refid = "ignoreErrors"/>
<toplink:ignoreerror code = "0545" />

</toplink:mappings.export>

5.8.10 How to Create the loginspec Task

Use the 1oginspec element to instruct a TopLink Ant task to override the project
database login information in a TopLink Workbench project. For more information, see
Chapter 96, "Introduction to Data Access".

Note: You can only use this element with a relational project (see
Chapter 18, "Introduction to Relational Projects").

You cannot use this element with a Java EE project.

5.8.10.1 Using Parameters

Table 5-13 loginspec Element Parameters

Attribute Description Required
id Unique identifier for this type instance, can be used  No
to reference this type in scripts.
refid Reference to a loginspec defined elsewhere. No
driverclass Fully qualified class of the data source driver (see No-default to the class that the
Section 98.3, "Configuring Database Login TopLink Workbench project
Connection Options"). specifies.
url URL of the driver see Section 98.3, "Configuring Yes
Database Login Connection Options").
user Login user name (see Section 97.2, "Configuring User No—default to the value that the
Name and Password"). TopLink Workbench project
specifies
password Login password (see Section 97.2, "Configuring User No-default to the value that the
Name and Password"). TopLink Workbench project
specifies

5.8.10.2 Specifying Parameters Specified as Nested Elements
You cannot specify parameters as nested elements of this element.

5.8.10.3 Examples

Example 5-14 shows a typical loginspec element.

Example 5-14 A loginspec Element

<toplink:mappings.export
projectfile = "${toplink.mwp.dir}/myProject.mwp"
deploymentfile = "${toplink.sessions.dir}/sessions.xml"
classpathref = "toplink.classpath">

Using TopLink Workbench 5-63



Integrating TopLink Workbench with Apache Ant

<toplink:classpath refid = "mw.classpath" />
<toplink:classpath refid = "mwplatforms.classpath"

<toplink:loginspec

url = "jdbc:cloudscape:stagedb;create=true"
driverclass = "COM.cloudscape.core.JDBCDriver"
user = "scott"

password="tiger" />
</toplink:mappings.export>
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Using the Schema Manager

The SchemaManager and its related classes provide API that you can use from a Java
application to specify database tables in a generic format, and then create and modify
them in a specific relational database. This decouples your TopLink project from a
particular database schema while giving you a programmatic means of creating a
database schema based on your TopLink project. For example, you can use the schema
manager to recreate a production database in a nonproduction environment. This lets
you build models of your existing databases, and modify and test them during
development.

Note: You can also create database tables manually during
development using Oracle JDeveloper TopLink editor (see Chapter 4,
"Using Oracle JDeveloper TopLink Editor") or TopLink Workbench
(see Section 5.5.1.2, "Creating New Tables" and Section 5.5.3.4,
"Generating Tables on the Database").

This chapter includes the following sections:
s Introduction to the Schema Manager

n  Creating a Table Creator

n  Creating Tables with a Table Creator

n  Creating Database Tables Automatically

6.1 Introduction to the Schema Manager

Figure 6-1 summarizes the important SchemaManager classes and the primary
means of using them.
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Figure 6—1 SchemalManager Usage
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Although you can use the SchemaManager API directly, Oracle recommends that you
create a TableCreator class and use its API (which, in turn, uses the
SchemaManager).

You can automatically generate a TableCreator using the following:

=  TopLink Workbench during development (see Section 6.2.1, "How to Use TopLink
Workbench During Development")

» DefaultTableGenerator atrun time (see Section 6.2.2, "How to Use the
Default Table Generator at Run Time")

The TableCreator class owns one or more TableDefinition classes (one for each
database table) and the TableDefinition class owns one or more
FieldDefinition classes (one for each field).

The TableDefinition class lets you specify a database table schema in a generic
format. At run time, TopLink uses the session associated with your TopLink project to
determine the specific database type, and uses the generic schema to create the
appropriate tables and fields for that database.

After creating a TableCreator class, you can use its API to create and drop tables
(see Section 6.3, "Creating Tables with a Table Creator"). You can also configure
TopLink to do this automatically (see Section 6.4, "Creating Database Tables
Automatically").

Because the schema manager uses Java types rather than database types, it is
database-independent. However, because it does not account for database-specific
optimizations, it is best-suited for development purposes rather than production. For
more information on how the schema manager maps Java types to database types, see
Section 6.1.1, "How to Use Schema Manager Java and Database Type Conversion".

Although the schema manager can handle the sequencing configuration that you
specify in your TopLink project, if you are using sequencing with non-Oracle
databases, there are some sequencing restrictions you should be aware of (see
Section 6.1.2, "How to Use Sequencing").
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6.1.1 How to Use Schema Manager Java and Database Type Conversion

Table 6-1 lists the Java type to database type conversions that the schema manager
supports depending on the database platform your TopLink project uses. This list is
specific to the schema manager and does not apply to mappings. TopLink
automatically performs conversions between any database types within mappings.

Table 6-1 Java and Database Field Type Conversion
Java Type Oracle DB2 Sybase MySQL MS Access
java.lang.Boolean NUMBER SMALLINT BIT default 0 TINYINT(1) SHORT
java.lang.Byte NUMBER SMALLINT SMALLINT TINYINT SHORT
java.lang.Bytel[] LONG RAW BLOB IMAGE BLOB LONGBINARY
java.lang.Character CHAR CHAR CHAR CHAR TEXT
java.lang.Character[] | LONG CLOB TEXT TEXT LONGTEXT
java.lang.Double NUMBER FLOAT FLOAT(32) DOUBLE DOUBLE
java.lang.Float NUMBER FLOAT FLOAT(16) FLOAT DOUBLE
java.lang.Integer NUMBER INTEGER INTEGER INTEGER LONG
java.lang.Long NUMBER INTEGER NUMERIC BIGINT DOUBLE
java.lang.Short NUMBER SMALLINT SMALLINT SMALLINT SHORT
java.lang.String VARCHAR?2 VARCHAR VARCHAR VARCHAR TEXT
java.math.BigDecimal NUMBER DECIMAL NUMERIC DECIMAL DOUBLE
java.math.BigInteger NUMBER DECIMAL NUMERIC BIGINT DOUBLE
java.sqgl.Date DATE DATE DATETIME DATE DATETIME
java.sql.Time DATE TIME DATETIME TIME DATETIME
java.sqgl.Timestamp DATE TIMESTAMP DATETIME DATETIME DATETIME

6.1.2

For more information about database platforms that TopLink supports, see

Section 96.1.3.1, "Database Platforms".

How to Use Sequencing

If you generate a TableCreator class using TopLink Workbench (see Section 6.2.1,
"How to Use TopLink Workbench During Development"), or
DefaultTableGenerator (see Section 6.2.2, "How to Use the Default Table
Generator at Run Time"), then sequencing configuration is included in your
TableCreator according to your TopLink project configuration. In this case, when

you use TableCreator method createTables, it does the following:

»  Creates the sequence table as defined in the session DatabaseLogin.

= Creates or inserts sequences for each sequence name for all registered descriptors
in the session.

»  Creates the Oracle sequence object if you use Oracle native sequencing.

You can use advanced API to handle special cases like Sybase or Microsoft SQL Server
native sequencing (see Section 6.2.3, "How to Use Java to Create a Table Creator").

For more information about sequencing, see Section 18.2, "Sequencing in Relational
Projects".
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6.2 Creating a Table Creator
You can automatically generate a TableCreator using the following:
s Oracle JDeveloper (during development).

»  TopLink Workbench (during development) (see Section 6.2.1, "How to Use
TopLink Workbench During Development").

s DefaultTableGenerator (at run time) (see Section 6.2.2, "How to Use the
Default Table Generator at Run Time").

After creating a TableCreator class, you can use its API to create and drop tables
(see Section 6.3, "Creating Tables with a Table Creator").

6.2.1 How to Use TopLink Workbench During Development

To create a TableCreator class that you can use in a Java application to recreate a
database schema using the SchemaManager, use this procedure:

1. Right-click the project in the Navigator and choose Export > Table Creator Java
Source from the context menu. The Table Creator dialog box appears.

You can also select the table and choose Selected > Export > Table Creator Java
Source from the menu.

2. Enter a name for the table creator class and click OK. The Save As dialog box
appears.

3. Choose a location for your table creator class and click OK. TopLink Workbench
exports the table creator Java class to the location you specify.

6.2.2 How to Use the Default Table Generator at Run Time

To create a TableCreator class in Java using the DefaultTableGenerator, use
this procedure:

1. Create an instance of DefaultTableGenerator, passing in an instance of your
TopLink project:

DefaultTableGenerator myDefTblGen = new DefaultTableGenerator (toplinkProject);
2. Create a TableCreator instance:

» If you want a TableCreator that can support any session, use:

TableCreator myTblCre = myDefTblGen.generateDefaultTableCreator () ;
s If you want a TableCreator customized for a specific TopLink session, use:

TableCreator myTblCre =
myDefTblGen.generateFilteredDefaultTableCreator (toplinkSession) ;
You can also configure TopLink to use the DefaultTableGenerator to
automatically generate and execute a TableCreator at run time (see Section 6.4,
"Creating Database Tables Automatically").

6.2.3 How to Use Java to Create a Table Creator

This section describes how to create a TableCreator class in Java, including the
following:

n  Creating a TableCreator Class
s Creating a TableDefinition Class

» Adding Fields to a TableDefinition
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»  Defining Sybase and Microsoft SQL Server Native Sequencing

6.2.3.1 Creating a TableCreator Class

To create your own TableCreator instance, you should extend TableCreator, as
Example 6-1 shows:

Example 6-1 Creating a TableCreator Class

public class MyTableCreator extends oracle.toplink.tools.schemaframework.TableCreator {

public M7TableCreator () ({
setName ("MyTableCreator") ;
addTableDefinition (buildADDRESSTable()) ;

}

public TableDefinition buildADDRESSTable() {
TableDefinition table = new TableDefinition();

return table;

6.2.3.2 Creating a TableDefinition Class

The TableDefinition class includes all the information required to create a new
table, including the names and properties of a table and all its fields.

The TableDefinition class has the following methods:
s setName

m addField

m addPrimaryKeyField

s addIdentityField

s addForeignKeyConstraint

All table definitions must call the setName method to set the name of the table that is
described by the TableDefinition.

6.2.3.3 Adding Fields to a TableDefinition

Use the addField method to add fields to the TableDefinition. To add the
primary key field to the table, use the addPrimaryKeyField method rather than the
addField method.

To maintain compatibility among different databases, the type parameter requires a
Java class rather than a database field type. TopLink translates the Java class to the
appropriate database field type at run time. For example, the String class translates
to the CHAR type for dBase databases. However, if you are connecting to Sybase, the
String class translates to VARCHAR. For more information, see Section 6.1.1, "How to
Use Schema Manager Java and Database Type Conversion".

The addField method can also be called with the fieldSize or fieldSubSize
parameters for column types that require size and subsize to be specified.

Some databases require a subsize, but others do not. TopLink automatically provides
the required information, as necessary.
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6.2.3.4 Defining Sybase and Microsoft SQL Server Native Sequencing

Use FieldDefinition method addIdentityField to add fields representing a
generated sequence number from Sybase or Microsoft SQL Server native sequencing.
See Section 18.2.2.6, "Native Sequencing with a Non-Oracle Database Platform" for
detailed information on using sequencing.

6.3 Creating Tables with a Table Creator

After creating a TableCreator class (see Section 6.2, "Creating a Table Creator"), you
can use its API to create and drop tables. The important TableCreator methods are
the following (each method takes an instance of DatabaseSession):

m createTables-this method creates tables, adds constraints, and creates sequence
tables and sequences (if sequence tables already exist, this method drops them and
recreates them).

» dropTables-his method drops all constraints and drops all tables (except
sequence tables) that the TableCreator defines.

= createConstraints-this method creates constraints on all pre-existing tables
that the TableCreator defines.

» dropConstraints-this method drops constraints on all pre-existing tables that
the TableCreator defines.

s replaceTables-this method drops and then creates all tables that the
TableCreator defines.

6.4 Creating Database Tables Automatically

You can configure TopLink to create database tables automatically in JPA and E]JB
CMP projects:

»  Creating Database Tables Automatically in JPA Projects
n  Creating Database Tables Automatically in EJB CMP Projects

6.4.1 Creating Database Tables Automatically in JPA Projects

Using EclipseLink JPA persistence unit properties that you can define in a
persistence.xml file, you can configure schema generation

For more information, see "Using EclipseLink JPA Extensions for Schema Generation"
section of EclipseLink Developer’s Guide at http: //wiki.eclipse.org/Using_
EclipselLink_JPA_Extensions_%28ELUG%29#Using_EclipseLink JPA_
Extensions_for Schema_Generation

6.4.2 Creating Database Tables Automatically in EJB CMP Projects

If you deploy a CMP project to OC4] configured to use TopLink as the persistence
manager, then you can configure OC4]J to automatically create (and, optionally, delete)
database tables for your persistent objects.

You can configure automatic database table creation at one of three levels, as Table 6-2
shows. You can override the system level configuration at the application level, and
you can override system and application configuration at the EJB module level.
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Table 6—2 Configuring Automatic Table Generation

Level Configuration File Setting Values
System (global) <0C4J_HOME>/config/ autocreate-tables True or False!
application.xml
autodelete-tables True or False!
Application (EAR) orion-application.xml autocreate-tables True or False!
autodelete-tables True or False!
EJB Module (JAR) orion-ejb-jar.xml pm-properties sub-element Create,

default-mapping attribute DropAndCreate,
db-table-gen?® or UseExisting®

! Default.
2 For more information, see Section 9.9.1.3, "Configuring default-mapping Properties".
% See Table 6-3.

Note: In case of default mapping, the default value for
autocreate-tables setting is true.

If you configure automatic table generation at the EJB module level, the value you
assign to the db-table-gen attribute corresponds to the autocreate-tables and
autodelete-tables settings, as Table 6-3 shows.

Table 6-3 Equivalent Settings for db-table-gen

db-table-gen Setting autocreate-tables Setting autodelete-tables Setting
Create True False

DropAndCreate True True

UseExisting False NA

You can use this feature in conjunction with default mapping (see Section 17.2.3.4,
"Default Mapping in EJB 2.n CMP Projects Using OC4J at Run Time").
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7

Using an Integrated
Development Environment

This chapter includes information on using TopLink with an integrated development
environment (IDE).

This chapter includes the following sections:
s Configuring TopLink for Oracle JDeveloper
s Configuring TopLink Workbench with Source Control Management Software

In addition to the development environment described here, TopLink can be used with
any Java EE development environment and process.

7.1 Configuring TopLink for Oracle JDeveloper

This section contains information on how to configure TopLink for use with Oracle
JDeveloper. Oracle JDeveloper is a Java EE development environment with end-to-end
support to develop, debug, and deploy e-business applications and Web services.

7.1.1 How to Use TopLink Mappings

Starting with Oracle JDeveloper 10g, the standard Oracle JDeveloper installation
includes an embedded TopLink editor. Refer to the Oracle JDeveloper documentation
for complete information.

To use TopLink with Oracle JDeveloper 9.0.4 (and earlier), use the following procedure
to add the TopLink JAR files to your Oracle JDeveloper projects:

1. Select a Oracle JDeveloper project in the System Navigator window.
2. Choose Project > Project Settings. The Project Settings window appears.

3. Choose Configurations > Development > Libraries. A list of predefined and
user-defined libraries appears.
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Figure 7-1 List of Available Libraries

%a Project Settings - C:'JDev9.0.3' jdev'mywork’ Workspace2' Project 1 Project1.jpr
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Hac BC4J HTML
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B4 Security
BC4J Struts Rurtime
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4. Click New to create a new library that will contain the TopLink . jar files. The
New Library dialog box appears.

5. Enter a name for the new library—for example, TopLink. Ensure that the default
choice for Location remains as User Libraries.

Figure 7-2 Creating a New Library Dialog Box

New Library

Erter the name of this library and its location.
Likarary Mame: Lozation:
TopLink L=zer Libraries ﬂ

Erter the paths associsted with this library.

Claz= Path:

[ Ecit...
Source Path:

[ Ect...
Dioc Path:

[ Ecit...

Help OK | Cancel |

6. To edit the Class Path and add the TopLink . jar files, click Edit.

Add the following to the beginning of your Class Path:

<TOPLINK_HOME>\7jlib\toplink.jar
<TOPLINK_HOME>\modules\com.bea.core.antlr.runtime_2.7.7.jar
<ORACLE_HOME>\modules\xmlparserv2.jar
<ORACLE_HOME>\modules\xml.jar

7. Click OK. On the Project Settings window click OK.
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Using an Existing User-Defined TopLink Library

After a user library is created, it can be referenced again by any other project. Revisit
the Libraries window of the Project Settings, and add the TopLink Library to any
project with which you want to use TopLink.

7.2 Configuring TopLink Workbench with Source Control Management

Software

You can use TopLink Workbench with a source control management (SCM) system to
facilitate enterprise-level team development (see Section 7.2.1, "How to Use a Source
Control Management System"). If you have a small development team, you can
manage the changes from within XML files (see Section 7.2.3, "How to Share Project
Objects").

When using a TopLink Workbench project in a team environment, you must
synchronize your changes with other developers. See Section 7.2.2, "How to Merge
Files" for more information.

7.2.1 How to Use a Source Control Management System

If you use an enterprise, file-based source control management system to manage your
Java source files, you can use the same system with your TopLink Workbench project
files. These project files are maintained by TopLink Workbench and written out in
XML file format.

The check in and check out mechanism for the source control system defines how to
manage the source (the XML source and TopLink Workbench project file) in a
multiuser environment.

Checking Out and Checking In TopLink Workbench Project Files

Although your actual development process will vary depending on your SCM tool, a
typical process involves the following steps:

1. Determine (based on your SCM system) which files to retrieve from the source
management system.

2. Edit the project using TopLink Workbench.

3. Save the edited project. If TopLink Workbench displays the Read-Only Files dialog
box, make a note of these files, they must be unlocked and possibly merged. See
Section 7.2.5, "How to Work with Locked Files" for more information.

4. Merge the required project files. See Section 7.2.2, "How to Merge Files" for details.

5. Check in the modified files, then retrieve from the repository any files that have
been added or modified for this TopLink Workbench project.

7.2.2 How to Merge Files

The most difficult aspect of application development is merging changes from two (or
more) development team members that have simultaneously edited the same file. If
you check in your changes, a merge condition exists. Use a file comparison tool to
determine the merged aspects of the project. The files to edit will vary, depending on
the type of merge, as follows:

= Merging Project Files
s Merging Table, Descriptor, and Class Files
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Example 7-1 and Example 7-2 demonstrate a merge out merging technique.

7.2.2.1 Merging Project Files

Project files contain references to the objects in the project. Generally, your project
<projectName>.mwp contains the following elements:

Database information: <database>
s Database tables: <tables>
Descriptors: <descriptors>
Repository: <repository>

m Classes: <classpath-entries>

Changes in these parts of the . mwp file are usually caused by adding, deleting, or
renaming project elements.

To merge project files, you will generally need to merge a project file if another
developer has added or removed a descriptor, table, or class, and checked in the
project while you were adding or removing descriptors, tables, or classes from the
same project. To merge the project’s . mwp file, use this procedure:

1.

3.

Perform a file comparison between the <projectName>mwp file in the repository
and your local copy. The file comparison shows the addition or removal of a
project element inside the owner (that is, <database>, <descriptors>, or
<repository>).

Insert the XML script to, or delete from your local <projectName>mwp file
(inside the corresponding owner element). This brings your local code up-to-date to
the current code in the code repository.

Retrieve any updated files, as indicated by your source control system.

Your local source now matches the repository.

Example 7-1 Merging Projects

Another developer has added and checked in a new Employee class descriptor to the
com. demo package while you were working with the same TopLink Workbench
project. To merge your work with the newly changed project, follow these steps:

1.

Perform a file comparison on the <projectName>mwp file to determine the
differences between your local file and the file in the repository. Your SCM system
may show the file in merge status.

The file comparison shows the addition of the <package-descriptor> tag and
a <name> element inside that tag:

<package-descriptor>
<name>com.demo . Employee.ClassDescriptor</name>
</package-descriptor>
Insert this XML into your <projectName>mwp file (inside the <descriptors>
element) to bring it up-to-date with the current files in the source repository.

Retrieve any new or updated files from your source control system. This includes
the newly added Employee class descriptor.

Check in files that you have modified.
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7.2.2.2 Merging Table, Descriptor, and Class Files

Developers who concurrently modify the same existing table, descriptor, or class file
will create a merge condition for the following files:

s Table: <tableName>.xml (one for each table)
s Descriptor: <descriptorName. type>.xml (one for each descriptor)
m Class: <className>.xml (one for each class)

TopLink Workbench changes these files when saving a project if you have changed
any of the contents within them (such as adding a mapping to a descriptor, adding an
attribute to a class, or a changing a field reference in a table).

If another developer has changed an attribute in a table, descriptor, or class, while you
were changing a different mapping on that same descriptor, you will need to merge
your project. To merge your project, use this procedure:

1. Perform a file comparison on the specific . xm1 files in merge status (that is, table,
descriptor, or class). The file comparison shows the addition or removal of an XML
element.

2. Insert the XML script to, or remove from your local . xm1 file to bring it up-to-date
with the current files in the source repository.

Example 7-2 Merging Files

Another developer has added and checked in the firstName mapping to the
Employee class descriptor while you were changing a different mapping on that same
descriptor. To merge your work with the newly changed project, use this procedure:

1. Perform a file comparison on the
com.demo.Employee.ClassDescriptor.xml file located in
<projectRoot>/Descriptor/ directory that is in merge status.

The file comparison shows the addition of the <mapping> tag and the elements
inside that tag:

<mapping>
<uses-method-accessing>false</uses-method-accessing>
<inherited>false</inherited>
<read-only>false</read-only>
<instance-variable-name>firstName</instance-variable-name>
<default-field-names>
<default-field-name>direct field=</default-field-name>
</default-field-names>
<field-handle>
<field-handle>
<table>EMPLOYEE</table>
<field-name>F_NAME</field-name>
</field-handle>
</field-handle>
<mapping-class>MWDirectToFieldMapping </mapping-class>
</mapping>
2. Insert this XML block into your local
com.demo.Employee.ClassDescriptor.xml file (inside the existing
<mapping> element) to bring it up to date to the current files in the source
repository.

3. Retrieve any new files noted as missing by your source control system. This
includes any tables or descriptors that may be referenced by the new mapping.

4. Check in files that you have modified.
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7.2.3 How to Share Project Objects

You can also share project objects by copying the table or descriptor files into the
appropriate directories in the target project.

After copying the files, insert a reference to the table, descriptor, or class in the
appropriate place in the <projectName>.mwp file. All references contained within
the project file must refer to an existing object in the project.

7.2.4 How to Manage the ejb-jar.xml File

When working in a team environment, manage the ejb-jar .xml file similarly
to the . xml project files. TopLink Workbench edits and updates the ejb-jar.xml
file, if necessary, when working with an EJB project.

If you use a version control system, perform the same check in and check out
procedures. For merge conditions, use a file comparison tool to determine which
elements have been added or removed. Modify the file as necessary and check in the
file to exercise version control on your work.

7.2.5 How to Work with Locked Files

When working in a team environment, your source control system may lock files when
you retrieve them from the repository. If TopLink Workbench attempts to save a locked
file, the Version Control Assistance dialog box appears, showing the locked files.

Figure 7-3 Version Control Assistance Dialog Box

:\: ¥ersion Control Assistance

h’he following files are marked read-only. Please check-out or unlock these files from your wersion
contral system to continue. Press the Save button once the files have been unlocked.
Read-only Files:

Ci\Documents and SettingsippurichDeskiopimwitutorial TopLink_Tutorialimeidescriptorsiexamples, servletjsp. model, Address, xml

[ Save As.. ] [ Save l [ Cancel

Select one of the following methods to save your project:
= Use your source control system to unlock the files, and then click Save.
= Click Save As to save the project to a new location.

See Section 116.2.2, "How to Save Projects” for more information.
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TopLink Application Deployment

This part describes how to package and deploy a TopLink application to an
application server. It contains the following chapters:

Chapter 8, "Integrating TopLink with an Application Server"

This chapter contains information on software requirements for integrating
TopLink with your specific application server.

Chapter 9, "Creating TopLink Files for Deployment"

This chapter describes how to create the necessary TopLink files for deployment to
your application server.

Chapter 10, "Packaging a TopLink Application"
This chapter explains how to package the deployment files.
Chapter 11, "Deploying a TopLink Application"

This chapter provides procedures for deploying different types of TopLink
applications in a variety of environments.
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Integrating TopLink with an Application
Server

This chapter describes how to configure Oracle TopLink for use with Java EE
containers and application servers. Although you can use Oracle TopLink with any
Java EE container or application server (by using the TopLink API), TopLink provides
specific integration and support for the application servers listed in this chapter.

This chapter includes the following sections:

s Introduction to the Application Server Support

» Integrating TopLink with an Application Server

» Integrating TopLink with Oracle WebLogic Server

s Integrating TopLink with Oracle Containers for Java EE (OC4])
n Integrating TopLink with IBM WebSphere Application Server
s Integrating TopLink with Sun Application Server

»n Integrating TopLink with JBoss Application Server

s Defining Security Permissions

s Configuring Miscellaneous EJB CMP Options

For more information, see the following:

n  Chapter 9, "Creating TopLink Files for Deployment"

n  Chapter 10, "Packaging a TopLink Application"

n  Chapter 11, "Deploying a TopLink Application"

8.1 Introduction to the Application Server Support

You can use TopLink with any Java EE application server (by using the TopLink API)
that meets the requirements shown in "What Are the Software Requirements" on
page 8-2.

Table 8-1 lists the application servers for which TopLink provides specific JPA, CMP
2.n, and session EJB/BMP integration.

Table 8—1 TopLink Integration Support by Application Server Type

(Session
Application Server Application Server Bean' and
Type Version JPA CMP 2.n BMP

Oracle WebLogic Server 10.3
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Table 8-1 (Cont.) TopLink Integration Support by Application Server Type

(Session
Application Server Application Server Bean' and
Type Version JPA CMP 2.n BMP
Oracle WebLogic Server 9.n
0C4J 10.1.3.n
ocC4J 10.1.3
0C4J 9.0.4
ocC4J 9.0.3
IBM WebSphere 6.1
SunAS 9
JBoss 4.2.0

! This applies to EJB 1.1, 2.n and 3.0 session beans.

For more information, see the following:

s Section 8.3, "Integrating TopLink with Oracle WebLogic Server"

»  Section 8.4, "Integrating TopLink with Oracle Containers for Java EE (OC4J)"
»  Section 8.5, "Integrating TopLink with IBM WebSphere Application Server"
»  Section 8.6, "Integrating TopLink with Sun Application Server"

»  Section 8.7, "Integrating TopLink with JBoss Application Server"

8.2 Integrating TopLink with an Application Server

This section describes concepts unique to TopLink application server integration,
including the following:

= What Are the Software Requirements

s How to Configure the XML Parser Platform
s How to Set Security Permissions

s How to Migrate the Persistence Manager

s How to Integrate Clustering

8.2.1 What Are the Software Requirements

To run a TopLink application within a Java EE container, your system must meet the
following software requirements:

= An application server or Java EE container (see Table 8-1);
s XML parser (see Section 8.2.2, "How to Configure the XML Parser Platform");

= A JDBC driver configured to connect with your local database system (for more
information, see your database administrator);

= A Java development environment, such as the following:
— Oracle JDeveloper;
- IBM WebSphere Studio Application Developer (WSAD);
— Sun Java Development Kit (JDK) 1.5 or later;
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= Any other Java environment that is compatible with the Sun JDK 1.5 or later;

s A command-line JVM executable (such as java.exe or jre.exe).

8.2.2 How to Configure the XML Parser Platform

The TopLink run-time environment uses an XML parser to do the following:

= Read and write XML configuration files (see Section 9.1.1, "project.xml File" and
Section 9.1.2, "sessions.xml File");

= Read and write TopLink Workbench project files (see Section 5.1, "Introduction to

TopLink Workbench");

= Perform object-to-XML transformations in EIS projects using XML records (see
Chapter 77, "Introduction to EIS Mappings");

= Perform object-to-XML transformations in XML projects (see Chapter 53,
"Introduction to XML Mappings");

Application servers use an XML parser to read deployment files, such as
ejb-jar.xml and <Java EE container>-ejb-jar.xml files (see Chapter9,
"Creating TopLink Files for Deployment").

To avoid XML parser conflicts, you must configure your TopLink application to use
the same XML parser as that used by the application server on which you deploy your

application.

Internally, TopLink accesses its XML parser using an instance of

oracle.toplink.platform.xml.XMLPlatform class.

You can configure TopLink to use any XML parser for which an XMLPlatform class
exists (see Section 8.2.2.1, "Configuring XML Parser Platform").

You can also create your own XMLPlatform to provide access to an XML parser not
currently supported by TopLink (see Section 8.2.2.2, "Creating an XML Parser

Platform").

8.2.2.1 Configuring XML Parser Platform
TopLink provides the XMI.P1lat form instances shown in Table 8-2.

Table 8-2 Supported XML Platforms

XMLPIatform...

Provides Access to...

Use with...

oracle.toplink.platform.xml .xdk .XDKPlatform!

XDKParser: this class provides
access to the Oracle XML
Developer’s Kit (XDK) XML
parser (see
http://www.oracle.com/t
echnology/tech/xml/xdkh
ome.html).

See Section 8.4, "Integrating
TopLink with Oracle
Containers for Java EE (OC4])"

oracle.toplink.platform.xml.jaxp.JAXPPlatform

JAXPParser: this class
provides access to the Java SDK
XML parser in the
javax.xml.parsers package
(see
http://java.sun.com/j2e
e/1l.4/docs/tutorial/doc
/JAXPIntro2.html).

See the following:

= Section 8.3, "Integrating
TopLink with Oracle
WebLogic Server"

- Section 8.5, "Integrating
TopLink with IBM
WebSphere Application
Server"

1 Default.
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Note: To use an XML parser not listed in Table 8-2, create your own
XMLPlatform (see Section 8.2.2.2, "Creating an XML Parser
Platform").

To configure your TopLink application to use a particular instance of the
XMLPlatform class, set system property toplink.xml.platform to the fully
qualified name of your XMLPlatform class, as Example 8-1 shows.

Example 8-1 Configuring XML Platform
toplink.xml.platform=oracle.toplink.platform.xml.jaxp.JAXPPlatform

8.2.2.2 Creating an XML Parser Platform

Using the oracle. toplink.platform.xml classes included in the public source
files shipped with TopLink (see Section 13.3, "Using Public Source"), you can create
your own instance of the oracle. toplink.platform.xml.XMLPlatform class to
specify an XML parser not listed in Table 8-2.

After creating your XMLPlat form, configure TopLink to use it (see Section 8.2.2.1,
"Configuring XML Parser Platform").

8.2.2.3 XML Parser Limitations

Crimson (http://xml.apache.org/crimson/) is the XML parser supplied in the
Java Platform, Standard Edition (Java SE) and in some JAXP reference
implementations.

If you use Crimson with the JAXP API to parse XML files whose system identifier is
not a fully qualified URL, then XML parsing will fail with a not valid URL exception.

Other XML parsers defer validation of the system identifier URL until it is specifically
referenced.

If you are experiencing this problem, consider one of the following alternatives:
= Ensure that your XML files use a fully qualified system identifier URL.
= Use another XML parser (such as the OracleAS XML Parser for Java v2).

8.2.3 How to Set Security Permissions

By default, when you run a TopLink-enabled application in a JVM configured with a
nondefault java.lang. SecurityManager, the TopLink run-time environment
executes certain internal functions by executing a PrivilegedAction with
java.security.AccessController method doPrivileged. This ensures that
you do not need to grant many permissions to TopLink for it to perform its most
common operations. You need only grant certain permissions depending on the types
of optional TopLink features you use.

For more information, see Section 8.8, "Defining Security Permissions".

If you run a TopLink-enabled application in a JVM without a nondefault
SecurityManager, you do not need to set any permissions.

8.2.4 How to Migrate the Persistence Manager

You can configure an application server to use TopLink as the persistence manager.
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You can only use one persistence manager for all the entity beans with
container-managed persistence in a JAR file.

TopLink provides automated support for migrating an existing Java EE application to
use TopLink as the persistence manager. For more information, see Section 8.4.2, "How
to Migrate OC4J Orion CMP Persistence to OC4] TopLink Persistence".

8.2.5 How to Integrate Clustering

Most application servers include a clustering service that you can use with your
TopLink application.

To use TopLink with an application server cluster, use this general procedure:

1. Install the toplink. jar file (and include it in the classpath) on each application
server in the cluster to which you deploy TopLink applications.

2. Configure TopLink cache consistency options appropriate for your application.
For more information, see Chapter 102, "Introduction to Cache".

If you are deploying a CMP application, see also Section 9.10.1.2, "Configuring
cache-synchronization Properties".

3. Configure TopLink coordinated cache support for your application server, if
available.

4. Configure clustering on each application server.

For more information, see your application server documentation.

8.3 Integrating TopLink with Oracle WebLogic Server

To integrate a TopLink application with Oracle WebLogic Server, you must consider
the foll